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1 Overview to Electronic Resources Management & Importing Metadata 
 
1.1 Overview to electronic resources metadata processing 
 
Three different methods can be used to import electronic resources metadata.  
 

A. You can create or import an individual MARC bibliographic record. To import the record, use Cataloging->Interactive 
Z39.50 MARC Bib Import or Cataloging->Import a MARC Bib File. If you can't find the MARC anywhere, then create it via 
Cataloging->Original Catalog. Once the record is in Batch Control then add the work's URL(s) via Edit Bib->Brief Bib 
Editor->Links, or via Edit Bib->MARC Editor->Add Tag->856->subfield u.  
 

B. Some publishers/aggregators publish MARC files which contain durable URLs to the works. The URLs are found in tag 
856 subfield u. To import use Cataloging->Import a MARC Bib File.  CyberTools finds that records are not the same 
quality as found in the CyberTools NLM Shadow Server or NLM itself. Publishers/aggregators MARC is often filled with 
product branding and can have poor data.  If the publishers/aggregators also publish metadata in spreadsheet or 
spreadsheet-like files, then please use those data rather than the MARC.  
 

C. Some publishers/aggregators publish metadata in spreadsheet or spreadsheet-like files. These formats are usually the 
preferred format over MARC. Use Cataloging->File Z39.50 MARC Bib Import to process.  
 

The remainder of this chapter will name different publishers/aggregators and how to acquire their metadata.  
 

Please note that publishers/aggregators are constantly changing the websites and file formats. If you find that reality does 
not match this document, please notify us.  

 
1.2 Alexander Street Press Metadata 
 
  BEFORE YOU IMPORT:  

If you previously imported Alexander Street Press MARC then read this section. Otherwise go to the next section, 
IMPORTING Alexander Street Press MARC.  
 

If you previously imported an Alexander Street Press collection, or added Alexander Street Press online works 
individually, then before you import a current collection, run Cataloging->Remove Online Collection. But before you run 
function [Remove Online Collection] you'll first need to know what is/are your Alexander Street Press URL paths. As of 
2018-07-17  
 

   https://alexanderstreet.com/page/marc-records-faq 

  

shows many different URL paths:  
 

   - http://aspresolver.com 

   - http://eenz.alexanderstreet.com  

   - http://ativ.alexanderstreet.com  

   - http://flon.alexanderstreet.com  

   - http://hisc.alexanderstreet.com  

  

CyberTools does not know the differences between these servers. You need to look at your MARC tag 856 $u values to 
determine which paths needs to be removed (verses what needs to be preserved!).  
 

If you are updating all of your Alexander Street Press, then you will need to run   

Cataloging->Remove Online Collection->MARC Boolean search once for  

 

   SET A 856 4 * $u CONTAINS alexanderstreet.com 

    

then a second time for  

 

   SET A 856 4 * $u CONTAINS aspresolver.com 

 

If you are updating one collection out of many Alexander Street Press imported collections, then the search might need to 
contain more data. You can always use the import batch number stamp found in MARC tag 856 $x, e.g.,  
 

https://alexanderstreet.com/page/marc-records-faq
http://aspresolver.com/
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   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 

   IMPORTING Alexander Street Press MARC:  

As of 2018-07-17, Alexander Street Press MARC bibliographic records containing durable URLs can be found at  
 

     https://alexanderstreet.com/marc-records 

  

Please also see  
 

     https://alexanderstreet.com/marc-records 

  

These MARC files should be imported via Cataloging->Import a MARC Bib File. If you import with "Guide the Batch 
Control functions", then immediately after the import you will see these windows:  
 

   - URL Link Text, Public Comments, & Rules  

   - Review URLs Retrieved from the catalog (only if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you import without "Guide the Batch Control functions", then once in Batch Control you should select these functions:  
 

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  

 
1.3 BioMed Central, BMC, Journals Metadata 
 
BioMed Central, BMC, no longer posts their metadata at their website. The data are found at Springer website as part of 
the Open Access metadata. This Springer file is not exclusively BMC. Please see the guide's section Springer Metadata.  

 
1.4 Directory of Open Access Journals, DOAJ, Metadata 
 
  BEFORE YOU IMPORT:  

If you previously imported DOAJ then read this section. Otherwise go to the next section, IMPORTING DOAJ.  
 

If you previously imported the DOAJ collection, or added DOAJ online works individually, then before you import a current 
collection, run Cataloging-> Remove Online Collection. Each DOAJ journal has a unique server name. For example, Acta 
Mycologica is at https://pbsociety.org.pl/journals/index.php/ am/index while the Icelandic Medical Journal is at 
http://laeknabladid.is/. Therefore to remove your DOAJ collection, you cannot search by the server's name. Instead you 
need to use the last DOAJ import batch number found in its MARC tag 856 $x, e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 

If you manage a health sciences library and have imported the PubMed Central Journal List, then CyberTools 
recommends that you do not import DOAJ since these two collections overlap.  
 

  IMPORTING DOAJ:  

As of 2018-7-18 go to  
 

   https://doaj.org/faq#metadata 

https://alexanderstreet.com/marc-records
https://alexanderstreet.com/marc-records
https://doaj.org/faq#metadata
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Under "How can I get journal metadata from DOAJ?" select "1. Download the file to your computer." Your browser should 
guide you through saving the file onto your workstation. The default file name is doaj_YYYYYMMDD_HHMM_utf8.csv.  
 

The data are now ready to be imported in your catalog via Staff Functions-> Cataloging->File Z39.50 MARC Bib Import. 
Use function [Browse to source file] to identify your metadata file. Select function [Import file & process bibs]. The file 
format is "DOAJ (Directory of Open Access Journals)" . You will automatically segue to the window URL Link Text, Public 
Comments, & Rules. Your metadata file is then copied from your workstation to the CyberTools server.  
 

Before retrieving the MARC, you are given a choice of downloading all journals or English journals:  
 

    |--Select journals for import.----|  

    | (*) English only journals       |  

    | ( ) All journals                |  

    |---------------------------------|  

    | [Ok]  [Cancel]                  |  

    |---------------------------------|  

  

Some journals are published in multiple languages and will import as long as English is one of the languages.  
 

Next you will see a pop-up window of all the subject categories in the input file records. Choose those categories which 
you wish to import and select [Ok].  
 

If you import with "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control run:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  

 
1.5 EBSCO A-Z, 2015 Format Metadata 
 
Importing EBSCO A-Z metadata is a one-time event. Once imported then your online resources should be updated via 
their primary metadata sources. CyberTools preference is always for the primary sources. EBSCO A-Z metadata is a 
comprise and should only be used as a last resort.  
 

You can import the metadata for EBSCO A-Z with these simple steps:  
 

 A. Download the EBSCO A-Z Holdings List in the Format Tab Delimited ;  

 B. Use function [File Z39.50 MARC Bib Import] to convert file to MARC.  

  

Please note that CyberTools has worked with a limited number of these files. Your own data might present a wrinkle that 
CyberTools did not anticipate. You need to be alert for anomalies. We will resolve all questions and problems quickly. 
Please send questions via email to Support@CyberToolsForLibraries.com with your data as an attachment.  
 

These steps are now discussed.  
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A. Download the EBSCO A-Z Holdings List in the Format Tab Delimited.  
 

These instructions are valid as of April 2016. EBSCO constantly improves their products and website therefore these 
instructions might be different from what you see. Go to your EBSOADMIN portal. Select tab Holdings Management-
>Downloads->Holdings List. Select Format "Tab Delimited". Section Contents should be used to your discretion: we 
suggest ALL is too much. We encourage you to skip or cull packages for which CyberTools has direct imports, e.g., 
EBSCO Journals or eBooks, ClinicalKey, Ovid, PMC, R2, etc. See  
 

   http://cybertoolsforlibraries.com/library/library.php#ERM 

  

for the complete list. The CyberTools direct imports harvest data better than the EBSCO A-Z exports. For example, the 
EBSCO A-Z export does not include starting or ending volumes, whereas all major aggregator packages allow 
CyberTools to capture these data.  
 

In field File Name use EBSCO_A-Z_YYYYMMDD.txt where YYYYMMDD is today's date. If you limited the selected data 
to certain resources and/or packages, then include reasonable text in the file name to reflect your selection, e. g., 
EBSCO_A-Z_JOURNALS_YYYYMMDD.txt  
 

The resulting file is a Unicode Text file. You do not have to look at the file. If you do, then the file might not work in all of 
your desktop applications. It will work in Excel. If you open it in Excel, please take care to designate each column as Text 
(rather than the default General). You will preserve the data if you use Text. General will ruin ISBN values by converting 
them to scientific notation. Some libraries open the file to remove specific works and/or packages.  
 

B. Use function [File Z39.50 MARC Bib Import] to convert the file to MARC.  
 

In function [File Z39.50 MARC Bib Import] use [Browse to source file] to identify your file. The File Format is "EBSCO A-Z 
2015". If you named your file as EBSCO_A-Z_YYYYMMDD.txt, or anything similar to that, then the software should 
automatically change the File Format to "EBSCO A-Z 2015." Other file names require field File Format to be manually 
changes to EBSCO A-Z 2015. Select function [Import file & process bibs]. You will automatically segue to the window 
URL Link Text, Public Comments, & Rules. Your metadata file is then copied from your workstation to the CyberTools 
server.  
 

The software scans the data for Resources and Packages. Once collected the software will pop-up  
 

    |-----------------Which Resource(s)?--------------------|  

    | [?]  ALL (579)  [ ] JOURNAL (576)  [ ] NEWSLETTER (3) |  

    |-------------------------------------------------------|  

  

Select ALL or individual Resources. The select might include: Audio Book, Book, Book Series, Database, Journal, 
Newsletter, Newspaper, Proceeding, Report, Streaming Audio, Streaming Video, Thesis/Dissertation, Unspecified, and/or 
Web Site.  
 

The software then solicits the Packages:  
 

  |-----------------Which packages?-------------------|  

  | [ ] ALL                                    (579)  |  

  | [ ] ACP JOURNALS                            (4)   |  

  | [ ] ALLEN PRESS JOURNALS                    (2)   |  

  | [ ] AMERICAN ACADEMY OF FAMILY PHYSICIANS   (1)   |  

  | [ ] AMERICAN ACADEMY OF PEDIATRICS (AAP)    (2)   |  

  | [ ] AMERICAN ASSOCIATION OF NEUROLOGICAL SUR(4)   |  

  <snip>  

  | [ ] BMJ JOURNALS                            (1)   |  

  | [ ] CAMBRIDGE JOURNALS ONLINE               (4)   |  

  | [ ] CHEST PUBLICATIONS                      (2)   |  

  |---------------------------------------------------|  

  | [More]  [Done]                                    |  

  |---------------------------------------------------|  

  

You can select a maximum of 255 packages, or select ALL.  
 

The software then extracts your requested data and sorts them by control numbers (ISSN or ISBN), titles, and URLs. 

http://cybertoolsforlibraries.com/library/library.php#ERM


CyberTools Electronic Resources Management Guide 2020-01-16      ©CyberTools Inc. 1998-2020 

 

 

9 

Identical control numbers, titles, and URLs with the same extent are merged. When the extent is different, then the 
records are merged. When the URLs are different, older records' URLs are moved to the newer records. All changes are 
reported, e.g.:  
 

  SUMMARY  

  

  25 removed URL(s):  same title & URL, same extent.  

  40 merged URL(s):  same title & URL, different extents.  

  40 moved URL(s):  same title & different URLs  

  

  REMOVED  

  

  removed The American Surgeon  

  0003-1348 (print) ; 1555-9823 (online)  

  Publisher's Site.: Extent 1.1.2005 - Present  

  http://www.ingentaconnect.com/content/sesc/tas  

  for The American Surgeon  

  0003-1348 (print) ; 1555-9823 (online)  

  IngentaConnect.: Extent 1.1.2005 - Present  

  http://www.ingentaconnect.com/content/sesc/tas  

  <snip>  

  removed JBJS Case Connector  

  2160-3251 (online)  

  Publisher's Site.: Extent 7.1.2011 - Present  

  http://caseconnector.jbjs.org/content/by/year  

  for JBJS Case Connector  

  2160-3251 (online)  

  Journal of Bone and Joint Surgery.: Extent 7.1.2011 - Present  

  http://caseconnector.jbjs.org/content/by/year  

  

  MERGED  

  

  merged Seminars in Nuclear Medicine  

  0001-2998 (print) ; 1558-4623 (online)  

  Publisher's Site.: Extent 1.1.1971 - Present  

  http://www.sciencedirect.com/science/journal/00012998  

  to Seminars in Nuclear Medicine  

  0001-2998 (print) ; 1558-4623 (online)  

  ScienceDirect.: Extent 1.1.2007 - Present  

  http://www.sciencedirect.com/science/journal/00012998  

  <snip>  

  merged Journal of Studies on Alcohol and Drugs. Supplement  

  1946-584X (print) ; 1946-5858 (online)  

  JSAD: Journal of Studies on Alcohol and Drugs.: Extent 1.1.1975 - 12.31.  

  2009  

  http://www.jsad.com/loi/jsads  

  to Journal of Studies on Alcohol and Drugs. Supplement  

  1946-584X (print) ; 1946-5858 (online)  

  Publisher's Site.: Extent 7.1.2009 - 3.31.2014  

  http://www.jsad.com/loi/jsads  

  

  MOVED  

  

  moved Acta Obstetricia et Gynecologica Scandinavica (Informa Healthcare)  

  0001-6349 (print) ; 1600-0412 (online)  

  Taylor & Francis.: Extent 1.1.1922 - 12.31.2010  

  http://www.tandfonline.com/loi/iobs20  

  to Acta obstetricia et gynecologica Scandinavica  

  0001-6349 (print) ; 1600-0412 (online)  

  Wiley Online Library (formerly Blackwell Synergy).: Extent 1.1.1997 -  

  Present  

  http://onlinelibrary.wiley.com/journal/10.1111/(ISSN)1600-0412/issues  
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  <snip>  

  moved Journal of Wrist Surgery  

  2163-3916 (print) ; 2163-3924 (online)  

  thieme.: Extent 1.1.2012 - Present  

  https://www.thieme-connect.com/ejournals/issue/eFirst/10.1055/s-00000183  

  to Journal of Wrist Surgery  

  2163-3916 (print) ; 2163-3924 (online)  

  Thieme Connect.: Extent 1.1.2012 - Present  

  https://www.thieme-connect.de/products/ejournals/journal/10.1055/s- 

  00000183  

  

The titles are extensively normalized. For example, 'Alcohol Research and Health' and 'Alcohol Research & Health 
(LWW)' will match. The URLs are normalized by removing leading http, https, and www. Nevertheless, some matches will 
be left for the cataloger to resolve:  this is a standard part of function [File Z39.50 MARC Bib Import] processing.  
 

Each file's content will be reformatted automatically into the CyberTools import standard.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - URL Link Text, Public Comments, & Rules  

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you imported with "Guide the Batch Control functions" option then once in Batch Control select function [Update Catalog 
with Batch]. You are done. Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons 
and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  

 
1.6 EBSCO eBook Collections Metadata 
 
If you previously imported an EBSCO eBook collection in January or the spring quarter, then you do not need to import 
the entire collection again for updates. Rather, EBSCO publishes MARC bib files and spreadsheets for books added and 
removed for their collections at  
 

https://help.ebsco.com/interfaces/eBooks_Audiobooks/Administrator_User_Guide/eBook_Subscription_Update_Files 
 

These added and removed files are discussed in this guide's next section, EBSCO eBook Titles Added and Removed. To 
correctly maintain an EBSCO eBook collection you must use the quarterly updates. Do not miss one because EBSCO 
removes the quarterly metadata files. EBSCO does not update the core metadata file until January. If you miss a quarter, 
then you will have to contact EBSCO support for advice. They will probably give you a MARC file to import which is less 
desirable than their spreadsheets.  
 

If you missed the spring, summer, or fall updates, then in January you should remove Cataloging->Remove Online 
Collection then import the current January metadata. If you only have one EBSCO eBook Collection, then your search is  
 

    SET A 856 4 * $u CONTAINS search.ebscohost.com/login.aspx  

https://help.ebsco.com/interfaces/eBooks_Audiobooks/Administrator_User_Guide/eBook_Subscription_Update_Files
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If you are updating one collection out of many imported EBSCO eBook collections, then the search might need to contain 
more data. You can always use the import batch number stamp found in an existing EBSCO eBook MARC tag 856 $x, 
e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 

You can import the metadata for EBSCO eBook Collections such as the Academic Collection, the Clinical Collection, and 
the Nursing Collection, etc., with these simple steps:  
 

 A. Download the EBSCO eBook Collection spreadsheet;  

 B. Convert the spreadsheet to a text tab-delimited file;  

 C. Use function [File Z39.50 MARC Bib Import] to convert  

    the text tab-delimited file to MARC.  

  

These steps are now discussed.  
 

A. Download the EBSCO eBook Collection spreadsheet.  
 

These spreadsheets are publicly posted. As of 2018-07-18 go to  
 

   http://www.ebscohost.com/ebooks/ebooks-subscription-listings 

  

Select Browse Collections. In the left column select your main category, e.g., Medical. Now find you collection in either 
Featured Collections or Subject Sets and select it. You can either save the file to your workstation or open directly in a 
spreadsheet program.  
 

IMPORTANT NOTE 1: As of 2018-07-19, the Clinical and Nursing collections do not have spreadsheet file posted at this 
location. CyberTools is waiting on EBSCO Support for a solution.  
 

IMPORTANT NOTE 2: The Academic Collection is large. It is in three spreadsheet files. Because of the speed of a 
Z39.50 transaction, this collection is too large to be imported via function [File Z39.50 MARC Bib Import]. You should 
instead use the EBSCO OCLC MARC Bib import option.  
 

B. Convert the spreadsheet to a text tab-delimited file.  
 

Open the file with any spreadsheet program. Use the spreadsheet's menu bar File->Save As. Change the "Save as Type" 
to be "Text (Tab-delimited) (*.txt)".  
 

C.  Use [File Z39.50 MARC Bib Import] to convert the text tab-delimited file to MARC.  
 

The data are now ready to be imported into your catalog via Cataloging-> File Z39.50 MARC Bib Import. Use [Browse to 
source file] to identify your text tab-delimited file. The File Format is "EBSCO eBook Collection". Select function [Import 
file & process bibs]. You will automatically segue to the window URL Link Text, Public Comments, & Rules. Your 
metadata file is then copied from your workstation to the CyberTools server.  
 

If you import any package with the title(s) Acute Exposure Guideline Levels for Selected Airborne Chemicals and ISBNs 
9780309254816 (v. 11) and/or 9780309255011 (v. 12), then CyberTools merges these two volumes into one work. 
CyberTools also adds the open access URLs volumes 1, 2, 3, 6, 7, 8, 9, 13, 14, 16, and 20 as found at NCBI.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

http://www.ebscohost.com/ebooks/ebooks-subscription-listings
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If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  
 

  

 

 
1.7 EBSCO eBook Collection ADDITIONS and REMOVALS of Metadata 
 
EBSCO publishes eBook metadata for titles added and/or removed to collections. These files are currently updated 
quarterly by EBSCO. These files are used only after the initial EBSCO eBook Collection is imported into your catalog. For 
example, if you import an initial EBSCO eBook Collection in January, then in April you would import the same collection's 
ADDITIONS and REMOVALS data.  
 

File formats include MARC for titles removed, a spreadsheet for titles removed, and a spreadsheet for titles added. The 
significance of these files is that you do not need to first remove the entire old collection (function [Remove Online 
Collection]) and then import the entire new collection for the updates. Instead you can apply these smaller additions and 
removals data to your catalog with these simple steps:  
 

 A. Download a zip file from EBSCO containing the three metadata files,  

    and extract the file;  

 B. Convert the spreadsheets to text tab-delimited files;  

 C. Use function [File Z39.50 MARC Bib Import] to process the text  

    tab-delimited files.  

  

These steps are now discussed.  
 

A. Download a zip file containing the three metadata files and extract the files.  
 

As of March 2018 go to  
 

https://help.ebsco.com/interfaces/eBooks_Audiobooks/Administrator_User_Guide/eBook_Subscription_Update_Files 
 

and click on your collection. You will download a zip file, e.g., the Clinical collection results in the file 
Titles_Removed_Medical.zip. (Note that the EBSCO collection name and its file name do not necessarily match!) Extract 
the files from the zip file using your favorite Windows extraction program, such as WinZip, 7Zip, etc. There should be 
three files within the zip file.  
 

    - a MARC bibliographic file of deleted works;  

    - a spreadsheet of removed titles;  

    - a spreadsheet of added titles.  

  

Using the example of the Clinical Collection, the January 2018 files were respectively named:  
 

Additional Removals - World Scientific - Clinical.xlsx ADDITIONS - Clinical.xlsx Clinical -- REMOVALS.xlsx eBook 
Subscription - Clinical.docx REVISED REMOVALS - Clinical.xlsx  
 

The REMOVALS spreadsheet has only four control numbers (BookID, ISBN, eISBN, OCN) whereas the MARC could 
have a large number of control numbers. Fewer control numbers means a record is less likely to match on multiple works 
in the catalog. We advise that you do not use the MARC file, instead please use the REMOVALS spreadsheet. The 
spreadsheet will be faster to process and more accurate.  
 

At have seen a file named DELETE MARC that can be used with the CyberTools function Cataloging->Import a MARC 
Bib File, but it is a slower option and potentially less accurate than using the REMOVALS spreadsheet.  

https://help.ebsco.com/interfaces/eBooks_Audiobooks/Administrator_User_Guide/eBook_Subscription_Update_Files
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B. Convert the spreadsheets to text tab-delimited files.  
 

For both the REMOVALS file and the ADDITONS file, open each file with any spreadsheet program. Use the 
spreadsheet's menu bar File->Save As. Change the "Save as Type" to be "Text (Tab-delimited) (*.txt)".  
 

If EBSCO changes their spreadsheet's format, then CyberTools software will not work without some modification. The 
software will notify you if there is a problem. Please notify Support@CyberToolsForLibraries.com of reported EBSCO file 
format changes. None of the content aggregators currently announce format changes in advance.  
 

C. Use function [File Z39.50 MARC Bib Import] to process the text tab-delimited files.  
 

The data are now ready to be imported into your catalog via [File Z39.50 MARC Bib Import]. Use [Browse to source file] to 
identify your file. The REMOVALS File Format is "EBSCO eBook REMOVALS ". We recommend that you process the 
REMOVALS before the ADDITIONS. The Z39.50 process is actually ignored; instead the software matches the imported 
data to the works in your catalog, then automatically processes the works through the function [Remove Online Collection] 
thus preserving any works which might have print and/or non-EBSCO URLs.  
 

The ADDITIONS File Format is "EBSCO eBook ADDITIONS". Select function [ Import file & process bibs]. You will 
automatically segue to the window URL Link Text, Public Comments, & Rules. Your metadata file is then copied from your 
workstation to the CyberTools server.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  

 
1.8 EBSCO Journals Metadata 
 
  BEFORE YOU IMPORT:  

If you previously imported EBSCO journals metadata then read this section. Otherwise go to the next section, 
IMPORTING EBSCO Journals Metadata.  
 

If you previously imported an EBSCO journal collection, or added EBSCO journals online works individually, then before 
you import a current collection, run Cataloging->Remove Online Collection.  
 

If you are updating all of your EBSCO journals, then your Cataloging-> Remove Online Collection->MARC Boolean 
search SET A will be:  
 

   SET A 856 4 * $u CONTAINS search.ebscohost.com/direct.asp  

  

If you are updating one collection out of many EBSCO journals imported collections, then the search might need to 
contain more data. Note that the original EBSCO metadata file name is reflected in the EBSCO URLs. For example, the 
Health Business Elite metadata file name is heh.txt. Note the " heh" name. This collection's URLs contain 
"search.ebscohost.com/direct.asp? db=heh" therefore the MARC Boolean Search removal set is  
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   SET A 856 4 * $x CONTAINS search.ebscohost.com/direct.asp?db=heh  

  

You can also look at a collection's URL in catalog to find the "db=PACKAGE".  
 

You can always use the import batch number stamp found in an existing EBSCO journals MARC tag 856 $x, e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 
View the removal tutorial silent recording here:  http://cybertools.biz/webex/erm/EbscoJournalsRemove.mp4 
 

   IMPORTING EBSCO Journals Metadata:  

EBSCO offers many electronic journal collections. EBSCO supplies both MARC and spreadsheet-like metadata files. 
CyberTools encourages libraries to use the spreadsheet-like metadata files rather than the MARC. If you select a MARC 
file then process the file via Cataloging->Import a MARC Bib File. Otherwise a library can export a text tab-delimited file 
containing a collection's ISSN,title, URL, etc., values from the library's EBSCO administrative portal. Libraries have sent 
us the following collections to test, and we have done so:  
 

   Biomedical Reference Collection: Basic  

   CINAHL  

   Health Business FullTEXT  

   Health Business Elite  

   Nursing and Allied Health Collection:  Basic  

   Psychology and Behavioral Sciences Collection  

  

You can import these EBSCO records into your catalog. The process is:  
 

   A. Save the EBSCO file on your workstation.  

   B. Use function [File Z39.50 MARC Bib Import] to convert  

      the EBSCO tab delimited text file(s) to MARC.  

  

These steps are now discussed.  
 

A. Save the EBSCO Journal file on your workstation.  
 

An EBSCO Journal file can be downloaded from the EBSCOhost administrative interface:  
 

     http://eadmin.ebscohost.com 

  

Go to Database Title Lists->Tab Delimited and select from the "Full Text Only" files. 
  

B. Use function [File Z39.50 MARC Bib Import] to convert the EBSCO tab delimited text file(s) to MARC.  
 

The data are now ready to be imported in your catalog via function [File Z39.50 MARC Bib Import]. Use function [Browse 
to source file] to identify your file. For the File Format, select "EBSCO Journals".  Select function [Import file & process 
bibs]. You will automatically segue to the window URL Link Text, Public Comments, & Rules. Your metadata file is then 
copied from your workstation to the CyberTools server.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

 

  

http://cybertools.biz/webex/erm/EbscoJournalsRemove.mp4
http://eadmin.ebscohost.com/
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Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  
 
View the import tutorial silent recording here:   http://cybertools.biz/webex/erm/EbscoJournalsCINAHLImport.mp4 

 
1.9 Elsevier ClinicalKey Books & Journals (not Nursing)  Metadata 
 
  BEFORE YOU IMPORT:  

If you previously imported ClinicalKey then read this section. Otherwise go to the next section, IMPORTING ClinicalKey 
Master Content.  
 

ClinicalKey provides monthly incremental updates. Although monthly, the updates seem to stay in their update metadata 
file for at least six months. Therefore for updates use the ClinicalKey update mechanism documented here in this 
document's section "Elsevier ClinicalKey Updates (not Nursing) Metadata." at least once every six months.  
 

If you did not update ClinicalKey for six months, then you need to remove the collection before updating it via Cataloging-
>Remove Online Collection. To remove all of ClinicalKey the search is  
 

   SET A 856 4 * $u CONTAINS clinicalkey.com  

  

To remove all of ClinicalKey books the search is  
 

   SET A 856 4 * $u CONTAINS clinicalkey.com/dura/browse/book  

  

To remove all of ClinicalKey journals the search is  
 

   SET A 856 4 * $u CONTAINS clinicalkey.com/dura/browse/journal  

  

To remove a ClinicalKey package, e.g., Ophthalmology, then the search might need to contain more data. You can 
always use the import batch number stamp for the last package import found in an existing ClinicalKey MARC tag 856 $ x, 
e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 

View the removal tutorial silent recording here:     http://cybertools.biz/webex/erm/ClinicalKeyRemove.mp4 
 

  IMPORTING ClinicalKey Master Content:  

  

If you are a ClinicalKey Flex subscriber (you subscribe to the all packages) then skip this IMPORTING ClinicalKey Master 
Content section and proceed to the BOOKS and JOURNALS DURABLE URLs STEPS.  
 

If you are not a Flex subscriber, then you first need to download, convert, and import the Master_Content_List.xls. These 
data tag the works with the packages.  
 

Master_Content_List.xls, or something similar, is at  
 

   http://elsevierresources.com/clinicalkey/clinicalkey/content 

http://cybertools.biz/webex/erm/EbscoJournalsCINAHLImport.mp4
http://cybertools.biz/webex/erm/ClinicalKeyRemove.mp4
http://elsevierresources.com/clinicalkey/clinicalkey/content
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Select "Download the Master Content List: ClinicalKey." Note that this link's file name changes monthly. Or log into your 
ClinicalKey administrative portal then click on the link for "Master Content List" to download the spreadsheet. Open the 
Master_Content_List.xls spreadsheet with any spreadsheet program. Note that the file name might be different. Select the 
Books worksheet, then File->Save as. Change "Save as Type" to "Text (Tab delimited) (*.txt)". Change the file name to 
Master_ Content_List_Books.txt (the change should be automatic).  
 

Now select the worksheet Journals and File->Save as. Change the "Save as Type" to be "Text (Tab delimited) (*.txt)". 
Change the file name to Master_Content_List_Journals.txt (this should be automatic).  
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import. Select your file 
Master_Content_List_Books.txt. The field File Format is "ClinicalKey Master Content List Books (not Nursing)" (should be 
automatic). Select function [Import file & process bibs]. No bibs are imported. Rather, the ClinicalKey Packages are 
established. Now repeat for Master_Content_List_Journals.txt.  
 

Please proceed to BOOKS and JOURNALS DURABLE URLs STEPS for the actual bib imports.  
 

   BOOKS and JOURNALS DURABLE URLs STEPS:  

  

A. Go to  
 

  http://elsevierresources.com/clinicalkey/clinicalkey/implementation 

  

Scroll to the "Durable URLs" section. Select "Download Book Durable URLs" spreadsheet and "Download Journal 
Durable URLs". The file name will be Books_Durable_URLS.xls and Journals_Durable_URLS.xls, or some variation.  
 

B. Open the Book and/or Journal spreadsheet and "Save As" a ".txt text tab-delimited" file.  
 

Open the files with any spreadsheet program. Use the spreadsheet's menu bar->File->Save As. Change the "Save as 
Type" to be "Text (Tab delimited) (*.txt)". Respectively change the file names to Books_Durable_URLS.txt and 
Journals_Durable_URLS.txt (all these name changes should occur automatically with the new ".txt" extension).  
 

C. Use CyberTools function [File Z39.50 MARC Bib Import] to convert the ClinicalKey text tab-delimited file(s) to MARC. 
The data are now ready to be imported in your catalog via function [File Z39.50 MARC Bib Import]. Use function [Browse 
to source file] to identify your file. For the File Format, select "ClinicalKey Books Durable URLS" or "ClinicalKey Journals 
Durable URLS" as appropriate (this should have been automatically changed when your Durable URL file was selected).  
 

Select function [Import file & process bibs]. You will automatically segue to the window URL Link Text, Public Comments, 
& Rules. Your metadata file is then copied from your workstation to the CyberTools server.  
 

After the copy to the server a popup will prompt you:  
 

 |------Package(s) to which you subscribe:--------------------|  

 | [ ] All (same as Flex)     [ ] Dermatology                 |  

 | [ ] Advanced Basic Science [ ] Emergency Medicine          |  

 | [ ] Anesthesiology         [ ] Family Medicine             |  

 | [ ] Base                   [ ] Flex Only                   |  

 | [ ] Cardiothoracic Surgery [ ] Gastroenterology-Hepatology |  

  <snip>  

  

Select your packages. If you are a Flex subscriber, select "All (same as Flex)" then [Ok].  
 

If you are importing Books, and your subscription includes any number of volumes from the work 'The Netter collection of 
medical illustrations' then you will see a popup window similar to this one:  
  

http://elsevierresources.com/clinicalkey/clinicalkey/implementation
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 |-----------Merge Netter URLs? ---------------------------------|  

 |Your ClinicalKey Collection contains ## volume(s) or part(s) of|  

 |'The Netter collection of medical illustrations.'  Your catalog|  

 |as a single bib in the following listed bib(s).                |  

 |                         -OR-                                  |  

 |does not currently include any volumes of the collection.      |  

 |Do you want to:                                                |  

 |[Merge ClinicalKey URLs into MARC# ####]                       |  

 |[Give each URL its own bib (recommended)]                      |  

 |[Place all URLs (each with its volume info) into a single bib.]|  

 |[Cancel]                                                       |  

 |---------------------------------------------------------------|  

  

[Merge ClinicalKey URLs into MARC# ####] is only shown when you have only one volume of the collection. When 
selected then the URLs for all 14 volumes are incorporate into your single existing Netter catalog record.  
 

[Give each URL its own bib (recommended)] first attempts to match one-to-one the Netter volumes with existing Netter 
volumes in the catalog. When one volume is missing, it is then retrieved from the CyberTools NLM Shadow Z39.50 Server 
(note:  this server must be on your list of Z39.50 servers at the time of the import).  
 

[Place all URLs (each with its volume info) into a single bib.] retrieves the MARC for a single bibliographic record for all 14 
volumes from the CyberTools NLM Shadow Z39.50 Server. All 14 URLs, ISBN values, and notes are placed in the record.  
 

If you are importing Books, and your subscription includes these works:  
 

 9781437722161  Neurostimulation for the Treatment of Chronic Pain, v. 1 

 9781437722178  Intrathecal Drug Delivery for Pain and Spasticity, v. 2 

 9781437722185  Diagnosis, Management, & Treatment of Discogenic Pain, v. 3 

 9781437722192  Spinal Injections and Peripheral Nerve Blocks, v. 4 

 9781437722208  Reducing Risks and Complications of Interventional Pain  

                Procedures, v. 5 

  

then these five volumes' URLs are merged into the work  
 

9781437737912  Interventional and Neuromodulatory Techniques for Pain  

               Management 

  

as found at LocatorPlus.  
 

If you are importing Books, and your subscription includes the three volumes of Brain Metastases from Primary Tumors, 
then all three volumes' URLs are merged into a work as found at LocatorPlus.  
 

If you are importing Books, and your subscription includes the six volumes of Plastic Surgery, then all six volumes' URLs 
are merged into a work as found at LocatorPlus.  
 

If you are importing Books, and your subscription includes the two volumes of Vitamin D, then the two volumes' URLs are 
merged into a work as found at LocatorPlus.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
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If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  
 
View the import tutorial silent recording here:     http://cybertools.biz/webex/erm/ClinicalKeyBooksAndJournalsImport.mp4 

 
1.10 Elsevier ClinicalKey Updates (not Nursing) Metadata 
 
The standard process for managing an aggregator's metadata in the catalog is:  
 

   - Initially import the aggregator's file.  

     Use function [Import a MARC Bib File] for MARC data.  

     Use function [File Z39.50 MARC Bib Import] for spreadsheet data.  

   - When the aggregator publishes a new metadata file, use function  

     [Remove Online Collection] to remove the old metadata;  

   - Import the new metadata file.  

  

These steps still work with Elsevier's ClinicalKey (not Nursing). Alternatively you can utilize the ClinicalKey Master 
Content List Content Updates worksheet. This option's benefit is that Elsevier publishes the Master Content List more 
frequently and/or sooner than its Durable URLs files. Another benefit might be processing the Content Updates worksheet 
is easier. The disadvantage is that the Content Updates worksheet's journal data does not include extent. Extent is found 
in the Elsevier Journal Durable URLs spreadsheet. Therefore when you import the Content Updates worksheet Journals 
Added, CyberTools adds this message to the URL tag's Materials specified (tag 856 $3): "Dates and volumes are not 
know at this time." Most new collections that come online are extensive so the ambiguous extent message should be ok. 
A full re-import of ClinicalKey Journals with the Journal's Durable URLs metadata will also remedy this message.  
 

Here are the steps to process the ClinicalKey Master Content List Content Updates worksheet:  
 

 A. Download the ClinicalKey Master Content List spreadsheet.  

  

 B. Use a spreadsheet program to convert the Content Updates  

    worksheet to a "Text (Tab delimited) (*.txt)" file.  

  

 C. Use CyberTools function [File Z39.50 MARC Bib Import] to  

    process the Content Updates "Text (Tab delimited) (*.txt)" file.  

    Run three times, once for Remove Books and/or Journals, once  

    for Book Updates, and finally once for Journals Added.  

  

These steps are now discussed.  
 

A. Download the ClinicalKey Master Content List spreadsheet. Master_Content_List.xls is at  
 

  http://elsevierresources.com/clinicalkey/clinicalkey/content/ 

  

Select "Download the Master Content List: ClinicalKey." Note that this link's file name regularly changes. Or log into your 
ClinicalKey administrative portal then click on the link for "Master Content List" to download the spreadsheet.  
 

B. Use a spreadsheet program to convert the Content Updates worksheet to "Text (Tab delimited) (*.txt)" file. Open the 
Master Content List spreadsheet with any spreadsheet program. Select worksheet Content Updates. On the menu bar 
select File->Save as. Change "Save as Type" to "Text (Tab delimited) (*.txt)". Change the file name to Master_ 
Content_List_Content_Updates.txt (the file extension change should be automatic).  
 

C. Use CyberTools function [File Z39.50 MARC Bib Import] to process the Content Updates "Text (Tab delimited) (*.txt)" 

http://cybertools.biz/webex/erm/ClinicalKeyBooksAndJournalsImport.mp4
http://elsevierresources.com/clinicalkey/clinicalkey/content/
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file. Please note that the Content Update worksheet has four sections:  Book Updates, Removed Book Titles, Journals 
Added, and Removed Journal Titles. The data are now ready to be processed via function [File Z39.50 MARC Bib Import]. 
Use function [Browse to source file] to identify your file. For the File Format, select "ClinicalKey Master Content List 
Content Updates (not Nursing)". Select function [Import file & process bibs]. Your metadata file is then copied from your 
workstation to the CyberTools server.  
 

After the file is uploaded to the server, you will see a pop-up:  
 

  

    |---Contents Update Next Step------|  

    | ( ) Book Updates                 |  

    | ( ) Journals Added               |  

    | ( ) Remove Books and/or Journals |  

    |----------------------------------|  

    | [Ok]  [Cancel]                   |  

    |----------------------------------|  

  

Select "Remove Books and/or Journals". The software merges the worksheet's sections Removed Book Titles and 
Removed Journal Titles then automatically passes control to function [Remove Online Collection].  
 

Go back to function [File Z39.50 MARC Bib Import]. Use function [Browse to source file] to identify your file. For the File 
Format, select "ClinicalKey Master Content List Content Updates (not Nursing)". Select function [Import file & process 
bibs]. Your metadata file is then copied from your workstation to the CyberTools server. At the same "Contents Update 
Next Step" pop-up select "Books Updates". You will automatically segue to the window URL Link Text, Public Comments, 
& Rules.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  
 

Go back to function [File Z39.50 MARC Bib Import]. Use function [Browse to source file] to identify your file. For the File 
Format, select "ClinicalKey Master Content List Content Updates (not Nursing)". At the pop-up "Contents Update Next 
Step" select "Journals Added". Repeat the steps found above for Books Updates.  
 
View the import tutorial silent recording here:  
 
   http://cybertools.biz/webex/erm/ClinicalKeyBooksAndJournalsUpdatesLive.mp4 

 
  

http://cybertools.biz/webex/erm/ClinicalKeyBooksAndJournalsUpdatesLive.mp4
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1.11 Elsevier ClinicalKey for Nursing Books & Journals Metadata 
 
These instructions are strictly for ClinicalKey for Nursing. These are not the instructions for ClinicalKey.  
 

  BEFORE YOU IMPORT:  

ClinicalKey for Nursing is similar to ClinicalKey. Its Master Content Spreadsheet now included a Contents Update 
worksheet. Although CyberTools can process the ClinicalKey Master Content's Contents Update worksheet, CyberTools 
does not do so for ClinicalKey for Nursing because the latter's books and journals complete lists are short and quickly 
processed (in contrast to the lengthy lists for ClinicalKey). Therefore if you previously imported ClinicalKey for Nursing 
then read this section on removing ClinicalKey for Nursing prior to importing a current collection. Otherwise, I fyou have 
not yet imported ClinicalKey for Nursing then go to the next section, IMPORTING ClinicalKey for Nursing Master Content.  
 

To remove all of ClinicalKey for Nursing use Cataloging->Remove Online Collection with the search  
 

   SET A 856 4 * $u CONTAINS clinicalkey.com/nursing  

  

To remove all of ClinicalKey for Nursing books the search is  
 

   SET A 856 4 * $u CONTAINS clinicalkey.com/nursing/dura/browse/book  

  

To remove all of ClinicalKey for Nursing journals the search is  
 

   SET A 856 4 * $u CONTAINS clinicalkey.com/nursing/dura/browse/journal  

  

To remove a ClinicalKey for Nursing package, e.g., Emergency, then the search needs to be more spcific. You can 
always use the import batch number stamp for the last package import found in an existing ClinicalKey for Nursing MARC 
tag 856 $ x, e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 

   IMPORTING ClinicalKey for Nursing Master Content:  

ClinicalKey for Nursing has a number of distinct packages. Unlike ClinicalKey (i.e., not Nursing) there is no ALL (called 
FLEX in ClinicalKey). Today the packages are Base, Critical Care, Emergency, and Perianesthesia. CyberTools has 
added an ALL for your convenience. If you subscribe to all packages then skip the following INDIVIDUAL PACKAGES 
STEPS and proceed to the BOOKS and JOURNALS DURABLE URLs STEPS.  
 

   INDIVIDUAL PACKAGES:  

If you subscribe to all ClinicalKey for Nursing packages then proceed to the BOOKS and JOURNALS DURABLE URLs 
STEPS in this documentation.  
 

If you do not subscribe to all packages, then you first need to download, convert, and import the 
CKNursing_Master_Content_List.xls. These data tag the titles with the packages.  
 

CKNursing_Master_Content_List.xls is found at  
 

  http://elsevierresources.com/clinicalkey-for-nursing/home/master-content-list/ 

  

Select "Download the Master Content List: ClinicalKey for Nursing." Note that this link's hypertext regularly changes. Open 
the CKNursing_Master_Content_List.xls (or something hopefully similarly named) spreadsheet with any spreadsheet 
program. Select the Books worksheet, then File->Save as. Change "Save as Type" to "Text (Tab delimited) (*.txt)". 
Change the file name to CKNursing_Master_Content_List_Books.txt (the change should be automatic).  
 

Now select the worksheet Journals and File->Save as. Change the "Save as Type" to be "Text (Tab delimited) (*.txt)". 
Change the file name to CKNursing_Master_Content_List_Journals.txt (this too should be automatic).  
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import. Use function [Browse to source file] 
to identify your metadata file CKNursing_Master_Content_List_Books.txt. The field File Format is "ClinicalKey for Nursing 
Master Content List Books" (should be automatic). Select function [Import file & process bibs]. You will automatically 

http://elsevierresources.com/clinicalkey-for-nursing/home/master-content-list/
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segue to the window URL Link Text, Public Comments, & Rules. Your metadata file is then copied from your workstation 
to the CyberTools server.  
 

The software will first pass through the CK data to collect the Packages' names, e.g. Emergency. No bibs are imported at 
this moment. Unlike ClinicalKey, the ClinicalKey for Nursing Master Content Books sheet actually contains each work's 
durable URL. The software will import them now. You can specify one or more Packages, or ALL.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  
 

Now repeat for the journals. It too contains the durable URLs, but the extent is only by year. So even though you have a 
functioning works, please take the extra few minutes to import the CK Nursing Journals Durable URLs sheet (see the next 
section).  
 

For journals, please proceed to this documentation section BOOKS and JOURNALS DURABLE URLs for the actual 
metadata and URLs import. If you imported CKNursing_Master_Content_List_Books.txt then you do not need to import 
the CKN Books Durable URLs spreadsheet since you already collected these data.  
 

   BOOKS and JOURNALS DURABLE URLs STEPS:  

  

Go to  
 

  http://elsevierresources.com/clinicalkey-for-nursing/home/implementation/ 

  

Scroll to the "Durable URLs" section. Select the "Download Book Titles URLs" spreadsheet and the "Download Journal 
Titles URLs". The file name will be BookTitles_nursing.xls and JournalTitles_nursing.xls, or some variation.  
 

Open the Book and/or Journal spreadsheet and "Save As" as a "Text (Tab delimited) (*.txt)" file.  
 

Open the files with any spreadsheet program. Use the spreadsheet's menu bar->File->Save As. Change the "Save as 
Type" to be "Text (Tab delimited) (*.txt)". Respectively change the file names to Books_Durable_URLS.txt and 
Journals_Durable_URLS.txt (all these name changes should occur automatically with the next .txt extension).  
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import. Use function [Browse to source file] 
to identify your file. For the File Format, select "ClinicalKey for Nursing Book Titles URLs" or "ClinicalKey for Nursing 
Journal Titles Durable URLs" as appropriate (this should have been automatically changed when your Durable URL file 
was selected). Select function [Import file & process bibs]. You will automatically segue to the window URL Link Text, 
Public Comments, & Rules. Your metadata file is then copied from your workstation to the CyberTools server. Via a 
popup, CyberTools software will prompt you:  
  

http://elsevierresources.com/clinicalkey-for-nursing/home/implementation/


CyberTools Electronic Resources Management Guide 2020-01-16      ©CyberTools Inc. 1998-2020 

 

 

22 

 

 |--Packages(s) to which you subscribe:----|  

 | [ ] All            [ ] Emergency        |  

 | [ ] Base           [ ] Perianesthesia   |  

 | [ ] Critical Care                       |  

 |-----------------------------------------|  

 | [Ok]  [Cancel]                          |  

 |-----------------------------------------|   

  

Select your packages. If you subscribe to all then select "All" then [Ok].  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  

 
1.12 Elsevier ClinicalKey Procedures Consult Metadata 
 
Please see the section on Elsevier Procedures Consult Metadata.  

 
1.13 Elsevier Procedures Consult Metadata 
 
We believe that Elsevier Procedures Consult and ClinicalKey Procedures Consult are the same. This documentation 
serves both. Hereinafter this document will simply refer to Procedures Consult.  
 

Because Procedures Consult is published without control numbers (i.e., no ISBN, ISSN, or LCCN), CyberTools cannot 
confidently matches a new import's metadata records with an old import's records in your catalog. Therefore if you have 
previously imported Procedures Consult metadata, you must first use the CyberTools Cataloging->Remove Online 
Collection for this collection.  
 

The search is:  
 

   SET A 856 4 * $u CONTAINS clinicalkey.com/playContent/  

  

ClinicalKey publishes the Procedures Consult metadata at  
 

   http://elsevierresources.com/clinicalkey/clinicalkey/implementation 

  

Scroll to Durable URLS, select "Download Procedures Consult URLs". Your browser should save the file on your 
workstation. The file name will be some variation of ProceduresConsult_Durable_URLS.xls. We recommend that you 
rename the file so that it includes the date of the data as displayed in row 1, column C.  
 

Open the files with any spreadsheet program. Use the spreadsheet's menu bar->File->Save As. Change the "Save as 
Type" to be "Text (Tab delimited) (*.txt)". The file name should automatically have its file extension changed to ".txt". Go to 
your CyberTools Staff Functions-> Cataloging->File Z39.50 MARC Bib Import. Use function [Browse to source file] to 

http://elsevierresources.com/clinicalkey/clinicalkey/implementation
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identify your file. For the File Format, select "Procedures Consult" (this should have been automatically changed when 
your file was selected). Take the window's defaults. Select function [Import file & process bibs]. You will automatically 
segue to the window URL Link Text, Public Comments, & Rules. Your metadata file is then copied from your workstation 
to the CyberTools server.  
 

The software will prompt you to select your subscriptions:  
 

    |--Select subscription packages(s):----|  

    | [ ] ALL (same as Flex)  (343)        |  

    | [ ] ANESTHESIA  (34)                 |  

    | [ ] CARDIOLOGY  (31)                 |  

    | [ ] EMERGENCY MEDICINE  (74)         |  

    | [ ] FAMILY MEDICINE  (51)            |  

    | [ ] GENERAL SURGERY  (47)            |  

    | [ ] INTERNAL MEDICINE  (46)          |  

    | [ ] ORTHOPEDICS  (52)                |  

    | [ ] PEDIATRICS  (8)                  |  

    |--------------------------------------|  

    | [Ok]  [Cancel]                       |  

    |--------------------------------------|  

  

We believe that these are the names of the subscription packages. ClinicalKey has a package called Flex. Flex includes 
all resources. The display shows each package name and the count of videos for each package. (Please note that some 
videos overlap between the packages so that if you select all you really will not have the total displayed at this point).  
 

After selecting your package(s), the software skips the Z39.50 MARC bibliographic retrieval process. The ClinicalKey file 
has no control numbers therefore Z39.50 will not work. Instead CyberTools creates MARC bibliographic record from each 
record's four fields. For example, the record  
 

  A. Defibrillation (Emergency Medicine)  

  B. 2007-04-23  

  C. https://www.clinicalkey.com/playContent/19-s2.0-mp_EM-066  

  D. Binder  

  

becomes the MARC bibliographic:  
 

  005 20160728132029.0  

  100 1# $a Binder, David.  

  245 10 $a Defibrillation. $c David Binder.  

  260 ## $b Elsevier, $c 2007.  

  337 ## $a video $b v $2 rdamedia  

  490 1# $a Procedures Consult  

  650 #2 $a Emergency Medicine  

  655 #2 $a Instructional films and videos  

  830 #0 $a Procedures Consult  

  856 4# $u https://www.clinicalkey.com/playContent/19-s2.0-mp_EM-066  

  $y Link to video at Procedures Consult. $z Emergency medicine  

  $x system 20160728 batch#8119 ProceduresConsult_Durable_URLS-1.txt  

  proccons  

  979 ## $a USERS $b 20160728 $c NEW $d 8119 $e system $f 8119 $g system  

  

Note: the Procedures Consults titles often contain a colon, e.g., "Arthrocentesis: Ankle". There are several 
"Arthrocentesis" followed by a body part. Typically Arthrocentesis should go to MARC tag 245 $a, and Ankle to 245 $b. 
With reservations CyberTools decided to keep place the entire title in the 245 $a, i.e.,  
 

 245 00 $a Arthrocentesis: ankle  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - Assign A to Z Group ID  

   - Batch Control  
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Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  

 
1.14 Elsevier ScienceDirect Metadata 
 
  BEFORE YOU IMPORT:  

If you previously imported ScienceDirect then read this section. Otherwise go to the next section, IMPORTING 
ScienceDirect.  
 

If you previously imported a ScienceDirect collection, or added ScienceDirect online works individually, then before you 
import a current collection, run Cataloging->Remove Online Collection. To remove all your MARC Boolean search SET A 
will be:  
 

   SET A 856 4 * $u CONTAINS sciencedirect.com  

  

To remove just the books:  
 

   SET A 856 4 * $u CONTAINS sciencedirect.com/science/book/  

  

To remove just the book series:  
 

   SET A 856 4 * $u CONTAINS sciencedirect.com/science/bookseries  

  

To remove just the handbooks:  
 

   SET A 856 4 * $u CONTAINS sciencedirect.com/science/handbooks  

  

To remove just the journals:  
 

   SET A 856 4 * $u CONTAINS sciencedirect.com/science/journal  

  

To remove just the reference works:  
 

   SET A 856 4 * $u CONTAINS sciencedirect.com/science/referenceworks  

  

You can combine book and bookseries as 

 

   SET A 856 4 * $u CONTAINS sciencedirect.com/science/book 

 

Otherwise each collection type needs to be a separate [Remove Online Collection] search, 

meaning you cannot combine book with handbooks and/or journals, etc. Do each separately. 

 

You can always use the import batch number stamp found in an existing ScienceDirect MARC tag 856 $x, e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
  



CyberTools Electronic Resources Management Guide 2020-01-16      ©CyberTools Inc. 1998-2020 

 

 

25 

 

   IMPORTING ScienceDirect:  

A. Download ScienceDirect's comma-separated-value (CSV) file to your workstation.  
 

Go to  
 

   http://www.sciencedirect.com 

  

and select the hyperlink "Sign In". "Sign In" then becomes your name. A "+" (i.e., the plus sign) next to your name is a 
pull-down menu. Select the "+" then choose "Electronic Holdings Report". Under the label "Comma Separated Value 
(CSV)" select the hyperlink Download. The standard Windows popup " Enter name of file to save to?" should open. Save 
the file anywhere on your workstation. Note that this file is large, i.e., approximately 9 MB. Most of the data are not 
relevant to your subscriptions.  
 

Open the file with a spreadsheet program. Check a few of your licensed works:  do they have column AF access_type set 
to Subscribed? If not then change all of the licensed works to Subscribed, or contact the ScienceDirect Help Desk.  
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import.  Use function [Browse to source file] 
to identify your metadata file. The file format is ScienceDirect Electronic Holdings Reports CSV. Select function [Import file 
& process bibs]. You will automatically segue to the window URL Link Text, Public Comments, & Rules. Your metadata 
file is then copied from your workstation to the CyberTools server.  
 

After the data are copied from your workstation to the server,  
 

    |--Publication type for import.----|  

    |     value     count              |  

    | ( ) Book        ###              |  

    | ( ) Focal Press  ##              |  

    | ( ) Handbooks    ##              |  

    | ( ) Journal     ###              |  

    | ( ) Reference   ###              |  

    |----------------------------------|  

    | [Done]                           |  

    |----------------------------------|  

  

# represents numbers. Your display will be different. "Publication type" is a column from the CSV file. At this time, only 
Book, Journal, and Reference are imported:  if you need the other types then please contact 
Support@CyberToolsForLibraries.com. Any record with the "Access type" column value Non-Subscribed is ignored. You 
can change a Non- Subscribed to Subscribed so the work is imported into CyberTools. Any record with column values of 
"Publication type" Journal," Access type" Complimentary or Free-To-Read, and "ongoing_ access" with a value of not 
Yes, is ignored.  
 

The above popup is typically replaced with a new popup "Access type for import":  
 

    |--Access type for your selected "Publication type".---|  

    |     value       count                                |  

    | [ ] Complimentary ###                                |  

    | [ ] Free-To-Read  ###                                |  

    | [ ] Subscribed    ###                                |  

    |------------------------------------------------------|  

    | [Done]                                               |  

    |------------------------------------------------------|  

  

# represents numbers. As of 2015.10.1, "Publication type" Book with "Access type" Complimentary, are all very old 
classics which predate the year 1700. If you only subscribe to ScienceDirect journals, and you select "Publication type" 
Book, then the popup "Access type for import" is skipped.  
 

Sometimes a journal is listed more than once. The few times that we have seen this, the stated extents of the works are 
nearly the same. The URLs are the same. We recommend that you let CyberTools Merge these duplicate titles. The 
earliest date and volume and the latest date and volume become the extent.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  

http://www.sciencedirect.com/
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   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  
 

 
1.15 Gale Metadata 
 
  BEFORE YOU IMPORT:  

If you previously imported Gale then read this section. Otherwise go to the next section, IMPORTING Gale.  
 

If you previously imported a Gale collection, or added Gale online works individually, then before you import a current 
collection, run Cataloging-> Remove Online Collection.  
 

If you are updating all of your Gale, then your Cataloging->Remove Online Collection->MARC Boolean search SET A will 
be:  
 

   SET A 856 4 * $u CONTAINS link.galegroup.com  

  

If you are updating one collection out of many Gale imported collections, then the search might need to contain more 
data. You can always use the import batch number stamp found in an existing Gale MARC tag 856 $x, e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 

   IMPORTING Gale:  

Gale also offers KBART files at  
 

   https://support.gale.com/tlist/kbart 

  

CyberTools recommends that you use the KBART instead of the Gale MARC. Gale has two KBART files:  KBART and 
KBART XLS. Use the KBART files. Do not use KBART XLS. Gale also offers MARC at  
 

   https://support.gale.com/marc 

  

In our testing, the MARC files have a fraction of the records compared to the KBART files. For example, on 2018-07-23, 
the Health and Wellness Resource Center MARC has 75 records, whereas the KBART has 4610 records, therefore use 
the KBART files.  
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import.  Use function [Browse to source file] 
to identify your Galle KBART metadata file. The file format is KBART. Select function [Import file & process bibs]. You will 
automatically segue to the window URL Link Text, Public Comments, & Rules. Your metadata file is then copied from your 
workstation to the CyberTools server.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  

https://support.gale.com/tlist/kbart
https://support.gale.com/marc
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   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  

 
1.16 JAMA Network Metadata 
 
   BEFORE YOU IMPORT:  

If you previously imported the JAMA Network collection, or added JAMA Network online works individually, then before 
you import a current collection, run Cataloging->Remove Online Collection. Your MARC Boolean search SET A will be:  
 

   SET A 856 4 * $u CONTAINS jamanetwork.com/journals  

  

   IMPORTING JAMA Network Metadata:  

The JAMA Network provides KBART formatted files. KBART is an NISO standard for exchanging ERM metadata. The 
JAMA Network KBART files are found at  
 

   http://jamanetwork.com/pages/institutions-and-librarians#il-Catalog-Data 

  

Right click either the AMA Current Titles (amassoc.txt) or AMA Backfiles ( amassocbackfile.txt) and "Save Link As" the file 
on your workstation.  Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import. Use function 
[Browse to source file] to identify your metadata. file. The file format is KBART. Select function [Import file & process bibs] 
You will automatically segue to the window URL Link Text, Public Comments, & Rules. Your metadata file is then copied 
from your workstation to the CyberTools server.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  

 

http://jamanetwork.com/pages/institutions-and-librarians#il-Catalog-Data
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1.17 Karger Metadata 
 
   BEFORE YOU IMPORT:  

If you previously imported a Karger collection then read this section. Otherwise go to the next section, IMPORTING 
Karger.  
 

If you previously imported an Karger collection, or added Karger online works individually, then before you import a 
current collection, run Cataloging->Remove Online Collection. The MARC Boolean set for all of Karger is  
 

   SET A 856 4 * $u CONTAINS karger.com  

  

For books or books series:  
 

   SET A 856 4 * $u CONTAINS karger.com/Book  

  

For journals:  
 

   SET A 856 4 * $u CONTAINS karger.com/Journal  

  

If you are updating one collection out of many Karger imported collections, then the search might need to contain more 
data. You can always use the import batch number stamp found in an existing Karger MARC tag 856 $x, e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 

   IMPORTING Karger:  

Karger offers MARC at  
 

   https://www.karger.com/Services/eBooksRecords 

  

You can import these MARC via Cataloging->Import a MARC Bib File. Karger also offers KBART files at  
 

   https://www.karger.com/Services/KBart 

  

CyberTools recommends that you use the KBART (rather than the MARC files) files with Cataloging->File Z39.50 MARC 
Bib Import. Download the Karger zipped file and extract your target package. Each package has a text file ".txt" and a 
spreadsheet file ".xlsx".   
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import.  Use function [Browse to source file] 
to identify your metadata file.  The file format is KBART. Select function [Import file & process bibs].  You will automatically 
segue to the window URL Link Text, Public Comments, & Rules. Your metadata file is then copied from your workstation 
to the CyberTools server.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

https://www.karger.com/Services/eBooksRecords
https://www.karger.com/Services/KBart
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Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  

 
1.18 KBART Metadata 
 
KBART is an ANSI/NISO standard for exchanging electronic resources metadata. Many aggregators provide their 
metadata in KBART or near-KBART format. As of 2018-07-23 the following publisher/aggregators have KBART formats:  
 

   JAMA Network  

   Karger  

   ScienceDirect  

   Thieme  

  

The ClinicalKey and ClinicalKey for Nursing Durable URL files are nearly KBART: instead of the NISO specified text tab-
delimited format these CK files are in Excel ".xls" files. These CK files can be converted by a spreadsheet program to text 
tab-delimited files and then imported as CyberTools File Format KBART, although we discourage that because 
CyberTools fixes various problems in CK data. Similarly, ScienceDirect's CSV and Wiley's various xls files are nearly 
KBART, but they too need special care thus have discrete CyberTools File Format imports.  
 

If you have an aggregator's metadata file, and it contains the columns publication_title and title_url, then the file might in 
KBART format. If it is not a text tab- delimited file, then use a spreadsheet program to convert it to text tab- delimited.  
 

  BEFORE YOU IMPORT:  

If you previously imported a collection that is in the KBART file format, then read this section. Otherwise go to the next 
section, IMPORTING a KBART Collection.  
 

The prior import should be removed before importing the update. Use Cataloging->Remove Online Collection. But before 
you run function [Remove Online Collection] you'll first need to know what is/are your collection's URL look like. For 
example, if you are importing a Karger Collection, then the search statement might be:  
 

   SET A 856 4 * $u CONTAINS karger.com  

  

Or it might be  
 

   SET A 856 4 * $u CONTAINS karger.com/Books  

  

Please look at the URLs before you attempt to remove a collection. If you are updating one collection out of many 
imported collections for an aggregator, then the search can use the prior import batch number stamp found in an existing 
MARC tag 856 $x, e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 

   IMPORTING a KBART Collection:  

If the KBART file is not a text tab-delimited file, e.g., it is an Excel ".xls" file, then use a spreadsheet program to convert 
the ".xls" file to text tab-delimited file.  
 

Once you have the text tab-delimited KBART file, go to CyberTools Cataloging->File Z39.50 MARC Bib Import to convert 
the KBART text tab-delimited file to MARC.  Use function [Browse to source file] to identify your file. Change the field File 
Format to KBART. Select function [Import file & process bibs]. You will automatically segue to the window URL Link Text, 
Public Comments, & Rules. Your metadata file is then copied from your workstation to the CyberTools server.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
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Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  

 
1.19 Liebert Online Journals Metadata 
 

If you previously imported a Mary Ann Liebert collection, or added Mary Ann Liebert online works individually, then before 

you import a current collection, run Cataloging->Remove Online Collection. Your MARC Boolean search SET A will be:  

   SET A 856 4 * $u CONTAINS liebertpub.com  

 

View the removal tutorial silent recording here:   http://cybertools.biz/webex/erm/LiebertJournalsRemove.mp4 
 

Go to  
 

   http://www.liebertpub.com/ 

  

Select "Register/Sign In" via the shoulder+head icon in the top left corner. Download the metadata via Access 
Entitlements. The resulting file will probably be name subscriptions.tsv. If you open the file with a spreadsheet  
program then do not save it: ISBN values might be corrupted into corrupted into scientific notation. 
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import.  Use function [Browse to source file] 
to identify your metadata file. The file format is Liebert. Select function [Import file & process bibs]. You will automatically 
segue to the window URL Link Text, Public Comments, & Rules. Your metadata file is then copied from your workstation 
to the CyberTools server.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  
 
View the import tutorial silent recording here:   http://cybertools.biz/webex/erm/LiebertJournalsImport.mp4 

 
  

http://cybertools.biz/webex/erm/LiebertJournalsRemove.arf
http://cybertools.biz/webex/erm/LiebertJournalsRemove.arf
http://www.liebertpub.com/
http://cybertools.biz/webex/erm/LiebertJournalsImport.mp4
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1.20 McGraw-Hill Access and Collections Metadata 
 
If you previously imported a McGraw-Hill collection, or added McGraw-Hill online works individually, then before you 
import a current collection, first run Cataloging->Remove Online Collection. If you are updating all of your McGraw-Hill, 
then your Cataloging->Remove Online Collection->MARC Boolean search SET A will be:  
 

   SET A 856 4 * $u CONTAINS mhmedical.com  

  

If you are updating one collection out of many McGraw-Hill imported collections, then the search needs to contain the 
collection's full server name. For example, if you have AccessMedicine and AccessAnesthesiology, and you are only 
updating AccessMedicine, then your MARC Boolean search SET A will be:  
 

   SET A 856 4 * $u CONTAINS accessmedicine.mhmedical.com  

 
View the removal tutorial silent record here:  
 
http://cybertools.biz/webex/erm/AccessMedicineRemoveAndGetNewCsvFile.mp4 
  
CyberTools strongly discourages importing the McGraw-Hill MARC. The McGraw-Hill Title List "Export to Excel" files 
should be used. As of 2018-07-10 go to  
 

https://www.accessusercenter.com/users/765-user-center-help/posts/15324-title-lists-by-site 
 

(this page can move around) and select your target collection. On your selected Title List page select "Export to Excel." 
Save the resulting export.csv file on your workstation. Since all of the McGraw-Hill Excel files are named export.csv, we 
recommend that you rename the file to included the collection name and date, e.g.,  
 

   AccessMedicine_2018july_export.csv.  

  

(You can open the file with a spreadsheet program, but do not save it: Excel likes to convert ISBN values to scientific 
notation, thus ruining the data.) Import into CyberTools via Cataloging->File Z39.50 MARC Bib Import. The File Format is 
either McGraw- Hill Books or McGraw-Hill Case Files: select the appropriate format. Use function [Browse to source file] 
to identify your metadata file. Select function [Import file & process bibs]. Segue to the window URL Link Text, Public 
Comments, & Rules. Your metadata file is then copied from your workstation to the CyberTools server.  
 

Some collections, e.g., AccessMedicine, often have more than one edition of the same title. CyberTools will popup:  
  

     |------------------Remove old editions?------------------|  

     | McGraw-Hill collections typically stock multiple       |  

     | editions of the same work.                             |  

     | Do you want all editions or just the current edition?  |  

     | [Just the current edition]  [All editions]  [Cancel]   |  

     |--------------------------------------------------------|  

  

CyberTools recommends that you select the default [Just the current edition].  
 

If you import with "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (only if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation!  
 

If you did not imported with "Guide the Batch Control functions." then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

http://cybertools.biz/webex/erm/AccessMedicineRemoveAndGetNewCsvFile.arf
https://www.accessusercenter.com/users/765-user-center-help/posts/15324-title-lists-by-site
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   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation!  
 
View the AccessMedicine import tutorial silent recording here:   
http://cybertools.biz/webex/erm/AccessMedicineImport.mp4 
 
View the Case Files import tutorial silent recording here:   
http://cybertools.biz/webex/erm/McGrawHillCaseFilesImport.mp4 

 
1.21 Proquest ebrary and eBooks Metadata 
 
  BEFORE YOU IMPORT:  

If you previously imported a Proquest collection then read this section. Otherwise go to the next section, IMPORTING 
Proquest.  
 

Historically books removed from the Proquest collections are also in MARC format, where each MARC leader's position 5, 
Record Status, has a 'd' for Deleted. Staff Functions->Cataloging->Import a MARC Bib File will remove these bibs from 
your catalog. Please see that function's documentation for a complete discussion.  
 

Alternatively, if you have only imported one Proquest collection, or added Proquest online works individually, then before 
you import a current collection, run Cataloging->Remove Online Collection. Your search is:  
 

   SET A 856 4 * $u CONTAINS ebookcentral.proquest.com  

  

If you are updating one collection out of many Proquest imported collections, then the search might need to contain more 
data. You can always use the import batch number stamp found in an existing Proquest MARC tag 856 $x, e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 

   IMPORTING Proquest:  

As of 2018-07-24 Proquest offers MARC at  
 

   https://support.proquest.com/#articledetail?id=kA140000000CnINCA0 

  

The page has the title "Ebook Central Admin: MARC records - START HERE". Download your MARC files.  
 

These MARC files should be imported via Cataloging->Import a MARC Bib File. Use function [Browse to source file] to 
identify your MARC file. Select function [Import MARC File into Batch].  
 

If you import with "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - URL Link Text, Public Comments, & Rules  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you import without "Guide the Batch Control functions", then once in Batch Control you should select these functions:  
 

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

http://cybertools.biz/webex/erm/AccessMedicineImport.mp4
http://cybertools.biz/webex/erm/McGrawHillCaseFilesImport.mp4
https://support.proquest.com/#articledetail?id=kA140000000CnINCA0
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Do not run Batch Control->Item Creation!   

 
1.22 PubMed Central Journal List Metadata 
 
  BEFORE YOU IMPORT:  

If you previously imported the PubMed Central Journal List (hereinafter PMCJL) then you need to remove your PMCJL 
materials before import the current collection. Use Staff Functions->Cataloging->Remove Online Collection. Your Boolean 
search SET A will be:  
 

   SET A 856 4 * $u CONTAINS www.ncbi.nlm.nih.gov/pmc  

  

View the import tutorial silent recording here: 
 

   http://cybertools.biz/webex/erm/PubMedCentralJournalsRemoveAndImport.mp4 
 

  IMPORTING PubMed Central Journal List:  

The National Library of Medicine grants full text access to any journal article that was published with federal funds. The 
journal titles can be found at:  
 

    http://www.pubmedcentral.nih.gov/fprender.fcgi?cmd=full_view 

  

On this page click "Download CSV". On the next page, click the button "Download (CSV).  
 

It is called "PubMed Central Journals - Full List". Save this list of journals and their URLs to your workstation. Use its 
default filename of jlist.csv.  
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import.  Use function [Browse to source file] 
to identify your metadata file. The file format is "PubMed Central Journals List". You will automatically segue to the 
window URL Link Text, Public Comments, & Rules. Your metadata file is then copied from your workstation to the 
CyberTools server.  
 

After the data are copied from your workstation to the server, the window PubMed Central Journal List Import Option will 
open. Titles in the PubMed Central Journal List have four values which categorize the nature of the contributions. 
Complete documentation can be found at  
 

   http://www.ncbi.nlm.nih.gov/pmc/about/PMC-jlist-csv.pdf 

  

This window displays the values the four categories: Full Access, Open Access Indicators, Participation Level, and 
Deposit Status. Please note that we recommend that you deselect Deposit Status->Predecessor and Deposit Status->No 
New Content.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

http://cybertools.biz/webex/erm/PubMedCentralJournalsRemoveAndImport.mp4
http://www.pubmedcentral.nih.gov/fprender.fcgi?cmd=full_view
http://www.ncbi.nlm.nih.gov/pmc/about/PMC-jlist-csv.pdf
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Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  
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View the import tutorial silent recording here: 
 

   http://cybertools.biz/webex/erm/PubMedCentralJournalsRemoveAndImport.mp4 
 

Special note: Both PMC and the catalogers for LocatorPlus assign the journal Nephron's print ISSN value 1660-8151 to 
the following titles:  
 

   - Nephron. Clinical Practice;  

   - Nephron. Experimental Nephrology;  

   - Nephron. Experimental Nephrology.  

  

We believe that this is incorrect. The publisher does not make the association. Moreover, Nephron ceased publication in 
2002, splintering into the three titles noted above. Therefore CyberTools clears the Nephron's print ISSN value 1660-8151 
from all three of these PMC records.  

 
1.23 Rittenhouse R2 Digital Library Metadata 
 
If you previously imported Rittenhouse R2 (hereinafter R2) then before you import a current collection, run Staff 
Functions->Cataloging->Remove Online Collection. Your MARC Boolean search SET A will be:  
 

   SET A 856 4 * $u CONTAINS www.r2library.com  

 

View the removal tutorial recording here:   http://cybertools.biz/webex/erm/R2.mp4 
  
R2 has both MARC and spreadsheet metadata. CyberTools strongly encourages you to use the spreadsheet metadata. 
Go your R2 portal and login as Administrator. Select "Collection Management". Select My R2 Collection-> Tools-
>Download Spreadsheet. (For Technical Support, please email customerservice@r2library.com or call 1.800.345.6425 
X601)  
 

Open the R2 spreadsheet with any spreadsheet program. Use the spreadsheet's menu bar->File->Save As. Change the 
"Save as Type" to be "Text (Tab-delimited) (*.txt)". Change the file name to "R2.txt".  
 

C. Use function [File Z39.50 MARC Bib Import] to convert the R2 text tab-delimited file(s) to MARC.  
 

File Format, select "Rittenhouse R2 Digital Library".  
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import.  Use function [Browse to source file] 
to identify your metadata file. The file format is "Rittenhouse R2 Digital Library". Select function [Import file & process 
bibs]. You will automatically segue to the window URL Link Text, Public Comments, & Rules. Your metadata file is then 
copied from your workstation to the CyberTools server.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

http://cybertools.biz/webex/erm/PubMedCentralJournalsRemoveAndImport.mp4
http://cybertools.biz/webex/erm/R2.mp4
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Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  
 

View the import tutorial recording here:   http://cybertools.biz/webex/erm/R2.mp4 

 
1.24 SAGE Journals Metadata 
 
Notice: CyberTools will soon be transitioning to SAGE KBART. Until then, please accept these instructions.  
 

  BEFORE YOU IMPORT:  

If you previously imported SAGE then read this section. Otherwise go to the next section, IMPORTING SAGE.  
 

Before you import a current collection, run Staff Functions->Cataloging-> Remove Online Collection. To remove all 
collections your MARC Boolean search will be:  MARC Boolean search SET A will be:  
 

   SET A 856 4 * $u CONTAINS journals.sagepub.com  

  

If you are updating one collection out of many SAGE imported collections, then the search needs more or different data. 
You can always use the import batch number stamp found in an existing SAGE MARC tag 856 $x, e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 

   IMPORTING SAGE:  

As of 2018.07.24 the SAGE Journals spreadsheet files are posted at  
 

   https://us.sagepub.com/en-us/nam/sage-journals 

  

The STM (Science, Technology and Medicine) package is clearly posted. Most of the other packages can be found under 
Subject Collections (e.g., Oncology). The page will change. Select the Title List hyperlink that corresponds with your 
package. Your browser should guide you through saving the document onto your workstation.  
 

Open the spreadsheet with any spreadsheet program. Use the spreadsheet's menu bar->File->Save As. Change the 
"Save as Type" to be "Text (Tab delimited) (*.txt)".  
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import.  Use function [Browse to source file] 
to identify your metadata file. The file format is "SAGE Journals". Select function [Import file & process bibs]. You will 
automatically segue to the window URL Link Text, Public Comments, & Rules. Your metadata file is then copied from your 
workstation to the CyberTools server. CyberTools corrects much of the data.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  

http://cybertools.biz/webex/erm/R2.mp4
https://us.sagepub.com/en-us/nam/sage-journals
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1.25 Springer Metadata 
 
  BEFORE YOU IMPORT:  

If you previously imported Springer then read this section. Otherwise go to the next section, IMPORTING Springer. Before 
you import a current collection, run Staff Functions->Cataloging->Remove Online Collection. If you are updating all of your 
Springer, then your MARC Boolean search SET A will be:  
 

   SET A 856 4 * $u CONTAINS link.springer.com  

  

If you are updating all of your Springer books, then your MARC Boolean search SET A will be:  
 

   SET A 856 4 * $u CONTAINS link.springer.com/10.1007  

  

If you are updating all of your Springer journals, then your MARC Boolean search SET A will be:  
 

   SET A 856 4 * $u CONTAINS link.springer.com/journal  

  

If you are updating one collection out of many Springer imported collections, then the search needs more or different data. 
You can always use the import batch number stamp found in an existing Springer MARC tag 856 $x, e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 

   IMPORTING Springer.  

As of 2017-07-10, Springer offers metadata in the formats KBART, MARC, and/ or spreadsheet files. CyberTools prefers 
KBART. For journals, only KBART contains usable extent data. KBART is the preferred and is found at  
 

     https://link.springer.com/lists 

  

These are standard text tab-delimited KBART files. Select your package and save the file on your workstation.  
 

Use these KBART files directly in CyberTools's Cataloging->File Z39.50 MARC Bib Import. Select the CyberTools File 
Format KBART.  
 

Select function [Import file & process bibs]. You will automatically segue to the window URL Link Text, Public Comments, 
& Rules. Your metadata file is then copied from your workstation to the CyberTools server.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Springer represents each volume as a record in the KBART file. CyberTools will attempt to merge them. Unfortunately 
Springer does not always include the volume number in the KBART volume column. Therefore when you merge them, 
there will not always be sufficient tagging with the URL to be able to tell the URLs apart, i.e., which URL goes with which 
volume. Once in Batch Control use Display Bibs-> Display the following MARC Tags=245,856-> Workstation. Where ever 
you see more than one URL:  
 

     - test the URL directly from the Display Bibs report page;  

     - use Batch Control->Edit Bib to annotate to add the volume  

       values to MARC 856 subfield 3, Material type.  

  

Hint:  the Springer URLs in tag 856 $u contain the ISBN values. The ISBN tags 020 have the same ISBN values and 
probably show a volume number which you can copy to 856 $3. For example:  
 

   EXAMPLE SPRINGER VOLUMES:  

   020  ## $a 9783319144634 (v. 1 : eBook)  

https://link.springer.com/lists
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   020  ## $a 9783319144665 (v. 2 : eBook)  

   245  00 $a Cell polarity / $c Klaus Ebnet, editor.  

   856 4# $u CONTAINS link.springer.com/10.1007/978-3-319-14463-4  

          $y Link to book at Springer.  

   856 4# $u CONTAINS link.springer.com/10.1007/978-3-319-14466-5  

          $y Link to book at Springer.  

  

You would change the 856 tags to:  
 

   856 4# $u CONTAINS link.springer.com/10.1007/978-3-319-14463-4  

          $y Link to book at Springer.  

          $3 v. 1  

   856 4# $u CONTAINS link.springer.com/10.1007/978-3-319-14466-5  

          $y Link to book at Springer.  

          $3 v. 2  

  

Now back in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then CyberTools might display work has multiple volumes 
as duplicates, and ask you to merge them: you should do so. Once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - If you imported books then you need to check the merged volumes:  

  

If you imported books then you need to check the merged volumes. Unfortunately Springer does not always include the 
volume number in the KBART volume column. Therefore when you merge them, there will not be sufficient tagging with 
the URL to be able to tell the URLs apart, i.e., which URL goes with which volume. Once in Batch Control use Display 
Bibs-> Display the following MARC Tags=245,856->Workstation. Where ever you see more than one URL:  
 

     - test the URL directly from the Display Bibs report page;  

     - use Batch Control->Edit Bib to annotate to add the volume  

       values to MARC 856 subfield 3, Material type.  

  

Hint:  the Springer URLs in tag 856 $u contain the ISBN values. The ISBN tags 020 have the same ISBN values and 
probably show a volume number which you can copy to 856 $3. Please see the above " EXAMPLE SPRINGER 
VOLUMES."  
 

  

Finally, run Batch Control->Update Catalog with Batch. Do not run Batch Control->Item Creation because it is 
unnecessary and confusing to patrons and staff.  
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1.26 Teton Data System, TDS, STAT!Ref Metadata 
 
If you previously imported a Teton Data Systems (TDS) STAT!Ref collection then run Staff Functions->Cataloging-
>Remove Online Collection. Your MARC Boolean search SET A will be:  
 

   SET A 856 4 * $u CONTAINS online.statref.com  

  

TDS also delivers MARC bibliographic with URLs via  
 

    -  your TDS Administrative Portal;  

    -  TDS Support;  

    -  your regional system cataloger.  

  

The STAT!Ref MARC file should be imported via Staff Functions-> Cataloging-> Import a MARC Bib File. Use function 
[Browse to source file] to identify your MARC file. Select function [Import MARC File into Batch].  
 

If you import with "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - URL Link Text, Public Comments, & Rules  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you import without "Guide the Batch Control functions", then once in Batch Control you should select these functions:  
 

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation!   
 

Important note: when a new edition of a work is released by STAT!Ref, they often make minor, insufficient changes to the 
prior editions MARC. We've seen errors in this type of editing by STAT!Ref. Moreover, their MARC bibs are overwhelmed 
with branding, much of which is inconsistent. After you import these MARC bibs you should refresh them (Cataloging-
>Refresh MARC Bibs via Z39.50) with better data from NLM. Go to Cataloging->Batch Control->Display Bibs. Look for the 
start and end of contiguous MARC numbers:  these are your new bibs. Take the first and last MARC number of these 
contiguous MARC numbers and use them as the Starting MARC# and Ending MARC#.  
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1.27 Thieme Books and Journals Metadata 
 
  BEFORE YOU IMPORT:  

If you previously imported a Thieme collection then read this section. Otherwise go to the next section, IMPORTING 
Thieme.  
 

If you previously imported just one Thieme collection, or added Thieme online works individually, or if you are updating all 
of your Thieme collection, then before you import a current collection, run Staff Functions->Cataloging->Remove Online 
Collection. For all of Thieme your MARC Boolean search SET A will be:  
 

   SET A 856 4 * $u CONTAINS www.thieme-connect.de/products  

  

For all eBooks use  
 

   SET A 856 4 * $u CONTAINS www.thieme-connect.de/products/ebooks  

  

For all eJournals use  
 

   SET A 856 4 * $u CONTAINS www.thieme-connect.de/products/ejournals  

  

If you are updating one collection out of many Thieme imported collections, then the search needs more or different data. 
You can always use the import batch number stamp found in an existing Thieme MARC tag 856 $x, e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 

   IMPORTING Thieme:  

Thieme provides KBART formatted files. KBART is an NISO standard for exchanging ERM metadata. The Thieme 
KBART files are found at  
 

https://www.thieme.de/en/thieme-connect/product-information-13542.htm 

 

Instructions for Downloading Thieme E-Books Metadata: as of 2018-07-26, the E-Books KBART files are found under 
most of the E-Books collection names, e.g. "Thieme MedOne Spine". Select the collection's hyperlink, then select its 
KBART hyperlink (it tends to vary from collection to collection). Sometimes you download the text tab-delimited KBART 
file, sometimes you download a ZIP compressed file. If you download a compressed file the use Windows itself or any 
compressed file extraction program (e.g., 7-Zip or WinZip) to extract your collection's KBART text tab-delimited file. For 
example, the "MedOne Spine" collection filename is "7.8 eSpine-KBart-ExLibris.txt" (this name can change).  
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import.  Use function [Browse to source file] 
to identify your metadata file. The file format is KBART. Select function [Import file & process bibs] . You will automatically 
segue to the window URL Link Text, Public Comments, & Rules. Your metadata file is then copied from your workstation 
to the CyberTools server.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

https://www.thieme.de/en/thieme-connect/product-information-13542.htm
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   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  

 
1.28 Wiley Current Protocols, Journals, Online Book, and Reference Works Metadata 
 
  BEFORE YOU IMPORT:  

If you previously imported a Wiley collection then read this section. Otherwise go to the next section, IMPORTING Wiley.  
 

If you previously imported just one Wiley collection, or added Wiley online works individually, or if you are updating all of 
your Wiley collections, then before you import a current collection, run Staff Functions->Cataloging->Remove Online 
Collection. To remove all Wiley collections your MARC Boolean search SET A will be:  
 

   SET A 856 4 * $u CONTAINS onlinelibrary.wiley.com  

  

For all eBooks use  
 

   SET A 856 4 * $u CONTAINS onlinelibrary.wiley.com/book  

  

For all eJournals use  
 

   SET A 856 4 * $u CONTAINS onlinelibrary.wiley.com/journal  

  

If you are updating one collection out of many Wiley imported collections, then the search needs more or different data. 
You can always use the import batch number stamp found in an existing Wiley MARC tag 856 $x, e.g.,  
 

   SET A 856 4 * $x CONTAINS batch#NNNN  

  

where NNNN is the batch number.  
 

   IMPORTING Wiley:  

As of 2018-07-26 go to:  
 

   http://olabout.wiley.com/WileyCDA/Section/id-404513.html 

  

Under Resources for Librarians->Download Title and Price lists to find these four options of possible interest:  
 

   - 'Current Protocols' to download Current_Protocols_Title_and_Price_List.  

      xls  

   - 'Journals' to download all_wiley-blackwell_journals.xls  

   - 'Online Books' to download onlinebooks_list.xls  

   - 'Reference Works' to download wiley_online_reference_works.xls  

  

IMPORTANT NOTE 1:  Wiley customer service can send your journals' metadata in a spreadsheet file. It's better than 
downloading the "Journals Titles, Changes, and Collections" file because you do not have to remove titles to which you do 
not subscribe. Please see the next section, "Wiley Journals Generated File" for more information.  
 

Once downloaded open your file with a spreadsheet program.  
 

IMPORTANT NOTE 2: These Wiley metadata files all have the file extension ".xls". In fact, some are really ".xlsx". If your 
spreadsheet program complains about the file, then do not open it. Instead try changing the file extension to ".xlsx" via 
Windows Explorer rename. Everything will work better.  
 

Current Protocols: remove the rows of the titles for which you do not have access. Do not remove any header rows at the 
top of the sheets.  
 

Journals: select worksheet "Subscription Journals", typically the first worksheet. Note that when you run the CyberTools 
function [File Z39.50 MARC Bib Import] you can select specific Wiley Collections which might make deselecting titles in 

http://olabout.wiley.com/WileyCDA/Section/id-404513.html
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the spreadsheet unnecessary. Or, if you just subscribing to a small set of journals, then remove all titles which you are not 
subscribing.  
 

Online Books: first select worksheet "onlinebooks_list". Find the titles for which you have access and mark their row's 
column A with an X.  
 

Reference Works: remove the rows of the titles for which you do not have access. Do not remove any header rows at the 
top of the sheets, or in the middle of the sheet (the "Standard Reference Works" section.)  
 

  

For all files:  use the spreadsheet's menu bar->File->Save As. Change the "Save as Type" to be "Text (Tab delimited) 
(*.txt)".  
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import. Use function [Browse to source file] 
to identify your metadata file.  
 

For the field File Format, select the File Format that corresponds to your data:  
 

   - 'Current Protocols' is Wiley Current Protocols;  

   - 'Journals' is Wiley Subscription Journals;  

   - 'Online Books' is Wiley Online Books;  

   - 'Reference Works' is Wiley Reference.  

  

To effectively import the Wiley resources, it is important to have a major academic library's Z39.50 server on your list of 
Z39.50 servers. NLM and LOC will not have many of the records.  
 

Select function [Import file & process bibs]. You will automatically segue to the window URL Link Text, Public Comments, 
& Rules. Your metadata file is then copied from your workstation to the CyberTools server.  
 

When importing Wiley Subscription Journals, a popup will ask you to select one of the collections: Full, SSH, Medicine & 
Nursing, R4L, or INASP. Another popup asks if your subscription includes backfiles.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  
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1.29 Wiley Journals Generated File 
 
If you previously imported Wiley journals, or added Wiley online works individually, and do not have other Wiley 
resources, then before you import a current collection, run Staff Functions->Cataloging->Remove Online Collection. To 
remove all Wiley collections your MARC Boolean search SET A will be:  
 

   SET A 856 4 * $u CONTAINS onlinelibrary.wiley.com/journal  

  

Wiley customer service can send your Journals' metadata in a spreadsheet file. It's better than downloading the preceding 
section's "Wiley Subscriptions Journals" file because you do not have to remove titles to which you do not subscribe. 
Request your Journal metadata file from Wiley customer service. Save the Wiley spreadsheet on your workstation. Open 
the spreadsheet and File->Save As the spreadsheet as a " Text tab-delimited .txt" file.  
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import.  Use function [Browse to source file] 
to identify your Wiley text tab-delimited file. The file format is Wiley Journals Generated. Select function [Import file & 
process bibs]. You will automatically segue to the window URL Link Text, Public Comments, & Rules. Your metadata file 
is then copied from your workstation to the CyberTools server.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

  

Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  
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1.30 Wolters Kluwer Ovid Resources Metadata 
 
  BEFORE YOU IMPORT:  

If you previously imported an Ovid collection then read this section. Otherwise go to the next section, IMPORTING Ovid.  
 

If you previously imported just one Ovid collection, or added Ovid online works individually, or if you are updating all of 
your Ovid collections, then before you import a current collection, run Staff Functions->Cataloging->Remove Online 
Collection. To remove all Ovid collections your MARC Boolean search SET A will be:  
 

   SET A 856 4 * $u CONTAINS ovidsp.ovid.com  

  

Removing just one of the four Ovid collection types is more work. You need a SET A and B. SET A is for the URL. SET B 
is for one of the other subfield values in the same 856 occurrence, e.g., your unique batch number used in the import 
found in the 856 $x, or a word in the link text in 856 $y. For example, given this MARC tag for an Ovid book: 
 

   856 4# $u http://ovidsp.ovid.com/ovidweb.cgi?T=JS&NEWS=n&CSC=Y& 

          PAGE=booktext&D=books&AN=01257047$&XPATH=/PG(0)&EPUB=Y  

          $y Link to book at Ovid. $x Sue 20190628 batch#10715 hhh991_1913085.xml ovidxml 

 

then the search could be this: 
 

   SET A 856 4 * $u CONTAINS ovidsp.Ovid.com 

   SET B 856 4 * $x CONTAINS batch#10715 

   BOOLEAN EQUATION: A AND B 

 

or this: 
 

   SET A 856 4 * $u CONTAINS ovidsp.Ovid.com 

   SET B 856 4 * $y CONTAINS book 

   BOOLEAN EQUATION: A AND B 

 

View the removal tutorial silent recording here:   http://cybertools.biz/webex/erm/OvidRemove.mp4 
 

   IMPORTING Ovid:  

The resources are Books, Journals, Perpetual Access journals, and/ or DB Jumpstart.  
 

Download the Ovid Access Detail Report from the OvidSP Webstats Tool.  
 

Note: Ovid has historically called this report the "Ovid Entitlement Report" or "Ovid Database Entitlement Report."  
 

Go to  
 

   http://ovidspstats.ovid.com 

  

and login using your Webstats username and password. From the My Subscriptions tab, click on "Ovid Access Detail 
Report." Under Ovid Access Detail Report, choose the following options:  
 

   -Detail Level: Include Browse URLs  

   -Content Level: Include Books, Include Journals,  

                   Include Deposit - Your Ovid Full Text.  

   -Platform: OvidSP  

   -Recipients: Type in your email address.  

   -Available Groups: YourGroupID and/or Primary  

   -Selected Groups:YourID - IP-validated  

  

Click on Run Now. A few moments later go to the My Subscriptions tab at the "Completed Reports" link to download the 
new report. Save the xlsx file to your computer. (Or wait for the zipped version of the report sent to your email. Extract the 
spreadsheet xlsx file from the zip.). It is important that the columns and tabs in the file are not edited.  
  

http://cybertools.biz/webex/erm/OvidRemove.mp4
http://ovidspstats.ovid.com/
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To view a tutorial on how to run this report, see  
 

https://www.brainshark.com/wkovid/vu?pi=zGPzQX040z2tkwz0&cmpid=Brainshark:CreatingOvidSPStatsEntitlementRepo
rt 
 

For more information about downloading this report, please contact support@ovid.com.  
 

Open the file with any spreadsheet program. Use the spreadsheet's menu bar->File->Save As. Change the "Save as 
Type" to be "XML Spreadsheet" format. Do not change the file name, but do change the file extension from ".xlsx" to 
".xml".  
 

Go to your CyberTools Staff Functions->Cataloging->File Z39.50 MARC Bib Import.  Use function [Browse to source file] 
to identify your metadata file. The file format is Ovid. Select function [Import file & process bibs]. You will automatically 
segue to the window URL Link Text, Public Comments, & Rules. Your metadata file is then copied from your workstation 
to the CyberTools server.  
 

The file contains all of your Ovid resources, including Journals, Perpetual Access, Books, and DB Jumpstarts. If only one 
type of resource is in the file, then the software will import it. If more than one resource exists, the software presents a 
pop-up window menu, such as  
 

   Select an Ovid Collection for import:  

   Journals  

   Perpetual Access  

   Books  

   DB Jumpstarts  

   None  

   

If you want Perpetual Access, it must be imported first, i.e., before Journals. Then when importing Journals, when a 
journal matches a Perpetual Access journal, the extents between the two files is merged.  
 

When Books is selected, an additional popup appears:  
  

  |----------------------Remove old editions?----------------------|  

  | Ovid Books typically stock multiple editions of the same work. |  

  | Do you want all editions or just the current edition?          |  

  | [Just the current edition]  [All editions]  [Cancel]           |  

  |----------------------------------------------------------------|  

  

CyberTools recommends that you select [Just the current edition].  
 

The import can process only one resource at a time. Therefore after importing one collection, rerun function [File Z39.50 
MARC Bib Import] for the remaining collections, e.g., first do Books, then do Journals.  
 

If you import with the "Guide the Batch Control functions", then immediately after the import you will see these windows:  
 

   - MARCout Conversion (if necessary)  

   - Review URLs Retrieved from the catalog (if necessary)  

   - Assign A to Z Group ID  

   - Batch Control  

  

Once in Batch Control select function [Update Catalog with Batch]. You are done. Do not run Batch Control->Item 
Creation because it is unnecessary and confusing to patrons and staff.  
 

If you did not imported with "Guide the Batch Control functions" then once in Batch Control use:  
 

   - MARCout Conversion (if necessary)  

   - Remove Local Tags (if necessary)  

   - Review URLs Retrieved from the catalog  

   - Assign A to Z Group ID  

   - any miscellaneous editing  

   - Update Catalog with Batch  

https://www.brainshark.com/wkovid/vu?pi=zGPzQX040z2tkwz0&cmpid=Brainshark:CreatingOvidSPStatsEntitlementReport
https://www.brainshark.com/wkovid/vu?pi=zGPzQX040z2tkwz0&cmpid=Brainshark:CreatingOvidSPStatsEntitlementReport
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Do not run Batch Control->Item Creation because it is unnecessary and confusing to patrons and staff.  
 

View the import tutorial silent recording here:   http://cybertools.biz/webex/erm/OvidRemove.mp4 
 

Known Problems:   
 

P1. The Ovid data have many problems. Titles are not consistent. ISxN values are incorrect. The Journals' eISSN values 
are incorrectly applied to many titles which went through a name change. The same title and URL are displayed on 
multiple rows. A recent medical school's Ovid Journal file had 1071 records. CyberTools software corrected 139 flaws. 
CyberTools also merge 624 of the 1071 records. Thus the major of the records have problems.  
 

P2. Bad HTML character encoding. Ovid's XML use HTML character encoding for certain characters, e.g., "&amp;" is 
ampersand. This is normal. But there are some characters that do not make sense. For example, sometimes we see 
"&#26;" the ESCAPE character. It should never be in this data, so we remove it. We also see "&amp;NA;": we do not 
understand this encoding so we remove it.  
 

P3. Ovid Journals Duplicate Electronic ISSN Values. Ovid replicates a current title's electronic ISSN to the preceding 
series' title(s). This is incorrect; moreover it will only cause problems when retrieving MARC bibs. We clear these 
electronic ISSNs from these records when they are duplicated. The CyberTools Z39.50 MARC import process will 
intelligently insert the electronic ISSN into the correct record so all is well.  
 

P4. Ovid Books can have complete duplicate records. CyberTools keeps only one.  
 

How to Update: Whenever your Ovid contract changes, use Cataloging->Remove Online Collection with 856 4# $u 
CONTAINS ovid.com. After removing the Ovid collections, import the most recent Ovid Entitlement Report.  
 

The good news is that CyberTools fix these problems!  
 

http://cybertools.biz/webex/erm/OvidRemove.mp4
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2 Importing Aggregator's Metadata from Spreadsheet-like Files 
 
2.1 Overview to File Z39.50 MARC Bib Import 
 
Function [File Z39.50 MARC Bib Import] takes a file of bibliographic control numbers (i.e., ISBN, ISSN, or LCCN) and 
submits each control number to a Z39.50 server for the purpose of retrieving MARC bibliographic records. The data are 
placed into Batch Control where the cataloger can further process the bibs, e.g., modify call numbers or added entries, 
etc. Once the data in the batch are perfect, the batch is updated to the catalog for the library's use in circulation and the 
OPAC.  
 

This function is primarily used to import access to electronic resources from electronic resources aggregators, e.g., 
BioMed Central, ClinicalKey, EBSCO, IEEE, PubMed Central, Ovid, etc. This function can also be used as part of 
migration to the catalog from non-MARC sources.  

 
2.2 How File Z39.50 MARC Bib Import Works 
 
Some libraries and most electronic aggregators build spreadsheets filled with bibliographic data. It is easy to reformat a 
spreadsheet into the format that the CyberTools Z39.50 software can use to retrieve full MARC bibs from an authoritative 
source, such as the Library of Congress.  
 

The spreadsheet must be exported as a tab delimited file. Some files may use the comma-separated variable ("csv"), e.g., 
the PubMed Central Journal List. The exported file should reside on the cataloger's workstation. The cataloger starts this 
function and identifies the file. The cataloger will also specify if these entries should be treated as recent acquisitions, and 
how to resolve duplicate records. Optionally, any LCSH found in the bibs can be dynamically copied into the Subject 
Authority File.  
 

Often the classification methodology is not recorded in the original system, thus the classification field in the file is empty. 
Field Classification can establish the methodology.  
 

The Z39.50 Server field is a table lookup. This table is under the library's control via the functions Main Menu->Properties-
> Z39.50 Servers, i.e., the library can add servers to this list.  
 

Selecting the [Import Bibs] button makes the session contact the Z39.50 server(s). One by one the control numbers are 
queried, and bibs are hopefully retrieved and placed into the imported bib batch.  
 

Any control numbers that are not found are reported. The cataloger should save this report via the [File] option. That 
saved report can be resubmitted to another Z39.50 for MARC bib retrieval. If the original server was the Library of 
Congress, then sometimes re-submitting the failures back to LC will yield more favorable results.  
 

The retrieved bibs are in a batch file and the session is transferred to function [Batch Control]. Function [Batch Control] is 
documented elsewhere.  

 
2.3 Import CyberTools Default Metadata 
 
This CyberTools Default Tab Delimited File Format is split into two sections:  
 

  I. CyberTools Default Tab Delimited File Format  

  II. Importing the CyberTools Default Tab Delimited File Format  

  

I. CyberTools Default Tab Delimited File Format.  
 

The CyberTools Default Tab Delimited File Format is typically used for conversions from non-MARC sources which export 
spreadsheet or spreadsheet-like file (e.g., tab delimited, comma separated values ".CSV", etc.). The source file is then 
organized to match the CyberTools Default Tab Delimited File Format. The values must be delimited by a tab character 
(ASCII 9). The record format is:  
 

   A. Control Numbers (ISBN or ISSN)  

   B. Call Number  
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   C. Classification (D=DDC,L=LC,N=NLM,O=OTHER,nil)  

   D. Title  

   E. SERIAL (literally SERIAL)  

   F. Control Number Type (literally ISBN or ISSN)  

   G. Additional Control Numbers  

   H. Author  

   I. Remainder of Title  

   J. URL  

   K. URL Link Text  

   L. URL Public Comment  

   M. Edition Statement  

   N. Place of Publication  

   O. Name of Publisher  

   P. Date of Publication  

   Q. Extent  

   R. Other Physical Details  

   S. Dimensions  

   T. Thesaurus  

   U. Term  

   V. Series Statement Title  

   W. Second URL  

   X. Second URL Link Text  

   Y. Second URL Public Comment  

   Z. Textual Holdings  

   AA. Location  

   AB. Bar Code  

   AC. Volume  

   AD. Copy Number  

   AE. Price  

  

Letters were used since these source files are typically manipulated by spreadsheets, and spreadsheets use letters for 
column headings.  
 

The following are notes on the fields.  
 

A. Control Numbers: There needs to be one ISBN or ISSN. There can be more than one if they are comma delimited, e.g., 
0028-4793,1533-4406. They must be valid, i.e., the self check digit is calculated and invalid values are rejected:  they will 
not be submitted for Z39.50 searching.  
 

Please note that this value can work with the value in "G. Additional Control Numbers". "A. Control Numbers" is often the 
print control number whereas field "G. Additional Control Numbers" might be the on-line control number (or the inverse).  
 

An ISBN becomes 020 $a. An ISSN becomes 022 $a.  
 

B. Call Number can be any format.  
 

C. Classification can be D for DDC, L for LC, N for NLM, O for OTHER, or nil. If this value is not provided then it is derived 
by the software, i.e., this value is optional. The software can't tell the difference between Planetree and LC. Therefore if a 
library uses both LC and Planetree then L and O (for Planetree) are required.  
 

D. Title. If the title contains a colon then the software assumes the first part is the main title and the second part is the 
remainder. The title becomes 245 $a, and the remainder becomes 245 $b.  
 

E. This value should be SERIAL if the title belongs in Serials Management.  
 

F. Control Number Type for field "A. Control Numbers". The value are ISBN, ISSN, or LCCN. If this value is not provided 
then it is derived by the software. This value is optional.  
 

G. Additional Control Numbers can be an ISBN, ISSN, or LCCN. There can be more than one if these are comma 
delimited, e.g., 0028-4793,1533-4406. They must be valid, i.e., the self check digit is calculated and invalid values are 
rejected:  they will not be submitted for Z39.50 searching.  
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Please note that this value can work with the value in "A. Control Numbers". "A. Control Numbers" is often the print control 
number whereas field "G. Additional Control Numbers" might be the on-line control number (or the inverse).  
 

An LCCN becomes tag 010 $a. An ISBN becomes 020 $a. An ISSN becomes 022 $a.  
 

H. Author should be Last, First or a corporate format. A personal name becomes 100 $a. If the word editor appears in the 
personal name then the name becomes 700 $a. A corporate name becomes 110 $a or 710 $a.  
 

I. Remainder of Title becomes 245 $b.  
 

J. URL goes to MARC bib 856 $u with an indicator of 4#.  
 

K. URL Link Text goes to MARC bib 856 $y.  
 

L. URL Public Comment goes to MARC bib 856 $z.  
 

M. Edition Statement goes to 250 $a.  
 

N. Place of Publication goes to 260 $a. If the text is in the format  
 

     PLACE : PUBLISHER, cYEAR  

  

then PLACE goes to 260 $a, PUBISHER goes to 260 $b, and cYEAR goes to 260 $c.  
 

O. Name of Publisher goes to 260 $b.  
 

P. Date of Publication goes to 260 $c.  
 

Q. Extent goes to 300 $a.  
 

R. Other Physical Details goes to 300 $b.  
 

S. Dimensions goes to 300 $c.  
 

T. Thesaurus goes to 650, the second indicator. It should be one of the following value:  
 

     0 - Library of Congress Subject Headings  

     1 - LC subject headings for children's literature  

     2 - Medical Subject Headings  

     3 - National Agricultural Library subject authority file  

     4 - Source not specified  

     5 - Canadian Subject Headings  

     6 - Répertoire de vedettes-matière  

     LCSH  

     LCSHCL  

     MeSH  

     NAL  

     Blank which will automatically become 4.  

     CSH  

     RVM  

  

U. Term goes to 650 $a.  
 

V. Series Statement Title goes to 490 $a and 830 $a.  
 

W. Second URL goes to a MARC bib 856 $u with an indicator of 4#.  
 

X. Second URL Link Text goes to a MARC bib 856 $y.  
 

Y. Second URL Public Comment goes to a MARC bib 856 $z.  
 

Z. Textual Holdings goes to a MARC bib 866, Textual Holdings -Basic Bibliographic Unit,  subfield a, Textual holdings. 
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The first indicator is SPACE for "No information provided". The second indicator is 0 for Non-standard. It should be used 
for archival print serials that are not in Serials Management. This value can appear in the Search Catalog Search Results 
and Details.  
 

AA. Location goes to 852 $b.  
 

AB. Bar Code goes to 852 $p.  
 

AC. Volume goes to 852 $v.  
 

AD. Copy Number goes to 852 $t.  
 

AE. Price goes to 852 $9.  
 

The order of the fields must be maintained. The values must be tab delimited, and must not be quoted. The first row must 
have the same column heading as shown above, although empty columns are allowed.  
 
Download the CyberTools File Z39.50 template from here . 
 

The following is an example of a text file in the CyberTools format:  
 

 Control Numbers<TAB>Call Number<TAB>Classification<TAB>Title<TAB>  

   <TAB>SERIAL<TAB>Control Number Type<TAB>Author<TAB><TAB>  

   URL<TAB><TAB>URL Public Comment<TAB><TAB><TAB>Name of Publisher  

 0375414576<TAB><TAB><TAB>My Life<TAB><TAB><TAB><TAB>Clinton,Bill  

 0743226712<TAB>E208 .MCC 2005<TAB>LC<TAB>1776<TAB><TAB><TAB>  

   <TAB>McCullough, David G.  

 1527-1609<TAB><TAB><TAB>NAWCC bulletin<TAB>SERIAL<TAB>ISSN<TAB>  

   <TAB><TAB><TAB>http://nawcc.org<TAB>  

   <TAB>Link to publisher's web site<TAB>  

   <TAB><TAB>National Association of Watch and Clock Collectors  

  

The first row is the column headings in use.  
 

The second entry by ISBN for Bill Clinton's My Life. The retrieved bib will use the MARC bib's call number.  
 

The third entry is by ISBN for David McCullough's book 1776. The library has a unique LC classification for it.  
 

The last entry is by ISSN. The journal National Association of Watch and Clock Collectors bulletin will go into Serials 
Management.  
 

Please note that the following file would also be valid:  
 

  Control Numbers  

  0375414576  

  0743226712  

  1527-1609  

  

The above file contains just control numbers. Columns B through AE can be nil, but the order of the fields cannot change.  
 

The file can have an unlimited number of entries.  
 

The above concluded the file format documentation.  
 

II. Importing the CyberTools Default Tab Delimited File Format.  
 

The data are now ready to be imported in your catalog via function [File Z39.50 MARC Bib Import]. Use function [Browse 
to source file] to identify your file. From the File Format field, enter or select "CyberTools Default".  

 
2.4 Import a Spreadsheet-Like MARC Encoded File 
 

http://cybertoolsforlibraries.com/library/CyberTools_erm_template.xls
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Important note: this is not for importing a MARC file. It is for importing a spreadsheet(-like file) where the columns are 
encoded as specific tags and subfield. For example:  
 

  245 10 $a<TAB>100 1# $a<TAB>650 #0 $a  

  Moby Dick, or, the whale<TAB>Melville, Herman<TAB>Whales  

  JavaScript bible<TAB>Goodman, Danny<TAB>JavaScript (Computer  

    program language)  

  

Function [File Z39.50 MARC Bib Import] converts data from any spreadsheet(-like file) to MARC with the following steps:  
 

Step A. Insert a top row for column headings. Each column heading's format must be:  
 

   (Tag<occurrence delimiter>)<space>(Indicators)<space><$>  

   (Subfield)(Optional value)  

  

or  
 

   (Tag.#)<space>(Indicators)<space>$(Subfield)(Optional value)  

  

where  
 

A.1:  (Tag<occurrence delimiter>) = three digits for a MARC tag. The value has to be greater than 9. Tag values below 
100 must start with a zero. The tag does not have to be part of the MARC 21 standard. Here's a standard example of a 
tag with indicators and a subfield:  
 

      100 1# $a  

  

  

The optional <occurrence delimiter> is a single character that separates multiple occurrence, e.g.  
 

      100; 1# $a  

  

where the data might be  
 

      Bush,GH;Clinton,W;Bush,GW       

  

(Tag.#) = Tag is the same as above but includes the tag's occurrence value. When the occurrence value is not included, 
then the occurrence is 1 (one). Therefore, 650 and 650.1 represent tag 650's first occurrence. 650.2 represents tag 650's 
second occurrence. 650.10 is the tenth occurrence.  
 

A.2:  <space> is the space character, ASCII (10) 32.  
 

A.3:  (Indicators) should be two valid tag indicators, or blank. Use the character # when an indicator is the space 
character. When the indicators are blank, then the indicator from prior occurrence of the same tag are assumed. If there 
are none, then the indicators are spaces. One or more than two characters for indicators will be an error. For example,  
 

       650 #2 $a  

and    650  $x  

  

(notice the two spaces between the 650 and the $x) is the same as  
 

       650 #2 $a  

and    650 #2 $x  

  

Note that tag 245's second indicator is always re-calculated. For example, given the column heading "245 1# $a" and a 
row's value of "JavaScript Bible", the software converts the second indicator to 0 (zero). Given a different row's value "The 
HTML Guide", the software convert the second indicator to 4.  
 

A.4:  <$> is the dollar character. It represents the start of a subfield.  
 

A.5:  (Subfield) is a single character representing a tag's subfield. Only one occurrence of a tag, its indicator, and a 
subfield is valid, i.e., more than one column with the same tag, occurrence, and subfield is an error. For example, "500 ## 
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$a" in two columns is an error. Conversely, "500 ## $a" and "500.2 ## $a" are valid.  
 

Subfields are grouped by the tag occurrences. For example,  
 

      650 #2 $a  

  

is paired in the tag occurrence with  
 

      650 #2 $x  

and   650 #2 $v  

  

whereas  
 

      650.2 #2 $a  

  

is paired in the tag occurrence with  
 

      650.2 #2 $x  

and   650.2 #2 $v  

  

Note that tag 260, if the only subfield is $a, then the value is parsed into the correct values and punctuation for subfields 
a, b, and c. For example, a row's value of  
 

   "Boston, MA.: CyberTools, 2016."  

  

will be split into  
 

   260 ## $a Boston, MA.: $b CyberTools, $c 2016.  

  

Note that tag 650, when only using subfield $a, if a row's value contains the CIP formatting "--" then the value is parsed 
into the correct subfields. For example, a "650 #2 $a" of "Viruses--diagnosis--Mexico--1970-- handbook" becomes  
 

   650 #2 $a Viruses $x diagnosis $z Mexico $y 1970 $v handbook  

  

A.6:  (Optional value) is static value assigned to all occurrence of the subfield. Conversely, the values that follow in the 
column are ignored. For example:  
 

   856 41 $y Click here to access this online resource.  

  

then each MARC bib will be assigned tag 856 $v as "Click here to access this online resource."  
 

Special note:  tag 029 can be a mix of ISBN, ISSN, and LCCN. CyberTools will attempt to move the value to the correct 
tag, i.e., 020, 022, or 010, respectively.  
 

Step B. Save the spreadsheet as a text tab-delimited file.  
 

B.1: The file must be a text tab-delimited file.  
 

B.2: The file name must contain MARC and ".txt".  
 

B.3: Note that any cell that starts and ends with double quotes has the quotes removed.  
 

Step C. Import the MARC.txt file via Function [File Z39.50 MARC Bib Import].  
 

Use function [Browse to source file] to identify your file. For the File Format, select "MARC Coded Text Tab-Delimited".  
 

C.1: Note that the Z39.50 is not actually used. The data are directly converted to MARC. The converted data are sent to 
function [Batch Control] for further editing. If the data are good enough, then use Batch Control->Update Catalog with 
Batch to process the data to the catalog.  
 

C.2: If you want to replace your converted data with MARC from authoritative catalogs, note the starting and ending 
MARC numbers in the Batch in step C.1. Use function [Refresh MARC Bibs via Z39.50] with the previously noted MARC 
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number range.  
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2.5 File Z39.50 MARC Bib Import 
 

 
 
2.6 Fields:  File Z39.50 MARC Bib Import 
 
2.6.1 Field 1 Status of the Process:  60 characters, display only 
Displays the message "Working..." and/or other messages while the software processes the data.  
 
2.6.2 Field 2 Browse to source file:   
This push button enables the user to navigate to the target file on the user's workstation. The native workstation file 
browser is invoked to identify the file.  
 
2.6.3 Field 3 Filename:  150 characters 
This field specifies the target file name. The file name must include the directory paths (folders).  
 

Format: It is any legal directory path and file name for your server.  
 

Discussion: The file name is displayed in this field, and the file is copied from the workstation to the server.  
 

Example: On MS Windows, a file name with its folders might be  
 

     C:\temp\today\my_file.txt  

 

 
2.6.4 Field 4 File Format:  70 characters, mandatory 
This tells function [File Z39.50 MARC Bib Import] how to interpret the contents of the selected file. This field's options can 
be listed via the table list drop-down button. Each File Format is fully explained elsewhere as noted below.  
 

a. when online and viewing this message interactively, this window's pop-up is replaced by a thorough discussion in a 
subsequent pop-up window;  
 

b. when online and not in a help pop-up, then the Options function key F3 yields a pop-up with the menu item Extended 
Help;  
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c. any reference manual format (e.g., HTML or PDF) discusses the various File Formats in detail.  
 
Table Values: 
BioMed Central Journals 
ClinicalKey Book URLs (not Nursing) 
ClinicalKey for Nursing Book Titles URLs 
ClinicalKey for Nursing Journal Titles Durable URLs 
ClinicalKey for Nursing Master Content List Books 
ClinicalKey for Nursing Master Content List Journals 
ClinicalKey Journal URLs (not Nursing) 
ClinicalKey Master Content List Books (not Nursing) 
ClinicalKey Master Content List Content Updates (not Nursing) 
ClinicalKey Master Content List Journals (not Nursing) 
CyberTools Default 
DOAJ (Directory of Open Access Journals) 
EBSCO A-Z 2015 
EBSCO eBook ADDITIONS 
EBSCO eBook Collection 
EBSCO eBook REMOVALS 
EBSCO Journals 
HighWire A-Z List 
IEEE Books 
IEEE Journals 
KBART 
Liebert Online Journals 
MARC Bibliographic 
MARC Tag Encoded Columns 
McGraw-Hill eBooks 
Ovid XML format 
Procedures Consult 
PubMed Central Journal List 
Rittenhouse R2 Digital Library 
Sage Journals 
ScienceDirect (Current) 
ScienceDirect Old Serial and Non-Serial Books Content 
ScienceDirect Old Serial Content 
Springer eBook Spreadsheet 
Wiley All Current Journals 
Wiley Journals Generated 
Wiley Online Books 
Wiley Online Reference Works 
Wiley Open Access Journals 
 
2.6.5 Field 5 Place on Recent Arrivals:  mandatory 
Specifies that the MARC bibliographic import file contains new titles that should be added to the Search Catalog's Recent 
Arrival list. Three conditions exist for MARC bibliographic records:  
 

     - None of the records are new (e.g., retrospective  

       cataloging);  

  

     - The software should match ISSN/ISBN, LCCN, or other  

       control numbers to determine if the bib is new, and only  

       newly matched MARC bibs will be added to the Recent  

       Arrivals list;  

  

     - All of the records are new.  

  

Format: It is a radio button selection.  
 
Menu Style:  Radio Button/Check Box 
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Menu Values: 
None 
New Matches Only 
All 
 
2.6.6 Field 6 Modify Rules for Bib Match:   
Allows the cataloger to temporarily change the rules to match imported bibs to bibs already in the catalog and/or to other 
bibs within the imported file.  
 
2.6.7 Field 7 Guide the Batch Control functions:   
Option "Guide the Batch Control functions" automatically runs a number of the Batch Control functions after the import:  
 

  -> NLM MARCout Conversion;  

  -> Remove Undesired Local Tags.  

  

If the import was started via function  
 

   + [File Z39.50  MARC Bib Import];  

   + or [via Import a MARC Bib File] and there are more than 9  

     records in the batch  

  

then these additional Batch Control->Tools functions are automatically run:  
 

  -> Review Prior URLs (but only if they exist);  

  -> Assign A to Z Group IDs.  

  

If the import was started via function [Import a MARC Bib File] and a record has an occurrence of a tag which match a 
MARC Import Holdings Profiles tag and subfield for a call number, then Batch Control->Import Profile Call# Copy is 
automatically run.  
 
2.6.8 Field 8 Add selected thesauri imported terms to catalog's thesaurus:  multiple 
The selected thesauri's terms not found in the catalog's thesaurus will be added to the catalog's thesaurus as part of the 
MARC bib import. MARC from LC, NLM, and most major universities are acceptable donors. CyberTools recommends 
that health sciences libraries add LCSH and MeSH.  
 

Here are the decoding of the abbreviations. # stands for the 6XX indicator 2 value.  
 

 #  code  Name  

 0  LCSH  Library of Congress Subject Headings  

 1  LCSH Children's  

 2  MeSH  Medical Subject Headings  

 3  NAL   National Agricultural Library  

 4  SNS   Source not specified  

 5  NLC   Library and Archives Canada  

 6  RVM   Bibliotheque de l'Universite de Laval  

 7  $2    Source specified in subfield $2  

 

 
2.6.9 Field 9 Z39.50 Servers:  10 characters, multiple, mandatory 
Specifies the Z39.50 Servers from which to retrieve bibliographic data.  
 
  Server                                     Database  Primary  

  Code      IP Address                 Port #    Name  Classif.  

  --------  ----------                 ------  ------  -------- 

  SHDWNLM   cybertoolsforlibraries.com    210  SHDWNLM      NLM  

  

Server SHDWNLM is special. CyberTools collects many of the frequently used health sciences MARC bibs in a catalog 
called SHDWNLM, the Shadow NLM. We've removed much of the local NLM Bethesda data, e.g., statements on 
microfiche holdings. We've fixed incorrect data. When a CyberTools hosted catalog accesses SHDWNLM, the transport is 
local, i.e., a query to it does not go across Internet, so it is very fast. For example, importing the 1800 titles for the PubMed 
Central journal list from the NLM Z39.50 server takes at least one hour outside normal business hours. During business 
hours it can take many hours. In contrast SHDWNLM takes under two minutes. When a record is not found at 
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SHDWNLM, then the request is sent to NLM. Lastly, SHDWNLM's catalog is regularly refreshed with NLM's current data.  
 
2.6.10 Field 10 Z39.50 Properties:   
Function [Z39.50 properties] opens a window that controls Z39.50 behavior.  
 
Menu Style:  Push Button 
Menu Values: 
Z39.50 properties... 
 
2.6.11 Field 11 Controls: Import, Cancel, Help:   
Specifies an action that controls the window's flow. The load file push button will move the specified file into the 
application, whereas [Cancel] will reject the changes. [Help] will display all of the documentation for the window. Press the 
Help key for context sensitive help for each field.  
 

Format: Select the desired push button with a click or focus on it and press ENTER.  
 
Menu Style:  Push Button 
Menu Values: 
Import file & process bibs 
Cancel 
Help 
 
[Import file & process bibs] first copies the file containing the control numbers into this session. It then submits each 
control number to the target Z39.50 server. If the bibs exists on the server, then the server will return the MARC bib back 
to this session. The bib is placed into a batch. Once all of the bibs are retrieved, then the user is brought into the [Batch 
Control] function for further processing.  
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2.7 Overview to Duplicate Bibs Importing Rules 
 
This is accessed via the push button [Duplicate Bibs Importing Rules] from function [Import a MARC Bib File] or [File 
Z39.50 MARC Bib Import]. The rules are taken from the Catalog [Defaults] but can be changed for the immediate import 
session.  
 

Please note that the selections are sometimes automatically changed by function [File Z39.50 MARCBib Import].  

 
2.8 Duplicate Bibs Importing Rules 
 

 
 
2.9 Fields:  Duplicate Bibs Importing Rules 
 
2.9.1 Field 1 If bib matches an existing one:  mandatory 
The selected option determines the default action when an imported bib matches a bib already in the catalog.  
 

Format: It is a radio button selection.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Show & Ask Overlay/Cancel/Create/Retrieve Bib 
Overlay Catalog's Bib with Imported Bib 
Set Imported Bib's Status to CANCEL 
Create a New Bib for the Catalog 
Retrieve catalog's bib & add unique data 
 
Discussion: The importing software compares some of the key identifying values in the imported bib(s) to existing bibs in 
the catalog. If the software finds a match on the following MARC tags  
 

     001   Control Number  

     010   Library of Congress Control Number  

     020   International Standard Book Number  

     022   International Standard Serial Number  
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then the cataloger must determine the next action. It is possible that the bib is really not a duplicate or an update, but a 
true new bib, but this is unlikely. The most common legitimate reason is when a large MARC file contains multiple bibs 
which match on the same ISSN number because the publisher changed the title (thus the multiple bibs) but failed to 
change the ISSN.  
 

Option "Show & Ask Overlay/Cancel/Add Imported Bib" will display each bib's key identifiers and the title from the 
imported bib and the bib in the catalog. Along with the display, the cataloger will get to choose the next action:  
 

     Overlay Catalog's Bib with Imported Bib  

     Set Imported Bib's Status to CANCEL  

     Create a new Bib for the Catalog  

  

These actions are described below. One of these actions may be determined at the beginning of the import, i.e., rather 
than show the individual bibs and their values, simply determine the rule in advance.  
 

Option "Overlay Catalog's Bib with Imported Bib" will load the imported bib into the batch using the catalog's matching 
bib's MARC Number. When the cataloger uses the Batch Control function [Updated to the Catalog], then at that point the 
newly imported bib would replace the catalog's old bib. The old bib's items (i.e., the holdings) are assumed by the new 
bib. Alternatively, the cataloger may manually CANCEL the bib in the batch prior to the Update to the Catalog function, 
thus protecting the old bib from the new bib. Because of the flexibility of this action, this action is the recommended 
choice, unless the cataloger knows that the bib is really new.  
 

Option "Set Imported Bib's Status to CANCEL" loads the new bib into the batch but sets the bib's status to CANCEL, 
making it impossible to Update the Catalog with the new bib. Nevertheless, the imported bib can be reviewed in the batch.  
 

Option "Create a new Bib for the Catalog" will create a new instance of the bib in the catalog. This new bib will be 
completely independent from the old bib, and will have its own holdings. It is unusual to select this action. If this action is 
erroneously selected, then the catalog will have duplicate bibs.  
 

Keep in mind that the bib is the idea of the title, and the items (holdings) are the actual instances of the materials. Items 
are attached to bibs.  
 

Option "Retrieve catalog's bib & add unique data" will first test to see if an imported bib record's control number matches a 
bib record that is already in the catalog. If a matching bib is found in the catalog, then the catalog's bib is added to the 
batch. The system then checks to see if there are unique data in the imported bib record such as URLs and/or holdings 
data. If so, then these unique data are added to the bib in the batch. If the imported bib is not found in the catalog then it is 
added to the batch.  
 
2.9.2 Field 2 Duplicate Bibs Importing Rules:  multiple 
When importing MARC bibs, the records can be checked against the catalog and the import file itself for duplicate 
records. If a duplicate is found, then the session's "If a bib matches an existing one" choice determines how the record will 
be processed.  
 

The duplicate checking rules are:  
 

Control#: tag 001: The software removes all beginning and trailing spaces for the comparison. It does not simply check 
the numeric portion. If the value starts with tds, for Teton Data  Systems, then the value is not used to match. Teton Data 
Systems uses the same value on sequential editions.  
 

LCCN: tag 010 $a: This is the unique Library of Congress Control Number.  
 

ISBN: tag 020 $a: All occurrences of the ISBN are checked.  
 

ISSN: tag 022 $a: All occurrences of the ISSN are checked.  
 

Call Number: The call number is determined according to the Call Numbers Tags for this Catalog value. Call numbers 
from the import holdings profiles are not used.  
 

Ignore Call Numbers without Numbers: This option is only applicable if call numbers are being checked. It will bypass any 
call number that lacks a number, such as Online, Web, etc.  
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Confirm title 245 $a: This option normalizes the title, clears punctuation, and then compares the titles to confirm that the 
record is a duplicate. We recommend only using this option with great care because the metadata from content providers 
can be inconsistent.  
 

Confirm publication year 260 $c: This option normalizes the year, clears punctuation, and then compares the years to 
confirm that the record is a duplicate. If a year is blank then it is counted as a match. We recommend using this option.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Control#:  tag 001 
LCCN: tag 010 $a 
ISBN: tag 020 $a 
ISSN: tag 022 $a 
Call Number 
Ignore Call# without Numbers 
Confirm title 245 $a 
Confirm publication year 260 $c 
 
2.9.3 Field 3 Match on $z then convert to $a:  multiple 
The Library of Congress ISBN MARC tag 020 subfield z definition (http://www.loc.gov/marc/bibliographic/bd020.html 
accessed October 2017) is a "Canceled/invalid" value. Similarly the ISSN tag 022 subfield z is a "Canceled ISSN" 
(http://www.loc.gov/marc/ bibliographic/bd022.html accessed October 2017). Normally subfield z is used to document a 
mistake that typically the publisher made at some point in time.  
 

Similarly, the Library of Congress tag 022 subfield y definition (http://www.loc.gov/marc/bibliographic/bd022.html accessed 
November 2012) is an "incorrect" value.  
 

Some aggregators' MARC bib collections convert the 02X $a value for the print to be a 02X $y or $z.  
 

In order to make the MARC bibs more generic and thus less tied to online manifestations, CyberTools recommends 
restoring the 02X $z to $a.  
 

Option "Any 020 $z or 022 $z when the $a is missing" should be used on MARC bibs sourced from Gale or OCLC (e.g., 
the ClinicalKey collection).  
 

Option "McGraw-Hill/Cassidy 010, 020, & 022 $y & $z" fixes MARC bibs from Cassidy Cataloging Service where tags 
010, 020, and 022 subfield y & z are coded incorrectly. This CyberTools import option moves the value from subfield y or 
z to subfield a, where the value belongs. The software tests if the MARC bib has any of these values:   
 

  - tag 001 starts with ccn AND  

  - tag 856 $u contains www.access or jamaevidence.com   

   

If the control number tag has no subfield a, but has a subfield z, then subfield z is moved to subfield a.  
 
2.9.4 Field 4 Controls Ok, Cancel, & Help:   
Specifies an action that controls the window's flow. [Ok] will save and apply the displayed values, while [Cancel] will reject 
the changes. [Help] will display all of the documentation for the window. Press the Help key for context-sensitive help for 
each field.  
 

Format: It is an action that toggles the push button.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help 
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2.10 Overview to Z39.50 Properties Window 
 
The Z39.50 Properties window is accessed by choosing function [Z39.50 Properties] from the windows "Interactive Z39.50 
MARC Bib Import", "File Z39.50 MARC Bib Import", and "Refresh MARC Bibs via Z39.50". This window controls:  
 

   -  adding failed records as skinny (basic) MARC bibs;  

   -  removal of MARC tag 856 (i.e., URLs);   

   -  limiting the retrieval to one record;   

   -  matching on ISBN tag 02X $z (Canceled/ invalid values).  

 

 
2.11 Z39.50 Properties 
 

 
 
2.12 Fields:  Z39.50 Properties 
 
2.12.1 Field 1 Remove 856 tags imported by Z3.90:  multiple 
Field "Remove tag 856 imported by Z39.50" can remove URLs that are not applicable to your collection. There are two 
different URL problems to consider.  
 

The first URL problem: if the target Z39.50 is the Library of Congress, then many of the LC bibs have enrichment tags. For 
example, Harrison's principles of internal medicine / 2008 at loc.gov has these MARC bib 856 tags:  
 

856  41 $3 Table of contents only $u http://www.loc.gov/catdir/ toc/ecip0714/2007012181.html  
 

856  42 $3 Contributor biographical information $u http://www.loc. gov/catdir/enhancements/fy0745/2007012181-b.html  
 

856  42 $3 Publisher description $u http://www.loc.gov/catdir/ enhancements/fy0745/2007012181-d.html  
 

For some libraries, the above links have value. Other libraries dislike these data (citing that it is publisher data for the work 
prior to publication and therefore might not be accurate). If you do not want these LC URLs in the bibs that you download 
from LC, then select option "{Remove} loc.gov TOC and Enhancement URLs".  
 

The second URL problem is when Z39.50 returns MARC bibs that often have links to subscription services applicable to 
the source library which will probably not work for your library. For example, we've seen Ovid, EBSCO, and other 
publishers' links at NLM. Most of these sites are marketing tools for fee-for-access, thus making the URLs undesirable. In 
either case you probably do not want these URLs, so select "All URLs apart from the above loc.gov URLs".  
 

Please note that CyberTools enables you to easily import Open Access bibs with URLs (e.g., BioMed Central, HighWire, 
or PubMed Journal List). You can also import bibs with URLs for subscription services.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
loc.gov TOC and Enhancement URLs 
All URLs apart from the above loc.gov URLs 
 
2.12.2 Field 2 Take first Z39.50 return when more than one:   
Option "Take first Z39.50 return when more than one" simplifies importing MARC bibs by Z39.50. The option is selected 
as a default. You should not change it except under one circumstance that will be explained later.  
 

When using Z39.50, the CyberTools software submits the cataloger's control numbers (i.e., ISBN, ISSN, or LCCN values) 
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to the Z39.50 servers. A Z39.50 server can come back with multiple bibliographic records. LC and NLM rarely return more 
than one bib because their catalogers follow the FRBR principle that one bib represents both print and online. 
Unfortunately not all academic collections adhere to this important principle thus will have one bib for print and a different 
bib for online. In unmonitored union catalogs (e.g. OHIOLINK) each library might have its own unique bibliographic record 
for the same work found elsewhere, regardless of print and/or online. Another problem is that electronic aggregators (e.g., 
Ovid) often assign a contemporary eISSN to old journals which had changed their names, e.g., Current Opinion in 
Orthopaedics is erroneously assigned the eISSN 1941-7551. That ISSN actually belongs to the succeeding title Current 
Orthopaedic Practice.  
 

The CyberTools option "Take first Z39.50 return when more than one" looks at all of the bibs returned by a Z39.50 query, 
and takes the first good match. This process is ideal and important when importing electronic resources bibs via function 
[File Z39.50 MARC Bib Import]. Otherwise the cataloger is asked to choose between all of the returning records. It is 
impractical and unnecessary to make these selections: any similar bib will do for these large collections. Therefore option 
"Take first Z39.50 return when more than one" should always be selected for mass imports (i.e., functions [File Z39.50 
MARC Bib Import] and [Refresh Bibs via Z39.50]). It is less necessary for function [Interactive Z39.50 MARC Bib Import] 
since it is unlikely the cataloger is requesting a large number of works.  
 

If function [Interactive Z39.50 MARC Bib Import] returns a bib that is not very good, then the process should be redone 
with this option deselected.  
 

When option "Take first Z39.50 return when more than one" is selected, and a server returns more than one result, the 
software looks at MARC tag 245 subfield h: if it contains the characters "microf" then the software disregards "Take first 
Z39.50 return when more than one" until a non-"microf" bib is found. It is unlikely that a new acquisition today will be in 
microform or microfiche, so CyberTools will attempt to retrieve a better MARC bib. The subsequent bibs will be displayed 
in the duplicate bib popup: the first bib's 245 $h without "microf" should overlay the bib in the batch. An example of this is 
requesting New England journal of medicine ISSN 0028-4793 from OHIOLINK on 2015.9.14.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Take first Z39.50 return when more than one 
 
2.12.3 Field 3 Controls Ok, Cancel, & Help:   
Specifies an action that controls the window's flow. [Ok] will save and apply the displayed values, while [Cancel] will reject 
the changes. [Help] will display all of the documentation for the window. Press the Help key for context-sensitive help for 
each field.  
 

Format: It is an action that toggles the push button.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help 
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2.13 Overview to Source File Duplicates 
 
Function [File Z39.50 MARC Bib Import] scans the import file for duplicate control numbers. These duplicates are 
reported. The cataloger can cancel the import, correct the source file, and then restart the import. Or the cataloger can 
continue the import and let the importing tools correct the duplicates.  
 

There are three types of duplicates. The first type is a mistake, for example when records erroneously share control 
numbers.  
 

The second type of duplicate is for secondary publication for a journal title, for example, newsletters or separately titled 
supplements. These can legitimately share control numbers. It is our preference, and the current cataloging practice that 
one bib represents all publications for a title. Nevertheless the library can choose to manage a bib for each publication.  
 

The third type of duplicate occurs when a publisher changes a journal's title and unfortunately keeps the old ISSN.  
 

The following Duplicate Control Numbers in Source report is for a content vendor's Serials file. The first pair is a mistake 
since Foot and Ankle Clinics has the ISSN 1083-7515.  
 

The second pair demonstrates a lazy publisher that changed a title but continued with the old ISSN.  
 

 ---------------------------------------- 

 Duplicates for ISSN 1064-7406  

  

 Record# 56  

 Title: Facial Plastic Surgery Clinics of North America  

 Additional Control Numbers: 1064-7406  

 Publisher: W.B. Saunders  

 URL: http://www.mdconsult.com/public/search?search_type=journal&  

 j_sort=pub_date&j_issn=1064-7406  

 URL Link Text: Feb 2002 - present  

  

 Record# 58  

 Title: Foot and Ankle Clinics  

 Additional Control Numbers: 1064-7406  

 Publisher: W.B. Saunders  

 URL: http://www.mdconsult.com/public/search?search_type=journal&  

 j_sort=pub_date&j_issn=1064-7406  

 URL Link Text: Mar 2002 - present  

 ---------------------------------------- 

 Duplicates for ISSN 1462-9410  

  

 Record# 52  

 Title: Evidence Based Healthcare and Public Health  

 Additional Control Numbers: 1462-9410  

 Publisher: Churchill Livingstone  

 URL: http://www.mdconsult.com/public/search?search_type=journal&  

 j_sort=pub_date&j_issn=1462-9410  

 URL Link Text: Oct 2004 - Dec 2005  

  

 Record# 53  

 Title: Evidence-based Healthcare: A Scientific Approach to Health  

 Policy Additional Control Numbers: 1462-9410  

 Publisher: Churchill Livingstone  

 URL: http://www.mdconsult.com/public/search?search_type=journal&  

 j_sort=pub_date&j_date_range=1995-current&j_issn=1462-9410  

 URL Link Text: Mar 1999 - Aug 2004  
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2.14 Source File Duplicates 
 

 
 
2.15 Fields:  Source File Duplicates 
 
2.15.1 Field 1 Records with duplicates:  70 characters, display only 
This field displays the count of records with duplicate key values, for example, duplicate ISSNs, ISBNs, and/or URLs. If a 
record has more than one value that is a duplicate then the record is still counted once.  
 
2.15.2 Field 2 Window Status:  60 characters, display only 
Displays the message "Working..." while the process is computing.  
 
2.15.3 Field 3 Choice of the Target Device:   
Specifies the target device for the output. Choices include Workstation, Printer, File, or send to an E-mail address.  
 
Menu Style:  Push Button 
Menu Values: 
Workstation 
Printer 
File 
E-mail 
Help 
 
2.15.4 Field 4 Resolve Source File Duplicates:   
Specifies the cataloger's action to resolve the duplicate.  
 

Function [Edit the duplicate records now] displays each cluster of duplicate records in a window with the fields Title, 
Control Numbers (i.e., ISSNs and/or ISBNs), URLs, URL Link Text, and URL Public Comments. The cataloger can do the 
following in the window:  
 

  a. correct values;  

  b. mark a record to be removed from the import;  

  c. merge the URLs from one record to another.  
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This function should be easier to use than the following function. It is recommended for when there is a small number of 
dups.  
 

[Import now] will start the import. When a dup is found, the software will try to:  
 

 1. merge the record's URL(s) into an existing bib in the batch;  

 2. or display solutions and ask you to pick one.  

  

[Cancel import so I can fix the source file] will stop the import. The cataloger should repair the data and then restart the 
import. This is the preferred choice for when there is a very large number of dups.  
 
Menu Style:  Push Button 
Menu Values: 
Merge all duplicate ISBN and ISSN works 
Edit the duplicate records now then import 
Import now 
Cancel import so I can fix the source file 
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2.16 Overview to Edit Records with Duplicate Values 
 
Function [Edit Records with Duplicate Values] is part of the function [File Z39.50 MARC Bib Import] process. When 
importing a file that has records with duplicate control numbers and/ or URLs, the software will report the duplicates and 
give options for dealing with them. One response to resolving the duplicates is the function [Edit Records with Duplicate 
Values].  
 

The [Edit Records with Duplicate Values] window will appear for each cluster of duplicates. For example, if your file 
contains the following records with duplicate control numbers and URLs, the window will first allow you to resolve ISSN 
2044-8325 and will then allow you to resolve http://wiley.com/journal/10.1111/(ISSN)1556-3502/issues. For example, 
given this duplicate report:  
 

 Duplicates for ISSN 2044-8325  

  

 Record# 186  

 Control Numbers: 0007-1269  

 Title: BRITISH JOURNAL OF PSYCHOLOGY  

 Additional Control Numbers: 2044-8325  

 URL: http://wiley.com/journal/10.1111/(ISSN)2044-8295  

 URL Link Text: Link to journal's homepage at Wiley.  

 URL Public Comment: Starting year: 1999; starting volume: 90.  

  

 Record# 778  

 Control Numbers: 0963-1798  

 Title: JOURNAL OF OCCUPATIONAL AND ORGANIZATIONAL PSYCHOLOGY  

 Additional Control Numbers: 2044-8325  

 URL: http://wiley.com/journal/10.1111/(ISSN)2044-8325  

 URL Link Text: Link to journal's homepage at Wiley.  

 URL Public Comment: Starting year: 1999; starting volume: 72.  

 ------------------------------------------------------------- 

 Duplicates for URL  

 http://wiley.com/journal/10.1111/(ISSN)1556-3502/issues  

  

 Record# 1340  

 Title: ACTA CRYSTALLOGRAPHICA SECTION E  

 Additional Control Numbers: 1600-5368  

 URL: http://wiley.com/journal/10.1111/(ISSN)1600-5368  

 URL Link Text: Link to journal's homepage at Wiley.  

 URL Public Comment: Starting year: 2001; starting volume: 57.  

 Second URL: http://wiley.com/journal/10.1111/(ISSN)1556-3502/  

             issues  

 Second URL Link Text: List of issues.  

  

 Record# 1341  

 Control Numbers: 1541-6151  

 Title: ANTHROPOLOGY NEWS  

 Additional Control Numbers: 1556-3502  

 URL: http://wiley.com/journal/10.1111/(ISSN)1556-3502  

 URL Link Text: Link to journal's homepage at Wiley.  

 URL Public Comment: Starting year: 1997; starting volume: 38.  

 Second URL: http://wiley.com/journal/10.1111/(ISSN)1556-3502/  

             issues  

 Second URL Link Text: List of issues.  

  

then this window first appears to resolve ISSN 2044-8325, and then appears to resolve 
http://wiley.com/journal/10.1111/(ISSN)1556-3502/issues.  
 

The ISSN duplicate is fixed by changing the first record Additional Control Numbers from 2044-8325 to 2044-8295. The 
URL duplicate is fixed by changing the first record's Second URL from  
 

http://onlinelibrary.wiley.com/journal/10.1111/(ISSN)1556-3502/issues 
 

http://onlinelibrary.wiley.com/journal/10.1111/(ISSN)1556-3502/issues
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to  
 

http://onlinelibrary.wiley.com/journal/10.1111/(ISSN)1600-5368/issues 

  

http://onlinelibrary.wiley.com/journal/10.1111/(ISSN)1600-5368/issues
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2.17 Edit Records with Duplicate Values 
 

 
 
2.18 Fields:  Edit Records with Duplicate Values 
 
2.18.1 Field 1 Report:  78 characters, display only 
 
2.18.2 Field 2 Record Number:  4 characters 
This is a sequential number assigned to the data when the data were copied from the source file to the import file.  
 
2.18.3 Field 3 Title:  280 characters, mandatory 
This is the title of the work as found in the source data.  
 
2.18.4 Field 4 Merge URLs into record number:  4 characters 
This field allows one of the other record numbers in the window to be selected as the recipient of this record's URLs. After 
the URLs are merged, this record is then automatically removed.  
 
2.18.5 Field 5 Remove Record:   
This check box simply expunges the record from the import process.  
 
2.18.6 Field 6 Control Numbers: ISSN or ISBN:  90 characters 
This field enables editing all of the ISSN and/or ISBN values for the record. Multiple values are separated by commas. 
Often a record contains an incorrect control number: these bad values can either be removed or corrected.  
 
2.18.7 Field 7 URL Number:  3 characters, display only 
This display-only field is a sequential number to aid in differentiating multiple URL records per title.  
 
2.18.8 Field 8 URL Supplied by Aggregator:  500 characters 
This is the link supplied by the source data. It can be corrected here. Since most of the source documents are 
spreadsheets, the spreadsheet's authors occasionally paste the same URL into multiple records, thus creating URL 
duplicates.  
 
2.18.9 Field 9 Linkage $8:  50 characters 
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Purpose: 856 $8 Linkage is an identifier that links to an occurrence of tag 774, Constituent Unit Entry, or even tag 245, 
Title Statement. 774 is typically used to capture volume, part, supplement, or any auxiliary data. Do not edit these data.  
 
2.18.10 Field 10 Link Text, 856 $y:  300 characters 
This field enables the user to add/modify text to clarify the uniqueness of multiple URLs. The Link Text will be the 
displayed as hypertext for the URL.  
 
2.18.11 Field 11 Public Comment, 856 $z:  300 characters 
The Public Comment usually states the extent of the URL.  
 
2.18.12 Field 12 Materials Specified, 856 $3:  300 characters 
 
2.18.14 Field 14 Save&Continue, Cancel, & Help:   
Specifies an action that controls the window's flow. [Ok] will save and apply the displayed values, while [Cancel] will reject 
the changes. [Help] will display all of the documentation for the window. Press the Help key for context-sensitive help for 
each field.  
 

Format: It is an action that toggles the push button.  
 
Menu Style:  Push Button 
Menu Values: 
Save&Continue 
Cancel 
Help 
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2.19 Overview to the PMC Journal List Import Options 
 
Titles in the PubMed Central Journal List have four values which categorize the nature of the contributions. Complete 
documentation can be found at  
 

   http://www.ncbi.nlm.nih.gov/pmc/about/PMC-jlist-csv.pdf 

  

This window displays the values the four categories: Full Access, Open Access Indicators, Participation Level, and 
Deposit Status.  

 
2.20 Distribution of PMC Journal List Category Values 
 
Before completing this window, it might be instructive to open your jlist.csv file with a spreadsheet program, and sort the 
data by Participation Level, then by Open Access Indicators, then by Deposit Status, and finally by Free Access. Here is a 
summary of the combinations in February 2015:  
 

  

   Paticipation+OA+Deposit+Free Access=Count  

   Full+All+No New Content+No value=72  

   Full+All+No value+0 months or more=7  

   Full+All+No value+1 month=5  

   Full+All+No value+12 months=3  

   Full+All+No value+12 months or less=1  

   Full+All+No value+2 months=3  

   Full+All+No value+3 months=1  

   Full+All+No value+6 months=4  

   Full+All+No value+Immediate=1175  

   Full+All+Predecessor+1 month=1  

   Full+All+Predecessor+6 months=1  

   Full+All+Predecessor+Immediate=66  

   Full+No+No New Content+No value=24  

   Full+No+No value+0 months or more=1  

   Full+No+No value+1 month=2  

   Full+No+No value+12 months=53  

   Full+No+No value+12 months or less=4  

   Full+No+No value+2 months=1  

   Full+No+No value+24 months=6  

   Full+No+No value+24 months or less=1  

   Full+No+No value+3 months=1  

   Full+No+No value+3 months or more=1  

   Full+No+No value+6 months=16  

   Full+No+No value+6 months or less=3  

   Full+No+No value+Immediate=161  

   Full+No+Now Select+No value=20  

   Full+No+Predecessor+12 months=7  

   Full+No+Predecessor+24 months=1  

   Full+No+Predecessor+36 months=1  

   Full+No+Predecessor+6 months=5  

   Full+No+Predecessor+Immediate=91  

   Full+Some+No New Content+No value=8  

   Full+Some+No value+0 months or less=1  

   Full+Some+No value+1 month=2  

   Full+Some+No value+12 months=43  

   Full+Some+No value+12 months or less=44  

   Full+Some+No value+2 months=1  

   Full+Some+No value+2 months or less=1  

   Full+Some+No value+24 months=3  

   Full+Some+No value+24 months or less=2  

   Full+Some+No value+36 months or less=1  

   Full+Some+No value+6 months=4  

   Full+Some+No value+6 months or less=13  

http://www.ncbi.nlm.nih.gov/pmc/about/PMC-jlist-csv.pdf
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   Full+Some+No value+Immediate=74  

   Full+Some+Now Select+No value=3  

   Full+Some+Predecessor+12 months=2  

   Full+Some+Predecessor+24 months or less=1  

   NIH Portfolio+All+No value+12 months=12  

   NIH Portfolio+All+No value+Immediate=4  

   NIH Portfolio+No+No New Content+No value=48  

   NIH Portfolio+No+No value+12 months=127  

   NIH Portfolio+No+No value+4 months=1  

   NIH Portfolio+No+No value+6 months=3  

   NIH Portfolio+No+No value+Immediate=4  

   NIH Portfolio+No+Predecessor+12 months=6  

   NIH Portfolio+Some+No New Content+No value=34  

   NIH Portfolio+Some+No value+12 months=146  

   NIH Portfolio+Some+No value+12 months or less=1  

   NIH Portfolio+Some+No value+Immediate=3  

   NIH Portfolio+Some+Predecessor+12 months=8  
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2.21 PubMed Central Journal List Import Options 
 

 
 
2.22 Fields:  PubMed Central Journal List Import Options 
 
2.22.1 Field 1 Free Access:  multiple 
From http://www.ncbi.nlm.nih.gov/pmc/about/PMC-jlist-csv.pdf :"Free access: how soon after publication the journal 
makes issues (or individual articles) available in PMC."  
 

Here is a distribution of the values as of 2015.2.11:  
 

   Value = count  

   Immediate = 1578  

   No value = 209  

   0 months or less = 1  

   0 months or more = 8  

   1 month = 10  

   2 months or less = 1  

   2 months = 5  

   3 months = 2  

   3 months or more = 1  

   4 months = 1  

   6 months or less = 16  

   6 months = 33  

   12 months or less = 50  

   12 months = 407  

   24 months or less = 4  

   24 months = 10  

   36 months or less = 1  

   36 months = 1  

 

 
2.22.2 Field 2 Participation Level:  multiple 

http://www.ncbi.nlm.nih.gov/pmc/about/PMC-jlist-csv.pdf
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From http://www.ncbi.nlm.nih.gov/pmc/about/PMC-jlist-csv.pdf :"Participation level: may be Full (the title deposits the 
complete contents of each issue in PMC); or NIH Portfolio (the title deposits all NIH-funded articles and possibly some 
others)."  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Full 
NIH Portfolio 
 
2.22.3 Field 3 Deposit Status:  multiple 
From http://www.ncbi.nlm.nih.gov/pmc/about/PMC-jlist-csv.pdf :"Deposit status: applies only to journals that are not 
depositing current content under a Full participation or NIH Portfolio (NIPH) model, but did so formerly. Status may be 
Predecessor (the title is no longer in publication and a later version of the title is also available in PMC); Now Select (the 
title has moved to a selective deposit model; in this case the 'Latest Issue' represents the most recent issue deposited 
under its former Full or NIHP participation); No New Content (the title no longer deposits material in PMC, but previously 
deposited articles are still available; the title may or may not be in publications currently.)"  
 

CyberTools recommends deselecting "Now Select" and "No New Content".  
 
2.22.4 Field 4 Controls Ok, Cancel, & Help:   
Push button [PMC's own documentation] will open a browser to  
 

   http://www.ncbi.nlm.nih.gov/pmc/about/PMC-jlist-csv.pdf 

  

That page is the basis of this CyberTools window.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help on window... 
PMC's own documentation... 

  

http://www.ncbi.nlm.nih.gov/pmc/about/PMC-jlist-csv.pdf
http://www.ncbi.nlm.nih.gov/pmc/about/PMC-jlist-csv.pdf
http://www.ncbi.nlm.nih.gov/pmc/about/PMC-jlist-csv.pdf
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2.23 URL Link Text, Public Comments, & Rules for Format CyberTools 
 

 
 
2.24 Fields:  URL Link Text, Public Comments, & Rules for Format CyberTools 
 
2.24.1 Field 1 Current URL Rewriter Server:  50 characters, display only 
This field displays the current URL Rewriter's path. If it is nil then the check box "Use with URL Rewriter" has no affect.  
 
2.24.2 Field 2 Rule for MARC tag 856 subfield y, Link Text:  mandatory 
Menu Style:  Radio Button/Check Box 
Menu Values: 
found in the import file. 
provided here: 
 
2.24.3 Field 3 MARC Tag 856 $y Link Text:  200 characters 
Most electronic resource URLs are long, complex, and not meaningful to patrons. A MARC tag 856 $y Link Text value 
replaces the URL in the OPAC display. It is more appropriate for a patron's view than the actual URL. The cataloger could 
apply the phrase "Link to resource." as an example.  
 
2.24.4 Field 4 Rule for MARC tag 856 subfield z, Public Comment:  mandatory 
Menu Style:  Radio Button/Check Box 
Menu Values: 
found in the import file. 
provided here: 
 
2.24.5 Field 5 MARC Tag 856 $z Public Comment:  200 characters 
The value entered here is placed into every bib's tag 856 subfield z in the batch for the imported 856 $u URL. Typically 
this value is used for instructions, e.g., "For use on campus, proxy, or VPN."  
 
2.24.6 Field 6 Link Resolver:   
Check box "OpenURL automatically resolves to these URLs" will cause any OpenURL to redirect to the imported URL for 
the bib. This check box enables the CyberTools link resolver for these bibs and their URLs for use when an OpenURL 
arrives for the bib.  
 

If more than one URL in a bib is tagged for automatically resolving, then the resolution is to display the OPAC Details and 
have the searcher select the appropriate URL. The exceptions to these rules are:  
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  A. PubMed Central Journal List: if a bib has both the  

  "Link to most recent issue" and the "Link to archives"  

  URLs, then the archives URL is used.  

  

  B. For Nursing Consult, if a bib has both the "Search URL" and  

  the "Browse URL", then the "Search URL" is used.  

  

Note that at this time article level data are not forwarded to the target URL.  
 

Check box "OpenURL automatically resolves to these URLs" is recorded in the 856 $9 with the value RESOLVE. 
Therefore if your library is in a union catalog with other libraries, and you share the same URLs, then the decision to (not) 
employ RESOLVE applies to all union catalog members.  
 
2.24.7 Field 7 Use URL Rewriter:   
The URL Rewriter check box is only used when there is a URL Rewriter Server (for example, EZproxy), and the Catalog 
Default URL Rewriter Rule is "Only Specified URLs". The URL Rewriter Server and URL Rewriter Rule are specified in 
the Catalog Defaults.  
 

If this check box is selected, then the MARC tag 856 has a subfield 9 assigned to REWRITE. Open access URLs do not 
need to use a URL Rewriter Server.  
 
2.24.8 Field 8 Restrict URLs to Catalogs:  9 characters, multiple 
This feature is only valid for catalogs in a union catalog. It forces the catalog's short name (the Catalog Identifier) into 
each bib's MARC tag 856 subfield 9, prefixed by the word ONLY. For example, if the catalog's short name is NORTH, 
then the 856 $9 would be "ONLY NORTH" without the quotes. This will prevent patrons in the other catalogs from seeing 
or selecting the URL.  
 
2.24.9 Field 9 Controls Ok, Cancel, & Help:   
Specifies an action that controls the window's flow. [Ok] will save and apply the displayed values, while [Cancel] will reject 
the changes. [Help] will display all of the documentation for the window. Press the Help key for context-sensitive help for 
each field.  
 

Format: It is an action that toggles the push button.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help 
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2.25 Overview to URL Link Text, Public Comments, & Rules. 
 
Function [File Z39.50 MARC Bib Import] always calls the function [URL Link Text, Public Comments, & Rules]. This 
function adds:  
 

 MARC Tag 856 $y Link Text  MARC Tag 856 $z Public Comment  Link Resolver  Use URL Rewriter 
 Restrict URLs to Catalogs  
 

Some File Formats (i.e., EBSCO Journals, PubMed Central Journal List, and others) have additional questions.  All 
responses are saved by File Format for use on the next import.  
 

This function can also be run on demand from the Batch Control menu.  

 
2.26 URL Link Text, Public Comments, & Rules 
 

 
 
2.27 Fields:  URL Link Text, Public Comments, & Rules 
 
2.27.1 Field 1 Current URL Rewriter Server:  50 characters, display only 
This field displays the current URL Rewriter's path. If it is nil then the check box "Use with URL Rewriter" has no affect.  
 
2.27.2 Field 2 File Type:  60 characters, display only 
Field File Type displays the name of the collection.  
 
2.27.3 Field 3 MARC Tag 856 $y Link Text:  210 characters 
Most electronic resource URLs are long, complex, and not meaningful to patrons. A MARC tag 856 $y Link Text value 
replaces the URL in the OPAC display. It is more appropriate for a patron's view than the actual URL. The cataloger could 
apply the phrase "Link to resource." as an example.  
 
2.27.4 Field 4 MARC Tag 856 $z Public Comment:  210 characters 
The value entered here is placed into every bib's tag 856 subfield z in the batch for the imported 856 $u URL. Typically 
this value is used for instructions, e.g., "For use on campus, proxy, or VPN."  
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2.27.5 Field 5 Link Resolver:   
Check box "OpenURL automatically resolves to these URLs" will cause any OpenURL to redirect to the imported URL for 
the bib. This check box enables the CyberTools link resolver for these bibs and their URLs for use when an OpenURL 
arrives for the bib.  
 

If more than one URL in a bib is tagged for automatically resolving, then the resolution is to display the OPAC Details and 
have the searcher select the appropriate URL. The exceptions to these rules are:  
 

  A. PubMed Central Journal List: if a bib has both the  

  "Link to most recent issue" and the "Link to archives"  

  URLs, then the archives URL is used.  

  

  B. For Nursing Consult, if a bib has both the "Search URL" and  

  the "Browse URL", then the "Search URL" is used.  

  

Note that at this time article level data are not forwarded to the target URL.  
 

Check box "OpenURL automatically resolves to these URLs" is recorded in the 856 $9 with the value RESOLVE. 
Therefore if your library is in a union catalog with other libraries, and you share the same URLs, then the decision to (not) 
employ RESOLVE applies to all union catalog members.  
 
2.27.6 Field 6 Use URL Rewriter:   
The URL Rewriter check box is only used when there is a URL Rewriter Server (for example, EZproxy), and the Catalog 
Default URL Rewriter Rule is "Only Specified URLs". The URL Rewriter Server and URL Rewriter Rule are specified in 
the Catalog Defaults.  
 

If this check box is selected, then the MARC tag 856 has a subfield 9 assigned to REWRITE. Open access URLs do not 
need to use a URL Rewriter Server.  
 
2.27.7 Field 7 Restrict URLs to Catalogs:  9 characters, multiple 
This feature is only valid for catalogs in a union catalog. It forces the catalog's short name (the Catalog Identifier) into 
each bib's MARC tag 856 subfield 9, prefixed by the word ONLY. For example, if the catalog's short name is NORTH, 
then the 856 $9 would be "ONLY NORTH" without the quotes. This will prevent patrons in the other catalogs from seeing 
or selecting the URL.  
 
2.27.8 Field 8 Controls Ok, Cancel, & Help:   
Specifies an action that controls the window's flow. [Ok] will save and apply the displayed values, while [Cancel] will reject 
the changes. [Help] will display all of the documentation for the window. Press the Help key for context-sensitive help for 
each field.  
 

Format: It is an action that toggles the push button.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help 
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2.28 URL Link Text, Public Comments, & Rules for PMC Journal List 
 

 
 
2.29 Fields:  URL Link Text, Public Comments, & Rules for PMC Journal List 
 
2.29.1 Field 1 Current URL Rewriter Server:  50 characters, display only 
This field displays the current URL Rewriter's path. If it is nil then the check box "Use with URL Rewriter" has no affect.  
 
2.29.2 Field 2 MARC 856 $y Link Text for the Archive URL:  210 characters 
Most electronic resource URLs are long, complex, and not meaningful to patrons. A MARC tag 856 $y Link Text value 
replaces the URL in the OPAC display. It is more appropriate for a patron's view than the actual URL. The cataloger could 
apply the phrase "Link to resource." as an example.  
 
2.29.3 Field 3 MARC 856 $z Public Comment for the Archive URL:  210 characters 
The value entered here is placed into every bib's tag 856 subfield z in the batch for the imported 856 $u URL. Typically 
this value is used for instructions, e.g., "For use on campus, proxy, or VPN."  
 
2.29.4 Field 4 Create recent issue links when possible:   
Although the PMC Journal List spreadsheet does not show it, some works can link directly to the most recent issue at 
PubMed Central. Patrons like that. Since not all works can have such a link, and/or since some blackouts make some 
recent not-so-recent, some libraries prefer not to show this link.  
 
2.29.5 Field 5 MARC 856 $y Link Text for the Recent Issue URL:  210 characters 
The PubMed URL is long, complex, and not meaningful to patrons. A MARC tag 856 $y Link Text value replaces the URL 
in the OPAC display. It is more appropriate for a patron's view than the actual URL. The cataloger could apply the phrase 
"Link to Recent Issue at PubMed." as an example.  
 
2.29.6 Field 6 MARC 856 $z Public Comment for the Recent Issue URL:  210 characters 
The value entered here is placed into every bib's tag 856 subfield z, the Public Comment, for the imported MARC tag 856 
$u Recent Issue URL.  Typically the PubMed Central Journal List Recent Issue Public Comment is blank.  
 
2.29.7 Field 7 Link Resolver:   
Check box "OpenURL automatically resolves to these URLs" will cause any OpenURL to redirect to the imported URL for 
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the bib. This check box enables the CyberTools link resolver for these bibs and their URLs for use when an OpenURL 
arrives for the bib.  
 

If more than one URL in a bib is tagged for automatically resolving, then the resolution is to display the OPAC Details and 
have the searcher select the appropriate URL. The exceptions to these rules are:  
 

  A. PubMed Central Journal List: if a bib has both the  

  "Link to most recent issue" and the "Link to archives"  

  URLs, then the archives URL is used.  

  

  B. For Nursing Consult, if a bib has both the "Search URL" and  

  the "Browse URL", then the "Search URL" is used.  

  

Note that at this time article level data are not forwarded to the target URL.  
 

Check box "OpenURL automatically resolves to these URLs" is recorded in the 856 $9 with the value RESOLVE. 
Therefore if your library is in a union catalog with other libraries, and you share the same URLs, then the decision to (not) 
employ RESOLVE applies to all union catalog members.  
 
2.29.8 Field 8 Use URL Rewriter:   
The URL Rewriter check box is only used when there is a URL Rewriter Server (for example, EZproxy), and the Catalog 
Default URL Rewriter Rule is "Only Specified URLs". The URL Rewriter Server and URL Rewriter Rule are specified in 
the Catalog Defaults.  
 

If this check box is selected, then the MARC tag 856 has a subfield 9 assigned to REWRITE. Open access URLs do not 
need to use a URL Rewriter Server.  
 
2.29.9 Field 9 Restrict URLs to Catalogs:  9 characters, multiple 
This feature is only valid for catalogs in a union catalog. It forces the catalog's short name (the Catalog Identifier) into 
each bib's MARC tag 856 subfield 9, prefixed by the word ONLY. For example, if the catalog's short name is NORTH, 
then the 856 $9 would be "ONLY NORTH" without the quotes. This will prevent patrons in the other catalogs from seeing 
or selecting the URL.  
 
2.29.10 Field 10 Controls Ok, Cancel, & Help:   
Specifies an action that controls the window's flow. [Ok] will save and apply the displayed values, while [Cancel] will reject 
the changes. [Help] will display all of the documentation for the window. Press the Help key for context-sensitive help for 
each field.  
 

Format: It is an action that toggles the push button.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help 
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2.30 URL Link Text, Public Comments, & Rules EBSCO eBooks 
 

 
 
2.31 Fields:  URL Link Text, Public Comments, & Rules EBSCO eBooks 
 
2.31.1 Field 1 Current URL Rewriter Server:  50 characters, display only 
This field displays the current URL Rewriter's path. If it is nil then the check box "Use with URL Rewriter" has no affect.  
 
2.31.2 Field 2 EBSCO eBook URL format:  mandatory 
As of 2017-12-8, EBSCO is in transition with their eBook URL format.  The currently documented format & the format 
used in all EBSCO holdings reports is:   
 

  

http://search.ebscohost.com/login.aspx?direct=true&scope=site&db=nlebk&db=nlabk&AN=Produc

tID 

  

ProductID is unique to each book. It is a number. EBSCO sometimes calls it the Book ID. See  
 

  

https://help.ebsco.com/interfaces/eBooks_Audiobooks/Administrator_User_Guide/direct_URL_s

yntax_to_ebook_audiobook 

  

But when an eBook is viewed at EBSCO, the [Persistent Link] button yields this URL:   
 

  http://search.ebscohost.com/login.aspx?direct=true&db=nlebk&AN=ProductID&site=ehost-

live 

  

Both URL formats work as of 2017-12-8. We're sorry to ask, but please decide which format you want.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Documented URL (recommended) 
Persistent URL 

http://search.ebscohost.com/login.aspx?direct=true&scope=site&db=nlebk&db=nlabk&AN=ProductID
http://search.ebscohost.com/login.aspx?direct=true&scope=site&db=nlebk&db=nlabk&AN=ProductID
https://help.ebsco.com/interfaces/eBooks_Audiobooks/Administrator_User_Guide/direct_URL_syntax_to_ebook_audiobook
https://help.ebsco.com/interfaces/eBooks_Audiobooks/Administrator_User_Guide/direct_URL_syntax_to_ebook_audiobook
http://search.ebscohost.com/login.aspx?direct=true&db=nlebk&AN=ProductID&site=ehost-live
http://search.ebscohost.com/login.aspx?direct=true&db=nlebk&AN=ProductID&site=ehost-live
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2.31.3 Field 3 MARC Tag 856 $y Link Text:  210 characters 
Most electronic resource URLs are long, complex, and not meaningful to patrons. A MARC tag 856 $y Link Text value 
replaces the URL in the OPAC display. It is more appropriate for a patron's view than the actual URL. The cataloger could 
apply the phrase "Link to resource." as an example.  
 
2.31.4 Field 4 MARC Tag 856 $z Public Comment:  210 characters 
The value entered here is placed into every bib's tag 856 subfield z in the batch for the imported 856 $u URL. Typically 
this value is used for instructions, e.g., "For use on campus, proxy, or VPN."  
 
2.31.5 Field 5 Link Resolver:   
Check box "OpenURL automatically resolves to these URLs" will cause any OpenURL to redirect to the imported URL for 
the bib. This check box enables the CyberTools link resolver for these bibs and their URLs for use when an OpenURL 
arrives for the bib.  
 

If more than one URL in a bib is tagged for automatically resolving, then the resolution is to display the OPAC Details and 
have the searcher select the appropriate URL. The exceptions to these rules are:  
 

  A. PubMed Central Journal List: if a bib has both the  

  "Link to most recent issue" and the "Link to archives"  

  URLs, then the archives URL is used.  

  

  B. For Nursing Consult, if a bib has both the "Search URL" and  

  the "Browse URL", then the "Search URL" is used.  

  

Note that at this time article level data are not forwarded to the target URL.  
 

Check box "OpenURL automatically resolves to these URLs" is recorded in the 856 $9 with the value RESOLVE. 
Therefore if your library is in a union catalog with other libraries, and you share the same URLs, then the decision to (not) 
employ RESOLVE applies to all union catalog members.  
 
2.31.6 Field 6 Use URL Rewriter:   
The URL Rewriter check box is only used when there is a URL Rewriter Server (for example, EZproxy), and the Catalog 
Default URL Rewriter Rule is "Only Specified URLs". The URL Rewriter Server and URL Rewriter Rule are specified in 
the Catalog Defaults.  
 

If this check box is selected, then the MARC tag 856 has a subfield 9 assigned to REWRITE. Open access URLs do not 
need to use a URL Rewriter Server.  
 
2.31.7 Field 7 Restrict URLs to Catalogs:  9 characters, multiple 
This feature is only valid for catalogs in a union catalog. It forces the catalog's short name (the Catalog Identifier) into 
each bib's MARC tag 856 subfield 9, prefixed by the word ONLY. For example, if the catalog's short name is NORTH, 
then the 856 $9 would be "ONLY NORTH" without the quotes. This will prevent patrons in the other catalogs from seeing 
or selecting the URL.  
 
2.31.8 Field 8 Controls Ok, Cancel, & Help:   
Specifies an action that controls the window's flow. [Ok] will save and apply the displayed values, while [Cancel] will reject 
the changes. [Help] will display all of the documentation for the window. Press the Help key for context-sensitive help for 
each field.  
 

Format: It is an action that toggles the push button.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help 
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2.32 URL Link Text, Public Comments, & Rules EBSCO Journals 
 

 
 
2.33 Fields:  URL Link Text, Public Comments, & Rules EBSCO Journals 
 
2.33.1 Field 1 Current URL Rewriter Server:  50 characters, display only 
This field displays the current URL Rewriter's path. If it is nil then the check box "Use with URL Rewriter" has no affect.  
 
2.33.2 Field 2 EBSCO journal options:  multiple 
Some EBSCO journal packages' records are not full text. CyberTools recommends that they are not included in your 
catalog. Similarly, we recommend that you don't include records' Abstracting & Indexing dates since your patrons cannot 
access their full text when the A&I dates differ from the Full Text dates.   
 

Some of the records have other problems. For example, a journal without an ISSN might not be worthy of your catalog. 
Lastly, there are unusual records for "journals" with just one month of Full Text.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Records with no Full Text 
Records missing an ISSN 
Records with just one month Full Text Dates 
Abstracting & Indexing dates 
 
2.33.3 Field 3 MARC Tag 856 $y Link Text:  210 characters 
Most electronic resource URLs are long, complex, and not meaningful to patrons. A MARC tag 856 $y Link Text value 
replaces the URL in the OPAC display. It is more appropriate for a patron's view than the actual URL. The cataloger could 
apply the phrase "Link to resource." as an example.  
 
2.33.4 Field 4 MARC Tag 856 $z Public Comment:  210 characters 
The value entered here is placed into every bib's tag 856 subfield z in the batch for the imported 856 $u URL. Typically 
this value is used for instructions, e.g., "For use on campus, proxy, or VPN."  
 
2.33.5 Field 5 Link Resolver:   
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Check box "OpenURL automatically resolves to these URLs" will cause any OpenURL to redirect to the imported URL for 
the bib. This check box enables the CyberTools link resolver for these bibs and their URLs for use when an OpenURL 
arrives for the bib.  
 

If more than one URL in a bib is tagged for automatically resolving, then the resolution is to display the OPAC Details and 
have the searcher select the appropriate URL. The exceptions to these rules are:  
 

  A. PubMed Central Journal List: if a bib has both the  

  "Link to most recent issue" and the "Link to archives"  

  URLs, then the archives URL is used.  

  

  B. For Nursing Consult, if a bib has both the "Search URL" and  

  the "Browse URL", then the "Search URL" is used.  

  

Note that at this time article level data are not forwarded to the target URL.  
 

Check box "OpenURL automatically resolves to these URLs" is recorded in the 856 $9 with the value RESOLVE. 
Therefore if your library is in a union catalog with other libraries, and you share the same URLs, then the decision to (not) 
employ RESOLVE applies to all union catalog members.  
 
2.33.6 Field 6 Use URL Rewriter:   
The URL Rewriter check box is only used when there is a URL Rewriter Server (for example, EZproxy), and the Catalog 
Default URL Rewriter Rule is "Only Specified URLs". The URL Rewriter Server and URL Rewriter Rule are specified in 
the Catalog Defaults.  
 

If this check box is selected, then the MARC tag 856 has a subfield 9 assigned to REWRITE. Open access URLs do not 
need to use a URL Rewriter Server.  
 
2.33.7 Field 7 Restrict URLs to Catalogs:  9 characters, multiple 
This feature is only valid for catalogs in a union catalog. It forces the catalog's short name (the Catalog Identifier) into 
each bib's MARC tag 856 subfield 9, prefixed by the word ONLY. For example, if the catalog's short name is NORTH, 
then the 856 $9 would be "ONLY NORTH" without the quotes. This will prevent patrons in the other catalogs from seeing 
or selecting the URL.  
 
2.33.8 Field 8 Controls Ok, Cancel, & Help:   
Specifies an action that controls the window's flow. [Ok] will save and apply the displayed values, while [Cancel] will reject 
the changes. [Help] will display all of the documentation for the window. Press the Help key for context-sensitive help for 
each field.  
 

Format: It is an action that toggles the push button.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help 
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2.34 Duplicate Bib Pop-up: Why and How to Resolve. 
 
Sometimes when importing you will see a pop-up window similar to this one:  
 

 ------------------------Duplicate Bib---------------------------- 

 | Requested record: 3                                           |  

 | Title: Nephron. Experimental Nephrology                       |  

 | Control Number Type: ISSN                                     |  

 | Additional Control Numbers: 1660-2129                         |  

 | URL: http://www.ncbi.nlm.nih.gov/pmc/?term=%22Nephron+Exp+N   |  

 | URL Link Text: Link to resource at PubMed Central.            |  

 | URL Public Comment: Earliest volume=v.113,2009; Open access=  |  

 | Name of Publisher: Karger Publishers                          |  

 |                                                               |  

 | The following newly imported bib from server NLM:             |  

 | Imported Title: Nephron. Experimental nephrology              |  

 | Call# W 1 NE204GB                                             |  

 | Control# 1159770                                              |  

 | LCCN 2003-243039                                              |  

 | ISSN 1660-2129, 1660-8151                                     |  

 |                                                               |  

 | Current Batch Bib MARC# 92                                    |  

 | Title: Nephron. Clinical practice [electronic resource].      |  

 | Call# W 1 NE204GB                                             |  

 | Control# 1159763                                              |  

 | LCCN 2003243038                                               |  

 | ISSN 1660-8151                                                |  

 | Match on tag 022 value 1660-8151                              |  

 |                                                               |  

 | Current Catalog Bib MARC# 96                                  |  

 | Title: Nephron. Physiology [electronic resource].             |  

 | Call# W 1 NE204GB                                             |  

 | Control# 1159772                                              |  

 | LCCN 2003243040                                               |  

 | ISSN 1660-8151                                                |  

 | Match on tag 022 value 1660-8151                              |  

 |---------------------------------------------------------------|  

 | [Display entire MARC bibs here]                               |  

 | [Display entire MARC bibs in a browser]                       |  

 | [Discard the newly imported bib]                              |  

 | [Create a new bib for the catalog]                            |  

 | [Stop the import and cancel the batch]                        |  

 | [Merge holdings & URLs into batch's MARC# 92]                 |  

 | [Overlay onto batch's MARC# 92]                               |  

 | [Retrieve MARC#96 from catalog & merge imported holdings&URLs]|  

 | [Overlay onto MARC# 96]                                       |  

 ----------------------------------------------------------------- 

  

The pop-up occurs because the imported data matches a bib already in the batch and/or matches a bib in the catalog. It is 
possible there is more than one match for either case.  
 

The window is divided into two panels. The top displays a minimum amount of data for each of the associated records. 
The bottom panel presents functions to resolve the situation.  
 

In the top panel, this first record only occurs when using cataloging function [File Z39.50 MARC Bib Import] or [Interactive 
Z39.50 MARC Bib Import]. The key values used to retrieve a full MARC record are displayed:  
 

  Requested record: 3  

  Title: Nephron. Experimental Nephrology  

  Control Number Type: ISSN  

  Additional Control Numbers: 1660-2129  

  URL: http://www.ncbi.nlm.nih.gov/pmc/?term=%22Nephron+Exp+Neph  
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  URL Link Text: Link to resource at PubMed Central.  

  URL Public Comment: Earliest volume=v.113,2009; Open access=So  

  Name of Publisher: Karger Publishers  

  

In this example the second record, the one starting with "The following newly imported bib..." shows data that has been 
imported from NLM via Z39.50:  
 

   The following newly imported bib from server NLM:  

   Imported Title: Nephron. Experimental nephrology  

   Call# W 1 NE204GB  

   Control# 1159770  

   LCCN 2003-243039  

   ISSN 1660-2129, 1660-8151  

  

If function [Import a MARC Bib File] is used, then this is the first displayed record in the top panel. The title and control 
numbers are extracted from the MARC. One or more of these key values match data in records already in the batch or 
catalog. This match is the situation that needs to be resolved. If there were no matches then the MARC would be 
automatically added to the batch.  
 

The next record has one or more key values that match the key values for the newly imported bib:  
 

   Current Batch Bib MARC# 7392  

   Title: Nephron. Clinical practice [electronic resource].  

   Call# W 1 NE204GB  

   Control# 1159763  

   LCCN 2003243038  

   ISSN 1660-8151  

   Match on tag 022 value 1660-8151  

  

This record already occurs in the batch. That means there is more than one bib in this import session, thus two bibs have 
overlapping key values. This is either a mistake or less-than-perfect metadata. Note that you typically have no matches for 
bibs already in the batch. In rare instances you may have many matches.  
 

The last record has one or more key values that match the key values for the newly imported bib:  
 

   Current Catalog Bib MARC# 7396  

   Title: Nephron. Physiology [electronic resource].  

   Call# W 1 NE204GB  

   Control# 1159772  

   LCCN 2003243040  

   ISSN 1660-8151  

   Match on tag 022 value 1660-8151  

  

This record is already in the catalog. Generally catalogers do not re-import the same bib, therefore one should consider 
how to resolve these matches. Please note that you may have no matches for bibs already in the catalog, or many 
matches.  
 

The bottom panel's functions resolve all matching bib situations. Unless the solution is obvious, always select function 
[Display entire MARC bibs in a browser]. Some catalogers like to select this function for each number of matching records 
thus allowing side by side comparison of the data.  
 

Once the data are adequately displayed, then select a function to resolve the situation.  
 

[Discard the newly imported bib] has two different effects. If you started in function [Import a MARC Bib File] then 
[Discard...] completely ignores the MARC record: you would only select [Discard...] if you do not want this record. If you 
started via one of the Z39.50 functions, then the system will discard the newly imported bib and will start the process 
again with either additional control numbers and/or additional Z39.50 servers.  
 

[Create a new bib for the catalog] ignores the matches and saves the new data into the batch as a new work for the 
catalog.  
 

[Stop the import and cancel the batch] is typically used when you have seen the "Duplicate Bib" pop-up window many 
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times, thus realized that you did not initiate the import session correctly. You want to start over.  
 

[Merge holdings & URLs into batch's MARC# nnnnn] will copy any unique URLs from the Z39.50 Requested Record or 
the newly imported bib into the batch's bib. If this session started via [Import a MARC Bib File] then any 85X, 86X and 
9XX tags are also copied.  
 

[Overlay onto batch's MARC# nnnnn] says that you like the new data better than the data currently in the batch therefore 
destroy the instance in the batch and replace it with the newly imported bib.  
 

[Retrieve MARC# nnnn from catalog & merge imported holdings & URLs] copies the data from the catalog into the batch, 
then copies any unique URLs from the Z39.50 Requested Record or the newly imported bib into the batch's bib. If this 
import started via function [Import a MARC Bib File] then any 85X, 86X and 9XX tags are also copied.  
 

[Overlay onto MARC# nnnn] says that you like the new data better than the data currently in the catalog and therefore you 
want to accept these new data into the batch but with the old bib's MARC number. When Batch Control->Update Catalog 
with Batch is later selected, the catalog's old record is replaced with these new data.  
 

Here's some guidance, in priority order:  
 

If the match is a false positive, i.e. the control numbers are shared but the bibs reflect unique works (this is very rare 
except in the case of call numbers), then [Create a new bib for the catalog] is correct. For Z39.50 functions, first verify that 
the newly imported bib matches the requested record at the top of the display.  
 

If the match is real and you see [Retrieve MARC# nnnn from catalog & merge imported holdings & URLs], that is your 
best choice.  
 

If the match is real and you see [Merge holdings & URLs into batch's MARC# nnnnn] then that is your best choice.  
 

Both [Retrieve MARC# nnnn from catalog & merge imported holdings & URLs] and [Merge holdings & URLs into batch's 
MARC# nnnnn] should not be legitimate, unless you have problems in your catalog.  
 

Neither [Overlay...] functions are advised. If the bib was previously fine then why replace it now? Particularly in a union 
catalog, you don't want to replace a colleague's prior work without careful consideration.  
 

When in doubt, [Stop the import and cancel the batch].  
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2.35 The import is over 
 
The import is now over. The data are now in a CyberTools batch. A batch is temporary storage where you can privately 
perfect the data. Your colleagues and patrons cannot see the batch. The import now segues to the Cataloging function 
[Batch Control]. Please continue to function [Batch Control] documentation.  
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3 Importing Aggregator's MARC Bibliographic Files 
 
3.1 Overview to Import a MARC File 
 
This window is used for importing MARC files. The MARC 21 format is expected. Two types of MARC files may be 
imported: MARC bibliographic files and MARC holdings.  
 

The Cataloging function [Import a MARC Bib File] will load a MARC bibliographic file into a temporary file called a batch, 
placing the data under the control of function [Batch Control]. Function [Batch Control] is where most processing takes 
place. Please see the web tutorial on importing MARC Bibs found at  
 

     http://cybertoolsforlibraries.com/cyberj/qt_marc/ 

  

Once the data are perfected in [Batch Control], it is sent to the actual catalog via function [Update Catalog with Batch]. 
Items can then be attached to the bib (e.g., multiple copies, volumes, etc.), and labels can be printed.  

 
3.2 Importing OCLC MARC Serial Holdings 
 
This window is also used to import a MARC Serial Holdings file with tag 866 Textual Holdings - Basic Bibliographic Unit. It 
has been tested with OCLC data where MARC bibs and holdings records are intermingled. When this window is run from 
Serials Management, the function performs the following tasks:  
 

     1. imports the bibs according to the user's selection on  

     the window;  

  

     2. immediately updates the catalog with the bibs;  

  

     3. adds the titles to Serials Management;  

  

     4. generates Serial Copy Free Text Holding Strings from  

     the 866 data.  

 

 
3.3 Import a file of deleted MARC bibs 
 
Some electronic resources aggregators (e.g., EBSCO and Proquest) publish a MARC file of removed works where each 
MARC leader's position 5, Record Status, has a "d" for Deleted. If you import such a MARC file via function [Import a 
MARC Bib Bib File], then the software will prompt you:   
 

  |-------------------------   Cancelled bibs   -----------------|  

  | # bibs out of ## have the status CANCEL.                     |  

  | Moreover ### bibs have a MARC Leader 05 Record Status of 'd' |  

  | for Deleted.                                                 |  

  | 2 bibs are currently in the catalog.                         |  

  | 2 bibs have imported URLs.                                   |  

  | Is this an online collection that you want to remove from    |  

  | your catalog?                                                |  

  | [Go to Batch Control and let me figure things out]           |  

  | [Display the bibs then let me decide]                        |  

  | [Remove this online collection from the catalog]             |  

  |--------------------------------------------------------------|  

   

The # is the count of bibs that are cancelled.  
 

The ## is the total number of bibs in the MARC file.  
 

The ### is the number of MARC bibs with a MARC Leader 05 Record Status of 'd' for Deleted.  
 

http://cybertoolsforlibraries.com/cyberj/qt_marc/
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Function [Go to Batch Control and let me figure things out] will do that. In Batch Control you can use any of the Batch 
Control functions, such as remove the batch, remove bibs from batch, or display the bibs.  
 

Function [Display the bibs then let me decide] uses Batch Control's [Display Bibs]. There the entire MARC bib or selected 
tags, such as the title at 245 and/or the URLs at 856, can be shown.  
 

Function [Remove this online collection from the catalog] goes directly to function [Remove Online Collection], fully 
documented elsewhere. Works which have print, restricted URLs, or other URLs simply have this batch's URLs removed 
from the catalog. Works that only have this batch's URLs have their entire MARC bibs removed from the catalog. The 
session will look like this:   
 

  Function [Remove Online Collection] on 01/25/2015 18:01  

  1. Batch Control->Remove Online Collection  

  2. Batch# ##: Remove online only bibs  

  3. Batch# ###: Remove URL for bibs with print with other  

     unrelated URLs.  

  4. Removed the now empty import batch# ####  

  5. Done. Archive this log and/or Close the window now.  

  

   

##, ###, and #### will be batch numbers specific to your session.  
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3.4 Import a MARC File 
 

 
 
3.5 Fields:  Import a MARC File 
 
3.5.1 Field 1 Import File Type:  40 characters, display only 
The display only field Import File Type states the type of MARC file that should be used at this moment. MARC includes 
Authority, Bibliographic, Holdings, etc. Usually this field will state Bibliographic.  
 
3.5.2 Field 2 Status of the Process:  60 characters, display only 
Displays the message "Working..." and/or other messages while the software processes the data.  
 
3.5.3 Field 3 Browse to File:   
This push button enables the user to navigate to the target file on the user's workstation. The native workstation file 
browser is invoked to identify the file.  
 
3.5.4 Field 4 File name:  120 characters 
This field specifies the target file name. The file name must include the directory paths (folders).  
 

Format: It is any legal directory path and file name for your server.  
 

Discussion: The file name is displayed in this field, and the file is copied from the workstation to the server.  
 

Example: On MS Windows, a file name with its folders might be  
 

     C:\temp\today\my_file.txt  

 

 
3.5.5 Field 5 Place on Recent Arrivals:  mandatory 
Specifies that the MARC bibliographic import file contains new titles that should be added to the Search Catalog's Recent 
Arrival list. Three conditions exist for MARC bibliographic records:  
 

     - None of the records are new (e.g., retrospective  

       cataloging);  

  

     - The software should match ISSN/ISBN, LCCN, or other  

       control numbers to determine if the bib is new, and only  

       newly matched MARC bibs will be added to the Recent  

       Arrivals list;  

  

     - All of the records are new.  
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Format: It is a radio button selection.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
None 
New Matches Only 
All 
 
3.5.6 Field 6 Modify Rules for Bib Match:   
Allows the cataloger to temporarily change the rules to match imported bibs to bibs already in the catalog and/or to other 
bibs within the imported file.  
 
3.5.7 Field 7 Guide the Batch Control functions:   
Option "Guide the Batch Control functions" automatically runs a number of the Batch Control functions after the import:  
 

  -> NLM MARCout Conversion;  

  -> Remove Undesired Local Tags.  

  

If the import was started via function  
 

   + [File Z39.50  MARC Bib Import];  

   + or [via Import a MARC Bib File] and there are more than 9  

     records in the batch  

  

then these additional Batch Control->Tools functions are automatically run:  
 

  -> Review Prior URLs (but only if they exist);  

  -> Assign A to Z Group IDs.  

  

If the import was started via function [Import a MARC Bib File] and a record has an occurrence of a tag which match a 
MARC Import Holdings Profiles tag and subfield for a call number, then Batch Control->Import Profile Call# Copy is 
automatically run.  
 
3.5.8 Field 8 Add selected thesauri imported terms to catalog's thesaurus:  multiple 
The selected thesauri's terms not found in the catalog's thesaurus will be added to the catalog's thesaurus as part of the 
MARC bib import. MARC from LC, NLM, and most major universities are acceptable donors. CyberTools recommends 
that health sciences libraries add LCSH and MeSH.  
 

Here are the decoding of the abbreviations. # stands for the 6XX indicator 2 value.  
 

 #  code  Name  

 0  LCSH  Library of Congress Subject Headings  

 1  LCSH Children's  

 2  MeSH  Medical Subject Headings  

 3  NAL   National Agricultural Library  

 4  SNS   Source not specified  

 5  NLC   Library and Archives Canada  

 6  RVM   Bibliotheque de l'Universite de Laval  

 7  $2    Source specified in subfield $2  

 

 
3.5.9 Field 9 Load, Cancel, & Help:   
Specifies an action that controls the window's flow. [Ok] will save and apply the displayed values, while [Cancel] will reject 
the changes. [Help] will display all of the documentation for the window. Press the Help key for context-sensitive help for 
each field.  
 

Format: It is an action that toggles the push button.  
 
Menu Style:  Push Button 
Menu Values: 
Import MARC File into Batch 
Cancel 
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Help 
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3.6 Overview to Duplicate Bibs Importing Rules 
 
This is accessed via the push button [Duplicate Bibs Importing Rules] from function [Import a MARC Bib File] or [File 
Z39.50 MARC Bib Import]. The rules are taken from the Catalog [Defaults] but can be changed for the immediate import 
session.  
 

Please note that the selections are sometimes automatically changed by function [File Z39.50 MARCBib Import].  

 
3.7 Duplicate Bibs Importing Rules 
 

 
 
3.8 Fields:  Duplicate Bibs Importing Rules 
 
3.8.1 Field 1 If bib matches an existing one:  mandatory 
The selected option determines the default action when an imported bib matches a bib already in the catalog.  
 

Format: It is a radio button selection.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Show & Ask Overlay/Cancel/Create/Retrieve Bib 
Overlay Catalog's Bib with Imported Bib 
Set Imported Bib's Status to CANCEL 
Create a New Bib for the Catalog 
Retrieve catalog's bib & add unique data 
 
Discussion: The importing software compares some of the key identifying values in the imported bib(s) to existing bibs in 
the catalog. If the software finds a match on the following MARC tags  
 

     001   Control Number  

     010   Library of Congress Control Number  

     020   International Standard Book Number  

     022   International Standard Serial Number  
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then the cataloger must determine the next action. It is possible that the bib is really not a duplicate or an update, but a 
true new bib, but this is unlikely. The most common legitimate reason is when a large MARC file contains multiple bibs 
which match on the same ISSN number because the publisher changed the title (thus the multiple bibs) but failed to 
change the ISSN.  
 

Option "Show & Ask Overlay/Cancel/Add Imported Bib" will display each bib's key identifiers and the title from the 
imported bib and the bib in the catalog. Along with the display, the cataloger will get to choose the next action:  
 

     Overlay Catalog's Bib with Imported Bib  

     Set Imported Bib's Status to CANCEL  

     Create a new Bib for the Catalog  

  

These actions are described below. One of these actions may be determined at the beginning of the import, i.e., rather 
than show the individual bibs and their values, simply determine the rule in advance.  
 

Option "Overlay Catalog's Bib with Imported Bib" will load the imported bib into the batch using the catalog's matching 
bib's MARC Number. When the cataloger uses the Batch Control function [Updated to the Catalog], then at that point the 
newly imported bib would replace the catalog's old bib. The old bib's items (i.e., the holdings) are assumed by the new 
bib. Alternatively, the cataloger may manually CANCEL the bib in the batch prior to the Update to the Catalog function, 
thus protecting the old bib from the new bib. Because of the flexibility of this action, this action is the recommended 
choice, unless the cataloger knows that the bib is really new.  
 

Option "Set Imported Bib's Status to CANCEL" loads the new bib into the batch but sets the bib's status to CANCEL, 
making it impossible to Update the Catalog with the new bib. Nevertheless, the imported bib can be reviewed in the batch.  
 

Option "Create a new Bib for the Catalog" will create a new instance of the bib in the catalog. This new bib will be 
completely independent from the old bib, and will have its own holdings. It is unusual to select this action. If this action is 
erroneously selected, then the catalog will have duplicate bibs.  
 

Keep in mind that the bib is the idea of the title, and the items (holdings) are the actual instances of the materials. Items 
are attached to bibs.  
 

Option "Retrieve catalog's bib & add unique data" will first test to see if an imported bib record's control number matches a 
bib record that is already in the catalog. If a matching bib is found in the catalog, then the catalog's bib is added to the 
batch. The system then checks to see if there are unique data in the imported bib record such as URLs and/or holdings 
data. If so, then these unique data are added to the bib in the batch. If the imported bib is not found in the catalog then it is 
added to the batch.  
 
3.8.2 Field 2 Duplicate Bibs Importing Rules:  multiple 
When importing MARC bibs, the records can be checked against the catalog and the import file itself for duplicate 
records. If a duplicate is found, then the session's "If a bib matches an existing one" choice determines how the record will 
be processed.  
 

The duplicate checking rules are:  
 

Control#: tag 001: The software removes all beginning and trailing spaces for the comparison. It does not simply check 
the numeric portion. If the value starts with tds, for Teton Data  Systems, then the value is not used to match. Teton Data 
Systems uses the same value on sequential editions.  
 

LCCN: tag 010 $a: This is the unique Library of Congress Control Number.  
 

ISBN: tag 020 $a: All occurrences of the ISBN are checked.  
 

ISSN: tag 022 $a: All occurrences of the ISSN are checked.  
 

Call Number: The call number is determined according to the Call Numbers Tags for this Catalog value. Call numbers 
from the import holdings profiles are not used.  
 

Ignore Call Numbers without Numbers: This option is only applicable if call numbers are being checked. It will bypass any 
call number that lacks a number, such as Online, Web, etc.  
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Confirm title 245 $a: This option normalizes the title, clears punctuation, and then compares the titles to confirm that the 
record is a duplicate. We recommend only using this option with great care because the metadata from content providers 
can be inconsistent.  
 

Confirm publication year 260 $c: This option normalizes the year, clears punctuation, and then compares the years to 
confirm that the record is a duplicate. If a year is blank then it is counted as a match. We recommend using this option.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Control#:  tag 001 
LCCN: tag 010 $a 
ISBN: tag 020 $a 
ISSN: tag 022 $a 
Call Number 
Ignore Call# without Numbers 
Confirm title 245 $a 
Confirm publication year 260 $c 
 
3.8.3 Field 3 Match on $z then convert to $a:  multiple 
The Library of Congress ISBN MARC tag 020 subfield z definition (http://www.loc.gov/marc/bibliographic/bd020.html 
accessed October 2017) is a "Canceled/invalid" value. Similarly the ISSN tag 022 subfield z is a "Canceled ISSN" 
(http://www.loc.gov/marc/ bibliographic/bd022.html accessed October 2017). Normally subfield z is used to document a 
mistake that typically the publisher made at some point in time.  
 

Similarly, the Library of Congress tag 022 subfield y definition (http://www.loc.gov/marc/bibliographic/bd022.html accessed 
November 2012) is an "incorrect" value.  
 

Some aggregators' MARC bib collections convert the 02X $a value for the print to be a 02X $y or $z.  
 

In order to make the MARC bibs more generic and thus less tied to online manifestations, CyberTools recommends 
restoring the 02X $z to $a.  
 

Option "Any 020 $z or 022 $z when the $a is missing" should be used on MARC bibs sourced from Gale or OCLC (e.g., 
the ClinicalKey collection).  
 

Option "McGraw-Hill/Cassidy 010, 020, & 022 $y & $z" fixes MARC bibs from Cassidy Cataloging Service where tags 
010, 020, and 022 subfield y & z are coded incorrectly. This CyberTools import option moves the value from subfield y or 
z to subfield a, where the value belongs. The software tests if the MARC bib has any of these values:   
 

  - tag 001 starts with ccn AND  

  - tag 856 $u contains www.access or jamaevidence.com   

   

If the control number tag has no subfield a, but has a subfield z, then subfield z is moved to subfield a.  
 
3.8.4 Field 4 Controls Ok, Cancel, & Help:   
Specifies an action that controls the window's flow. [Ok] will save and apply the displayed values, while [Cancel] will reject 
the changes. [Help] will display all of the documentation for the window. Press the Help key for context-sensitive help for 
each field.  
 

Format: It is an action that toggles the push button.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help 
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3.9 Overview to MARC Import Error Report and Repair 
 
If the import found fundamental MARC errors, then at the end of the import and before function [Batch Control], this 
window opens. The error report can be printed or archived. Some errors can be repaired.  

 
3.10 MARC Import Error Report and Repair 
 

 
 
3.11 Fields:  MARC Import Error Report and Repair 
 
3.11.1 Field 1 Repair:   
Option "Leader/11 change to 2" fixes the invalid MARC Leader position 11 value to be the correct value of 2.  
 

The repair occurs after function [CLOSE]. It can be verified in Batch Control->Display MARC Bibs.  
 
3.11.2 Field 2 Choice of the Target Device:   
Specifies the target device for the output. Choices include Workstation, Printer, File, or send to an E-mail address.  
 
Menu Style:  Push Button 
Menu Values: 
Workstation 
Printer 
File 
E-mail 
Close 
Help 
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3.12 Duplicate Bib Pop-up: Why and How to Resolve. 
 
Sometimes when importing you will see a pop-up window similar to this one:  
 

 ------------------------Duplicate Bib---------------------------- 

 | Requested record: 3                                           |  

 | Title: Nephron. Experimental Nephrology                       |  

 | Control Number Type: ISSN                                     |  

 | Additional Control Numbers: 1660-2129                         |  

 | URL: http://www.ncbi.nlm.nih.gov/pmc/?term=%22Nephron+Exp+N   |  

 | URL Link Text: Link to resource at PubMed Central.            |  

 | URL Public Comment: Earliest volume=v.113,2009; Open access=  |  

 | Name of Publisher: Karger Publishers                          |  

 |                                                               |  

 | The following newly imported bib from server NLM:             |  

 | Imported Title: Nephron. Experimental nephrology              |  

 | Call# W 1 NE204GB                                             |  

 | Control# 1159770                                              |  

 | LCCN 2003-243039                                              |  

 | ISSN 1660-2129, 1660-8151                                     |  

 |                                                               |  

 | Current Batch Bib MARC# 92                                    |  

 | Title: Nephron. Clinical practice [electronic resource].      |  

 | Call# W 1 NE204GB                                             |  

 | Control# 1159763                                              |  

 | LCCN 2003243038                                               |  

 | ISSN 1660-8151                                                |  

 | Match on tag 022 value 1660-8151                              |  

 |                                                               |  

 | Current Catalog Bib MARC# 96                                  |  

 | Title: Nephron. Physiology [electronic resource].             |  

 | Call# W 1 NE204GB                                             |  

 | Control# 1159772                                              |  

 | LCCN 2003243040                                               |  

 | ISSN 1660-8151                                                |  

 | Match on tag 022 value 1660-8151                              |  

 |---------------------------------------------------------------|  

 | [Display entire MARC bibs here]                               |  

 | [Display entire MARC bibs in a browser]                       |  

 | [Discard the newly imported bib]                              |  

 | [Create a new bib for the catalog]                            |  

 | [Stop the import and cancel the batch]                        |  

 | [Merge holdings & URLs into batch's MARC# 92]                 |  

 | [Overlay onto batch's MARC# 92]                               |  

 | [Retrieve MARC#96 from catalog & merge imported holdings&URLs]|  

 | [Overlay onto MARC# 96]                                       |  

 ----------------------------------------------------------------- 

  

The pop-up occurs because the imported data matches a bib already in the batch and/or matches a bib in the catalog. It is 
possible there is more than one match for either case.  
 

The window is divided into two panels. The top displays a minimum amount of data for each of the associated records. 
The bottom panel presents functions to resolve the situation.  
 

In the top panel, this first record only occurs when using cataloging function [File Z39.50 MARC Bib Import] or [Interactive 
Z39.50 MARC Bib Import]. The key values used to retrieve a full MARC record are displayed:  
 

  Requested record: 3  

  Title: Nephron. Experimental Nephrology  

  Control Number Type: ISSN  

  Additional Control Numbers: 1660-2129  

  URL: http://www.ncbi.nlm.nih.gov/pmc/?term=%22Nephron+Exp+Neph  
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  URL Link Text: Link to resource at PubMed Central.  

  URL Public Comment: Earliest volume=v.113,2009; Open access=So  

  Name of Publisher: Karger Publishers  

  

In this example the second record, the one starting with "The following newly imported bib..." shows data that has been 
imported from NLM via Z39.50:  
 

   The following newly imported bib from server NLM:  

   Imported Title: Nephron. Experimental nephrology  

   Call# W 1 NE204GB  

   Control# 1159770  

   LCCN 2003-243039  

   ISSN 1660-2129, 1660-8151  

  

If function [Import a MARC Bib File] is used, then this is the first displayed record in the top panel. The title and control 
numbers are extracted from the MARC. One or more of these key values match data in records already in the batch or 
catalog. This match is the situation that needs to be resolved. If there were no matches then the MARC would be 
automatically added to the batch.  
 

The next record has one or more key values that match the key values for the newly imported bib:  
 

   Current Batch Bib MARC# 7392  

   Title: Nephron. Clinical practice [electronic resource].  

   Call# W 1 NE204GB  

   Control# 1159763  

   LCCN 2003243038  

   ISSN 1660-8151  

   Match on tag 022 value 1660-8151  

  

This record already occurs in the batch. That means there is more than one bib in this import session, thus two bibs have 
overlapping key values. This is either a mistake or less-than-perfect metadata. Note that you typically have no matches for 
bibs already in the batch. In rare instances you may have many matches.  
 

The last record has one or more key values that match the key values for the newly imported bib:  
 

   Current Catalog Bib MARC# 7396  

   Title: Nephron. Physiology [electronic resource].  

   Call# W 1 NE204GB  

   Control# 1159772  

   LCCN 2003243040  

   ISSN 1660-8151  

   Match on tag 022 value 1660-8151  

  

This record is already in the catalog. Generally catalogers do not re-import the same bib, therefore one should consider 
how to resolve these matches. Please note that you may have no matches for bibs already in the catalog, or many 
matches.  
 

The bottom panel's functions resolve all matching bib situations. Unless the solution is obvious, always select function 
[Display entire MARC bibs in a browser]. Some catalogers like to select this function for each number of matching records 
thus allowing side by side comparison of the data.  
 

Once the data are adequately displayed, then select a function to resolve the situation.  
 

[Discard the newly imported bib] has two different effects. If you started in function [Import a MARC Bib File] then 
[Discard...] completely ignores the MARC record: you would only select [Discard...] if you do not want this record. If you 
started via one of the Z39.50 functions, then the system will discard the newly imported bib and will start the process 
again with either additional control numbers and/or additional Z39.50 servers.  
 

[Create a new bib for the catalog] ignores the matches and saves the new data into the batch as a new work for the 
catalog.  
 

[Stop the import and cancel the batch] is typically used when you have seen the "Duplicate Bib" pop-up window many 
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times, thus realized that you did not initiate the import session correctly. You want to start over.  
 

[Merge holdings & URLs into batch's MARC# nnnnn] will copy any unique URLs from the Z39.50 Requested Record or 
the newly imported bib into the batch's bib. If this session started via [Import a MARC Bib File] then any 85X, 86X and 
9XX tags are also copied.  
 

[Overlay onto batch's MARC# nnnnn] says that you like the new data better than the data currently in the batch therefore 
destroy the instance in the batch and replace it with the newly imported bib.  
 

[Retrieve MARC# nnnn from catalog & merge imported holdings & URLs] copies the data from the catalog into the batch, 
then copies any unique URLs from the Z39.50 Requested Record or the newly imported bib into the batch's bib. If this 
import started via function [Import a MARC Bib File] then any 85X, 86X and 9XX tags are also copied.  
 

[Overlay onto MARC# nnnn] says that you like the new data better than the data currently in the catalog and therefore you 
want to accept these new data into the batch but with the old bib's MARC number. When Batch Control->Update Catalog 
with Batch is later selected, the catalog's old record is replaced with these new data.  
 

Here's some guidance, in priority order:  
 

If the match is a false positive, i.e. the control numbers are shared but the bibs reflect unique works (this is very rare 
except in the case of call numbers), then [Create a new bib for the catalog] is correct. For Z39.50 functions, first verify that 
the newly imported bib matches the requested record at the top of the display.  
 

If the match is real and you see [Retrieve MARC# nnnn from catalog & merge imported holdings & URLs], that is your 
best choice.  
 

If the match is real and you see [Merge holdings & URLs into batch's MARC# nnnnn] then that is your best choice.  
 

Both [Retrieve MARC# nnnn from catalog & merge imported holdings & URLs] and [Merge holdings & URLs into batch's 
MARC# nnnnn] should not be legitimate, unless you have problems in your catalog.  
 

Neither [Overlay...] functions are advised. If the bib was previously fine then why replace it now? Particularly in a union 
catalog, you don't want to replace a colleague's prior work without careful consideration.  
 

When in doubt, [Stop the import and cancel the batch].  
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3.13 The import is over 
 
The import is now over. The data are now in a CyberTools batch. A batch is temporary storage where you can privately 
perfect the data. Your colleagues and patrons cannot see the batch. The import now segues to the Cataloging function 
[Batch Control]. Please continue to function [Batch Control] documentation.  
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4 Batch Control and Electronic Resource Management 
 
4.1 Overview to MARC Bib Batch Control 
 
All importing, editing, or creating of MARC bibliographic records (bibs) occurs in a batch file. A batch file is an intermediate 
file that does not affect the catalog until the batch is applied to the catalog via the function [Update Batch to Catalog]. 
Thus, the cataloger may take the necessary time to perfect a bib prior to having it exposed and indexed in the working 
database.  
 

If a MARC bib is imported from another source such as OCLC, Library of Congress, NLM, or MARCIVE, those data are 
applied to the batch file where it may be more fully processed and tuned for the catalog.  
 

If the MARC bib is already in the catalog and needs adjustments then a batch may be created, and the bib added to the 
batch. The changes made in the batch are not applied to the catalog until the update step [Update Batch to Catalog] 
occurs.  
 

Similarly, original cataloging takes place by creating a batch, and then creating a new MARC bib within this new batch. 
The [Update Batch to Catalog] step applies the new bib to the catalog.  
 

The format of this window implies the processing order. First a batch is selected. Next the cataloger will typically work 
down the first column of functions, and then down the second column of functions. Not all of the functions need to be run. 
During this process Batch Control will look for some obvious simple problems (examples include multiple call numbers 
and MARCout conditions) and will display associated error messages near the top of window until the problems are 
remedied.  
 

Only applicable functions will be selectable. For example, until the batch is processed through function [Update Batch to 
Catalog], function [Item Creation] cannot be run. Once [Update Batch to Catalog] is run, then it cannot be run again 
without changing the batch's status, nor can [Create a New Bib], [Add or Copy Existing Bibs], or [Edit Bib Functions] be 
used.  
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4.2 MARC Bibliographic Batch Control 
 

 
 
4.3 Fields:  MARC Bibliographic Batch Control 
 
4.3.1 Field 1 Catalog Name:  50 characters, display only 
 
4.3.2 Field 2 Last Function:  33 characters, display only 
Displays the last function used on this window.  
 
4.3.3 Field 3 First and Last Titles in Batch:  65 characters, display only 
Displays the first and last titles in the batch.  
 
4.3.4 Field 4 Special Messages:  70 characters, display only 
Displays bib problems or a status report for the batch. May be blank.  
 
4.3.5 Field 5 Batch Number:  7 characters 
Specifies the batch number that contains the bib(s) of interest.  
 

Format: It is a look up table; or, enter an appropriate batch number.  
 
4.3.6 Field 6 Display Bibs:   
This function displays all of the MARC bibliographic records in the batch according to the selected display properties.  
 

For example, a non-decoded display might look like this:  
 

 000 01105pam  2200301 a 4500  

 001 1982729  

 005 19900503152407.1  

 008 891115r19901988nyua     b    001 0 eng  

 010 $a    89048989  

 020 $a 0385267746 : $c $12.95 (Can. $15.95)  

 035 $9 (DLC)   89048989  
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 040 $a DLC $c DLC $d DLC  

 050 10 $a TS171.4 $b .N67 1990  

 082 00 $a 620.8/2 $2 20  

 100 1# $a Norman, Donald A.  

 240 10 $a Psychology of everyday things  

 245 14 $a The design of everyday things / $c Donald A. Norman.  

 250 $a 1st Doubleday/Currency ed.  

 260 ## $a New York : $b Doubleday, $c 1990, c1988.  

 300 $a xv, 257 p. : $b ill. ; $c 21 cm.  

 500 $a Reprint. Originally published: The psychology of everyday  

     things. New York : Basic Books, c1988.  

 500 $a Includes index.  

 504 $a Includes bibliographical references (p. 241-247).  

 650 #0 $a Design, Industrial $x Psychological aspects.  

 650 #0 $a Human engineering.  

  

A fully decoded display might look like this:  
 

000 - Leader =  
 

     00-04 - Logical record length = 01105  

     05 - Record status = p - Increase in encoding level from  

     prepublication  

     06 - Type of record = a - Language material  

     07 - Bibliographic level = m - Monograph/item  

     08 - Type of control = # - No specific type of control  

     09 - Character coding scheme = # - MARC-8  

     10 - Indicator count = 2  

     11 - Subfield code count = 2  

     12-16 - Base address of data = 00301  

     17 - Encoding level = # - Full level  

     18 - Descriptive cataloging form = a - AACR 2  

     19 - Linked record requirement = # - Related record not  

     required  

     20 - Length of the length-of-field portion = 4  

     21 - Length of the starting-character-position portion = 5  

     22 - Length of the implementation-defined portion = 0  

     23 - Undefined Entry map character position = 0  

 001 - Control Number = 1982729  

 005 - Date and Time of Latest Transaction =  

     00-03 - Year = 1990  

     04-05 - Month = 05  

     06-07 - Day = 03  

     08-09 - Hour = 15  

     10-11 - Minute = 24  

     12-15 - Second = 07.1  

 008 - General Information =  

     00-05 - Date entered on file = 891115  

     06 - Type of date/Publication status = r - Reprint/reissue  

     date and original date  

     07-10 - Date 1 = 1990  

     11-14 - Date 2 = 1988  

     15-17 - Place of publication, production, or execution = nyu  

     - New York (State)  

     18 - Illustrations = a - Illustrations  

     19 - Illustrations = # - No illustrations  

     20 - Illustrations = # - No illustrations  

     21 - Illustrations = # - No illustrations  

     22 - Target audience = # - Unknown or not specified  

     23 - Form of item = # - None of the following  

     24 - Nature of contents = b - Bibliographies  

     25 - Nature of contents = # - No specified nature of contents  
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     26 - Nature of contents = # - No specified nature of contents  

     27 - Nature of contents = # - No specified nature of contents  

     28 - Government publication = # - Not a government  

     publication  

     29 - Conference publication = 0 - Not a conference  

     publication  

     30 - Festschrift = 0 - Not a festschrift  

     31 - Index = 1 - Index present  

     32 - Undefined = #  

     33 - Literary form = 0 - Not fiction (not further specified)  

     34 - Biography = # - No biographical material  

     35-37 - Language = eng  

     38 - Modified record = # - Not modified  

     39 - Cataloging source = # - National bibliographic agency  

 010 - Library of Congress Control Number =  

     $a LC control number =    89048989  

 020 - International Standard Book Number =  

     $a International Standard Book Number = 0385267746 :  

     $c Terms of availability = $12.95 (Can. $15.95)  

 035 - System Control Number = $9  = (DLC)   89048989  

 040 - Cataloging Source =  

     $a Original cataloging agency = DLC  

     $c Transcribing agency = DLC  

     $d Modifying agency = DLC  

 050 - Library of Congress Call Number =  

     1st indicator - Existence in LC collection = 1 - Item is not  

     in LC  

     2nd indicator - Source of call number = 0 - Assigned by LC  

     $a Classification number = TS171.4  

     $b Item number = .N67 1990  

 082 - Dewey Decimal Call Number =  

     1st indicator - Type of edition = 0 - Full edition  

     2nd indicator - Source of call number = 0 - Assigned by LC  

     $a Classification number = 620.8/2  

     $2 Edition number = 20  

 100 - Main Entry--Personal Name =  

     1st indicator - Type of personal name entry element = 1 - 

     Surname  

     $a Personal name = Norman, Donald A.  

 240 - Uniform Title =  

     1st indicator - Uniform title printed or displayed = 1 - 

     Printed or displayed  

     2nd indicator - Nonfiling characters = 0 - Number of  

     nonfiling characters present  

     $a Uniform title = Psychology of everyday things  

 245 - Title Statement =  

     1st indicator - Title added entry = 1 - Title added entry  

     2nd indicator - Nonfiling characters = 4 - Number of  

     nonfiling characters present  

     $a Title = The design of everyday things /  

     $c Statement of responsibility, etc. = Donald A. Norman.  

 250 - Edition Statement =  

     $a Edition statement = 1st Doubleday/Currency ed.  

 260 - Publication, Distribution, etc. =  

     1st indicator - Presence of publisher in imprint (BK MP MU  

     SE) [OBSOLETE] = # - Undefined  

     2nd indicator - Added entry/publisher relationship  (SE)  

     [OBSOLETE] = # - Undefined  

     $a Place of publication, distribution, etc. = New York :  

     $b Name of publisher, distributor, etc. = Doubleday,  

     $c Date of publication, distribution, etc. = 1990, c1988.  

 300 - Physical Description =  
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     $a Extent = xv, 257 p. :  

     $b Other physical details = ill. ;  

     $c Dimensions = 21 cm.  

 500 - General Note =  

     $a General note = Reprint. Originally published: The  

     psychology of everyday  things. New York : Basic Books,  

     c1988.  

 500 - General Note = $a General note = Includes index.  

 504 - Bibliography, etc. Note =  

     $a Bibliography, etc. note = Includes bibliographical  

     references (p. 241-247).  

 650 - Subject Added Entry--Topical Term =  

     1st indicator - Level of subject = # - No information  

     provided  

     2nd indicator - Subject heading system/thesaurus = 0 - 

     Library of Congress Subject Headings  

     $a Topical term or geographic name as entry element = Design,  

     Industrial  

     $x General subdivision = Psychological aspects.  

 650 - Subject Added Entry--Topical Term =  

     1st indicator - Level of subject = # - No information  

     provided  

     2nd indicator - Subject heading system/thesaurus = 0 - 

     Library of Congress Subject Headings  

     $a Topical term or geographic name as entry element = Human  

     engineering.  

 

 
4.3.7 Field 7 Edit one bibliographic record:   
Function [Edit Bib] allows the selection of one bib in the batch for the purpose of editing, changing its status (including 
removing the bib from the batch), and displaying the bib. A traditional MARC editor is available as well as an easy to use 
Brief Bibliographic editor.  
 
4.3.8 Field 8 Review URLs Retrieved from the catalog:   
Function [Review URLs retrieved from the catalog] finds URLs which were retrieved from the catalog during the import. 
Some libraries have a preference for specific aggregators, e.g., Ovid over EBSCO. This window allows you to globally 
remove these retrieved URLs, or, conversely, to keep the retrieved bibs, or even remove the imported URLs when present 
with a retrieved URL.  
 
4.3.9 Field 9 URL Link Text, Public Comments, & Rules:   
Function [File Z39.50 MARC Bib Import] always calls the function [URL Link Text, Public Comments, & Rules]. This 
function adds:  
 

 MARC Tag 856 $y Link Text  MARC Tag 856 $z Public Comment  Link Resolver  Use URL Rewriter 
 Restrict URLs to Catalogs  
 

Some File Formats (i.e., EBSCO Journals, PubMed Central Journal List, and others) have additional questions.  All 
responses are saved by File Format for use on the next import.  
 

This function can also be run on demand from the Batch Control menu.  
 
4.3.10 Field 10 Assign A to Z Groups IDz:   
[Assign A to Z Group IDs] allows A to Z Group Identifiers to be selected and then applied to the bibs in the batch.  
 
4.3.11 Field 11 NLM MARCout Conversion:   
Function [NLM MARCout Conversion] converts a NLM format to a standard bib format. In some cases, NLM now uses a 
different MARC bib record format internally from the format it uses to distribute records to OCLC. If you choose to acquire 
records directly from NLM using a feature of NLM LOCATORplus, you will then have records in this non-standard format. 
CyberTools provides a utility to convert these records to the standard format. The utility allows you to specify which of four 
types of conversions to perform:  
 

1. Convert separate 650 age group, pregnancy tags to $x subfields on 650s.  
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2. Convert 651 _2 $a geographic to $z in all 650s.  
 

3. Convert Form PTs in 655 _7 tags to $v subfields on 650s.  
 

4. Convert Genre PTs in 659 _7 tags to 655 _7 tags.  
 

This process is fully documented elsewhere.  
 
4.3.12 Field 12 Remove Undesired Local Tags:   
Function [Remove Undesired Local Tags] removes all undesired local MARC tags from a bib. These tags contain a 9, 
e.g., 590, and thus they are not part of the MARC 21 Bibliographic definitions. If the MARC record was acquired from 
external source (LC, NLM, OCLC, or another library, etc.) then the record probably has local values in the MARC record, 
and those local notes should be at a tag containing a 9. For example, if you acquired the MARC record from the Library of 
Congress or from the National Library of Medicine, the records will have many 900 level tags which are meaningless apart 
from the software that those libraries use.  
 

The user should look at the MARC records before selecting this function. This Function will remove all tags containing a 9 
except for tags specified in the field labeled Tags to find Call Numbers and in the field labeled Allowable Local Tags 
(9ers). Both lists are controlled by the window called MARC Bibliographic Settings.  
 

Tag 949 subfield a, with a value of SERIAL or OTHER, will not be removed since these values at this tag and subfield are 
special controls to this CyberTools software.  
 
4.3.13 Field 13 Import Profile Call Number:   
A MARC Import Holdings Profile defines the tags and subfields which can be used to automatically adjust bib call 
numbers according to the holdings, and/or to create items (holdings). Multiple Profiles may be active at one time; a library 
also may have no Profiles at all. Profiles are used during conversions from other automation systems, or by libraries using 
a cataloging service.  
 

A Profile specifies which tag should be used, and how the tag's subfields map to the Item database. For example, the 
standard CyberTools - MARCIVE Profile uses tag 852 and maps:  
 

Item Field    Tag Subfield  

-----------   ------------ 

     Call #   h  

   Location   b  

   Bar Code   p  

     Copy #   t  

     Volume   v  

      Price   9  

  

A tag for the Profile may repeat in the MARC bib, thus conveying more than one copy of the same title. Repeating 
subfields within an occurrence of a tag are treated as additional copies.  
 

Although unusual, more than one Profile may use the same tag, but the mapping should be different. When this situation 
occurs, the software prompts the user to select the correct Profile.  
 

The Profile is used for two tasks. First, the holding's call numbers are compared to the call number tags used in the 
catalog. Second, the imported MARC bib's holdings data are converted to circulation items.  
 

The first task occurs automatically at the end of the import, or may be performed manually via function Batch Control-
>Import Profile Call Number. It is used for conversions from other automation systems or when receiving MARC bibs from 
a contract cataloging source. This takes the call number from the tag and subfield mapped in the Profile for Call Numbers, 
and compares that value to those found in the bib's call number tags:  
 

     050  Library of Congress Call Number  

     060  National Library of Medicine Call Number  

     082  Dewey Decimal Call Number  

     090  Local LC Call Number  

     092  Local Dewey Decimal Call Number  

     096  Local NLM Call Number  
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     099  Local Unspecified Call Number  

  

Only the call numbers that the library uses are compared.  
 

If the holding's call number is not found in the above call number tags, then the holding's call number is copied to a 09X 
tag accordingly:  
 

1) If the value is a NLM classification (i.e., starts with QR, QZ or W), then the software automatically copies the value to 
096 $a only if there is no 096, otherwise it is copied to 099 $a.  
 

2) If the value is a LC classification (i.e., does not start with QR, QZ or W and is not Dewey), then it is copied to 099 $a.  
 

3) If the value is a Dewey classification, then it is copied to 092 $a if there is none, otherwise it is copied to 099 $a.  
 

Please note that a Profile can be managed from the function [MARC Import Holdings Profiles].  
 

The second task occurs after running Batch Control->Update Catalog with Batch. It is automatic, but can also be run 
manually. In this function, items are created from the Profile mapping.  
 

As an example, given this abbreviated MARC bib:  
 

 010  ## $a 89-6056  

 060  0# $a WS 105 $b V369c 1990  

 245  10 $a Child and adolescent development : $b clinical  

      implications / $c Victor C. Vaughan III, Iris F. Litt.  

 852  ## $b GENERAL $h WS 105 V36 1990  

  

852 $h states that this item's call number is different than the bib's (at 060 $a & $b), and that the item is in location 
GENERAL (COLLECTION).  
 

Immediately after importing the bib, the software will prompt:  
 

 ----Compare and process holdings Call Numbers for the bibs'----- 

 | The imported MARC bibs match your Holdings Profile.          |  

 | Please select the Profile to move the Holdings' Call         |  

 | Number(s) into the appropriate MARC tag for call numbers.    |  

 | ( ) 1 CyberTools - MARCIVE 852 Profile                       |  

 |--------------------------------------------------------------|  

 | [Cancel]                                                     |  

 ---------------------------------------------------------------- 

  

If the Profile is selected, then the item's call number WS 105 V36 1990 will be copied to the MARC bib tag 096, thus 
becoming the call number for the bib at this library. Conversely, if [Cancel] is selected, then the comparison is not run but 
may be run later via function [Import Profile Call Numbers].  
 

After running function [Update Catalog with Batch] the software will prompt:  
 

 ----------Generate Items from Holdings Profile?------------- 

 | The MARC bibs match your Holdings Profile.               |  

 | Please select the Profile to generate items accordingly: |  

 | ( ) 1 CyberTools Standard 852 Profile                    |  

 |----------------------------------------------------------|  

 | [Cancel]                                                 |  

 ------------------------------------------------------------ 

  

If the Profile is selected then the software creates an item in location General Collection for this title. If [Cancel] is 
selected, then items are not created, although this function can be run manually later via function [Item Creation].  
 

The function first scans all of the Profile tags for all of the bibs in the batch.  
 

If a bib lacks the Profile tag, then the software will not create an item for the bib.  
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If a bib has a Profile tag that lacks a location, then the software uses the New Books Location value established by 
function Properties->New Items Circulation Defaults.  
 

If a bib has a Profile location that matches a value Circulation Location table (as found in function [Properties]), then an 
item is created for that bib, and the item is associated with the specified location.  
 

If a Profile location is not found in the Location Table, then the software will place the undocumented location in a report 
and the conversion process stops: items cannot be created until the location discrepancies are resolved. The cataloger 
typically corrects either the Locations Table and/or corrects the bib's Profile Location subfield values. When the batch is 
creating items, the batch may need to be re-imported and the Profile Location subfield edited. Since the items do not use 
the location values literally (i.e., the location value is found in the table and converted to a database pointer to the entity in 
the table), then the following solution may be employed. Edit the location table so that the following Location fields:  
 

     Description  

     Staff Display  

     OPAC Display  

     Spine Display  

  

reflect the variations in location names that might be found. For example, the default system is delivered with a location 
Reference. It has the short name of "Ref.". If a bib has a Profile Location subfield with a value of REF (note that it is 
missing the period), then the conversion program will not be able to match REF to Reference. The conversion program is 
not case sensitive, but it is phrase and punctuation sensitive.  
 

Since the bib is already updated to the catalog, you probably do not want to re-import it and edit the tag, particularly if this 
is the initial conversion, although re-importing and editing is an option. Instead, go to Staff Function->Properties-
>Circulation Locations. Select location Reference and you will see:  
 

          Location Description: Reference  

                 Staff Display: Ref.  

                  OPAC Display: Ref.  

                 Spine Display: Ref.  

  

Edit the Staff display from "Ref." to "REF", i.e., without the period:  
 

          Location Description: Reference  

                 Staff Display: REF  

                  OPAC Display: Ref.  

                 Spine Display: Ref.  

  

Go back and run the Batch Control->Item Creation, select your Profile, and it will now process the REF value. Once done, 
you may choose to re-edit the Staff Display value back to "Ref.".  
 

Serials Management interacts with Profile processing. If the bib was previously initialized for Serials Management, then 
the imported holdings are ignored. But, if the bib has no items in the database, and the imported holdings location 
matches a Circulation Location set up for Serials Management, then the bib is automatically initialized for Serials 
Management while running function [Import Profile Call Numbers].  
 
4.3.14 Field 14 Serial Initiation:   
Function [Serial Initiation] sets MARC Bib 949 $a to the value of SERIAL for each bib in the batch. This triggers the 
software to place the title in Serials Management.  
 
4.3.15 Field 15 Batch Control Tools:   
Function [Tools] leads to an additional menu which offers a variety of global edits to the batch as a whole. For example, 
this menu offers the function [Electronic Resources Global Edits].  
 
4.3.16 Field 16 Update Catalog with Batch:   
Applies the data in the batch to the catalog database. Without this step, the catalog will never see the data. Each bib with 
a status of OKPROCESS will be applied to the catalog.  
 

Format: It is a push button selection.  
 

Discussion: None of the values in the batch file are available in the catalog until the function [Update Catalog with Batch] 
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is run. Depending on your system setup, the update may be displayed in real-time in an update window, or the update 
may run in the background, freeing the window to do something else.  
 

Alternatively, if a batch's status is set to OKPROCESS, then the system will automatically update the catalog at night.  
 
4.3.17 Field 17 Report on Update to Catalog:   
This window may be used to generate the MARC Filer Report. This report should be checked whenever a batch is filed to 
determine which, if any, records and/or tags did not file. The report may be sent to the Workstation, the Default Printer, 
another Printer that is not the default, or a File. The report may also be e-mailed.  
 

SAMPLE REPORT:  
 

 Batch Number 31  

  

 MARC# 1 Tag: 100 NEW ENTRY: Asimov, 1920 made to Author Authority  

  

 MARC# 1 Tag: 245 NEW ENTRY: The man's... made to Series Authority  

 

 
4.3.18 Field 18 Item Creation:   
Use this field to create the actual holdings information. The bib is the idea of the titled object, but not the actual instance of 
the holdings: the holdings (items) circulate, not the bibs. The items are the copies, issues, and volumes that are the 
circulating collection. Items are tied to the bibs, and record the individual bar code, volume, copy, year, location, 
circulation class (example: two weeks) and status (example: Available), etc.  
 

Format: It is a push button selection.  
 

Discussion: Three sub-functions can be used create items, and one must be chosen. The options are:  
 

    Manually create items for each bib  

    Automatically create one item for each bib  

    Convert the 852 holdings data into items  

  

These functions are discussed thoroughly elsewhere.  
 
4.3.19 Field 19 Create Labels:   
This function prints three types of labels:  
 

     - Spine Labels  

     - Pocket Labels  

     - Combination Spine and Pocket Labels  

  

The following combination labels are in the software today:  
 

     Demco 142-0453  

     Demco 142-1685  

     Demco 149-4218  

     Highsmith 30720  

     Highsmith 43583  

     Highsmith 43590  

     Highsmith 43596  

  

All of the values collected on the window (except Batch Numbers) are stored in the database for re-use.  
 

The labels have a variable format:  
 

     - label length  

     - number of labels on a row  

     - most recent item's location  

     - most recent item number.  

  

Here is an example of 4 across spine labels:  



CyberTools Electronic Resources Management Guide 2020-01-16      ©CyberTools Inc. 1998-2020 

 

 

110 

 

 QU            WA            QV            QA  

 145           950           4             276  

 W618u         D184b         H918          C337  

 1990          1995          1998          1990  

  

Here are the same labels, but with location and item numbers:  
 

 RES.          CircD         RES.          CircD  

 QU            WA            QV            QA  

 145           950           4             276  

 W618u         D184b         H918          C337  

 1990          1995          1998          1990  

 389256        389269        389270        389281  

  

Pocket labels display the call number, the author, and the title:  
 

 QU  145 W618u 1990                WA 950 D184b 1995  

 Whitney, Eleanor...               Daniel, Wayne W.,  

 Understanding                     Biostatistics : / a  

 nutrition /                       foundation for...  

  

 QV 4 H918 1998                    QA 276 C337 1990  

 Brody, Theodore M.                Casella, George.  

 Human pharmacology :              Statistical  

 / molecular to...                 inference /  

  

Pocket labels may also display location and item number values:  
 

 QU 145 W618u 1990                 WA 950 D184b 1995  

 Whitney, Eleanor...               Daniel, Wayne W.,  

 Understanding                     Biostatistics : / a  

 nutrition /                       foundation for...  

 RES.           389256             CircD          389269  

  

 QV 4 H918 1998                    QA 276 C337 1990  

 Brody, Theodore M.                Casella, George.  

 Human pharmacology :              Statistical  

 / molecular to...                 inference /  

 RES.           389270             CircD          389281  

  

The Combination Spine and Pocket labels are a neat layout, portrayed here as a single column. These actually print in 
two columns on a page. The Demco 142-1685 form allows for one more line of Title information to be printed on the 
pocket label:  
 

 QU          QU 145 W618u 1990  

 145         Whitney, Eleanor...  

 W618u       Understanding  

 1990        nutrition /  

  

             QU 145 W618u 1990  

             Whitney, Eleanor...  

             Understanding  

             nutrition /  

  

 WA          WA 950 D184b 1995  

 950         Daniel, Wayne W.,  

 D184b       Biostatistics : / a  

 1995        foundation for...  

  

             WA 950 D184b 1995  

             Daniel, Wayne W.,  
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             Biostatistics : / a  

             foundation for...  

  

The Demco 142-1685 label may also show the location and item number on the pocket:  
 

 QU          QU 145 W618u 1990  

 145         Whitney, Eleanor...  

 W618u       Understanding  

 1990        nutrition /  

             RES.           389256  

  

             QU 145 W618u 1990  

             Whitney, Eleanor...  

             Understanding  

             nutrition /  

             RES.           389256  

  

 WA          WA 950 D184b 1995  

 950         Daniel, Wayne W.,  

 D184b       Biostatistics : / a  

 1995        foundation for...  

             CircD          389269  

  

             WA 950 D184b 1995  

             Daniel, Wayne W.,  

             Biostatistics : / a  

             foundation for...  

             CircD          389269  

  

or show location and item numbers on all of the labels:  
 

 RES.        QU 145 W618u 1990  

 QU          Whitney, Eleanor...  

 145         Understanding  

 W618u       nutrition /  

 1990        RES.           389256  

 389256  

             QU 145 W618u 1990  

             Whitney, Eleanor...  

             Understanding  

             nutrition /  

             RES.           389256  

  

  

 CircD       WA 950 D184b 1995  

 WA          Daniel, Wayne W.,  

 950         Biostatistics : / a  

 D184b       foundation for...  

 1995        CircD          389269  

 389269  

             WA        Daniel, Wayne W.,  

             Daniel, Wayne W.,  

             Biostatistics : / a  

             foundation for...  

             CircD          389269  

 

 
4.3.20 Field 20 Change Batch Status:   
Use this field to change the status of a MARC batch. The batch statuses are:  
 

    CANCEL = the batch has been permanently rejected and rendered  

    unusable;  
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    DONE = the batch has been applied to the database, although  

    some MARC records might still have the status of error;  

  

    ERROR = due to a failure in updating the batch to the  

    database;  

  

    FILING = the system is attempting to update the database;  

  

    HOLD = prevents the system from automatically updating  

    the database at night;  

  

    INUSE = the system or a user is manipulating the batch;  

  

    OKPROCESS = allows the system to automatically update the  

    database at night;  

  

A batch with the status of CANCEL cannot be modified.  
 

If a batch status is FILING or INUSE, do not change it unless it keeps that status for a long time (e.g., hours). Before 
changing this condition, make sure the computer has not been too busy and there have been no other errors.  
 

If a batch status is ERROR or the batch has MARC records with the status of ERROR:  
 

   1. Edit the problematic MARC record  

   2. Change the status of the MARC records from ERROR to  

      OKPROCESS  

   3. Change the status of the batch from ERROR to OKPROCESS  

   4. Use function [Update Catalog with Batch].  

 

 
4.3.21 Field 21 Help on batch control:   
Provides both reference help and a tutorial on the batch control process.  
 

Format: It is a push button selection.  
 
4.3.22 Field 22 Return to Cataloging Menu:   
Function [Return to Cataloging Menu] ends the Batch Control session. All changes made during the session remain. The 
session can be resumed from the Cataloging Menu via function [Batch Control (resume editing bibs)].  

 
4.4 Oops! I ran [Update Batch...] but need to make more changes! 
 
We've all done that. As long as you have not created more batches with the same bibs in the target batch, then you can 
resume editing the updated batch. Go back to Cataloging->Batch Control-> Change Batch Status. A pop-up gives you the 
choices  
 

         |--Change the Status of Batch #### from DONE to----|  

         |  ( ) HOLD                                        |  

         |  ( ) CANCEL                                      |  

         |  ( ) Remove Batch                                |  

         |--------------------------------------------------|  

         | [Close]  [Help on Change Status]                 |  

         |--------------------------------------------------|  

  

Select HOLD. A subsequent pop-up asks:  
 

 |--------------Change bib(s) from DONE to OKPROCESS?-------------|  

 | There is at least one bib in the batch with the status of DONE.|  

 | Do you want to change all such bibs to OKPROCESS so that       |  

 | you can edit them?                                             |  

 | [Keep DONE]  [Change to OKPROCESS]                             |  

 |----------------------------------------------------------------|  
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Select function [Change to OKPROCESS], return to Batch Control, and finish your work.  
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4.5 Overview: Assign A to Z Groups to Bibs in a Batch 
 
Function [Assign A to Z Groups to Bibs in a Batch] is accessed from Batch Controls->Tools. This presents all of the 
libraries in the union catalog. Any number of libraries can be used, including none. Each library can have its own A to Z 
Groups assigned. Any number of a library's A to Z Groups can be used. The A to Z Groups and the libraries are saved in 
the MARC record in the A to Z tag, typically 919, as subfields a and b, respectively. Example:  
 

   919 ## $a JP $b East Campus  

   919 ## $a JA $b East Campus  

   919 ## $a JOURNALS $b West Campus  

  

This window is also used for a library not in a union catalog. The library can apply its A to Z groups to the batch. The 
MARC structure is the same as that shown above.  

 
4.6 Assign A to Z Groups to Bibs in a Batch 
 

 
 
4.7 Fields:  Assign A to Z Groups to Bibs in a Batch 
 
4.7.1 Field 1 Status of the Process:  60 characters, display only 
Displays the message "Working..." and/or other messages while the software processes the data.  
 
4.7.2 Field 2 Catalog Short Name:  60 characters, display only 
Field Catalog displays the library's short name as a preface to the following A to Z Group field.  
 
4.7.3 Field 3 A to Z Groups:  15 characters, multiple 
Patrons can access catalog data via functions [Search Catalog] or [A-Z]. An A to Z List is a collection of works displayed 
by title. Secondarily they are displayed by subject and then by title. Any work can belong to any number of A to Z lists. For 
example, New England Journal of Medicine might belong to a list of Print Journals, e-Journals on Campus, and/or the list 
of All Journals.  
 

A to Z Groups are created from the menus Cataloging and/or Properties.  
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4.7.5 Field 5 Controls Ok, Cancel, & Help:   
Specifies an action that controls the window's flow. [Ok] will save and apply the displayed values, while [Cancel] will reject 
the changes. [Help] will display all of the documentation for the window. Press the Help key for context-sensitive help for 
each field.  
 

Format: It is an action that toggles the push button.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help 
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4.8 Overview to Review URLs Retrieved from the Catalog 
 
Function [Review URLs retrieved from the catalog] finds URLs which were retrieved from the catalog during the import. 
Some libraries have a preference for specific aggregators, e.g., Ovid over EBSCO. This window allows you to globally 
remove these retrieved URLs, or, conversely, to keep the retrieved bibs, or even remove the imported URLs when present 
with a retrieved URL.  

 
4.9 Review URLs Retrieved from this catalog 
 

 
 
4.10 Fields:  Review URLs Retrieved from this catalog 
 
4.10.1 Field 1 Total number of servers retrieved from bibs in the live catalog:  4 characters, display only 
4.10.2 Field 2 Batch#:  6 characters, display only 
 
4.10.3 Field 3 Count of Retrieved Bibs:  65 characters, display only 
 
4.10.4 Field 4 Controls Ok, Cancel, & Help:   
Specifies an action that controls the window's flow. [Ok] will save and apply the displayed values, while [Cancel] will reject 
the changes. [Help] will display all of the documentation for the window. Press the Help key for context-sensitive help for 
each field.  
 

Format: It is an action that toggles the push button.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help 
 
4.10.5 Field 5 Display all retrieved servers' URLs in the catalog:   
In the window section "Servers in the catalog for bibs that occur in the batch" the function [Display] displays  
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 - the server on the same row as the button [Display];  

 - the Retrieval rule;  

 - each bib's URL to the same server;  

 - any other of the bib's URLs currently in the catalog;  

 - any other of the bib's URLs in this batch.  

  

The display should help determine the retrieval rule. For example, if the batch was for the open access PubMed Central 
Journal List, and you previously imported a commercial collection, e.g., Ovid, then you might want the Ovid URLs to 
OVERRIDE those from PubMed.  
 

All URLs are actual hyperlinks so that they can be used directly from the report, i.e., you can see the resource.  
 

Here is an example of the report:  
 

 1. Server clinicalkey.com is in existing bibs in the catalog  

 with the rule Retrieve:  

  

 MARC# 14 American family physician  

 catalog's 856-1 $u https://www.clinicalkey.com/dura/browse/  

 journalIssue/0002838X $y Link to resource. $z Starting  

 2008-08-01, v.78:3 $x SUE 20150707 batch#7838  

   also in this batch for this bib:  

   batch's 856-1 $u http://www.aafp.org/online/en/home/  

   publications/journals/afp/afpsearch.html $y Link to resource  

   at Publisher's Site. $z Extent 1998 - Present $x system  

   20160622 batch#8100  

   batch's 856-2 $u http://www.aafp.org/journals/afp.html  

   $y Link to resource at American Academy of Family Physicians.  

   $z Extent 1998 - Present $x system 20160622 batch#8100  

  

 MARC# 15 American heart journal.  

 catalog's 856-1 $u https://www.clinicalkey.com/dura/browse/  

 journalIssue/00028703 $y Link to resource. $z Starting 2007-01,  

 v.153:1 $x SUE 20150707 batch#7838  

   also in this batch for this bib:  

   batch's 856-1 $u http://www.sciencedirect.com/science/journal/  

   00028703 $y Link to resource at ScienceDirect. $z Extent 2007  

    - Present $x system 20160622 batch#8100  

<snip>  
 
4.10.6 Field 6 Server Number:  10 characters, display only 
The Server Number is a serial number for display purposes.  
 
4.10.7 Field 7 Server Doman Name:  45 characters, display only 
The Server Domain Name displays is the Internet address of the server.  
 
4.10.8 Field 8 Count of old URLs accessing this server:  3 characters, display only 
4.10.9 Field 9 Example title accessing this server:  60 characters, display only 
4.10.10 Field 10 Example URL with this title:  100 characters, display only 
4.10.11 Field 11 Resolve Server Doman Name:  20 characters, display only 
The Server Domain Name displays is the Internet address of the server.  
 
4.10.12 Field 12 List of new server where this old server occurs.:  45 characters, display only 
4.10.13 Field 13 Display one server currently in the catalog for same bibs:   
In the window section "Servers in the catalog for bibs that occur in the batch" the function [Display] displays  
 

 - the server on the same row as the button [Display];  

 - the Retrieval rule;  

 - each bib's URL to the same server;  

 - any other of the bib's URLs currently in the catalog;  

 - any other of the bib's URLs in this batch.  
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The display should help determine the retrieval rule. For example, if the batch was for the open access PubMed Central 
Journal List, and you previously imported a commercial collection, e.g., Ovid, then you might want the Ovid URLs to 
OVERRIDE those from PubMed.  
 

All URLs are actual hyperlinks so that they can be used directly from the report, i.e., you can see the resource.  
 

Here is an example of the report:  
 

 1. Server clinicalkey.com is in existing bibs in the catalog  

 with the rule Retrieve:  

  

 MARC# 14 American family physician  

 catalog's 856-1 $u https://www.clinicalkey.com/dura/browse/  

 journalIssue/0002838X $y Link to resource. $z Starting  

 2008-08-01, v.78:3 $x SUE 20150707 batch#7838  

   also in this batch for this bib:  

   batch's 856-1 $u http://www.aafp.org/online/en/home/  

   publications/journals/afp/afpsearch.html $y Link to resource  

   at Publisher's Site. $z Extent 1998 - Present $x system  

   20160622 batch#8100  

   batch's 856-2 $u http://www.aafp.org/journals/afp.html  

   $y Link to resource at American Academy of Family Physicians.  

   $z Extent 1998 - Present $x system 20160622 batch#8100  

  

 MARC# 15 American heart journal.  

 catalog's 856-1 $u https://www.clinicalkey.com/dura/browse/  

 journalIssue/00028703 $y Link to resource. $z Starting 2007-01,  

 v.153:1 $x SUE 20150707 batch#7838  

   also in this batch for this bib:  

   batch's 856-1 $u http://www.sciencedirect.com/science/journal/  

   00028703 $y Link to resource at ScienceDirect. $z Extent 2007  

    - Present $x system 20160622 batch#8100  

<snip>  
 
4.10.14 Field 14 Resolve Retrieved URLs:  mandatory 
Purpose:  field Resolve Retrieved URLs purpose determines if a URL currently in the catalog and copied into the batch 
should stay, be removed, or cause the newly imported URLs to be removed.  
 

When you use function [Import a MARC Bib File], if the bib is already in the catalog, then the default software behavior is 
to copy the catalog's bib into the batch, then add the URLs from the imported bib. Similarly, when you use function [File 
Z39.50 MARC Bib Import], if the work is already in the catalog then its bib is copied into the batch, and the imported URLs 
are added to the bib in the batch.  
 

Most of the time all of the URLs (old and new) are kept. Some libraries do not like keeping multiple URLs per work. 
Therefore this field, Resolve Retrieved URLs allows you to globally remove either the old URLs or the new URLs in the 
batch. For example, perhaps you originally imported the PubMed Central Journal List, and then import CINAHL. If 
CINAHL has lesser blackouts/embargos, then this window would allow you to REMOVE OLD the PubMed Central Journal 
List URLs. Conversely, if you originally imported the CINAHL, and then import PubMed Central Journal List. If CINAHL 
has lesser blackouts/embargos, then this window would allow you to DISCARD NEW the PubMed Central Journal List 
URLs.  
 

Option KEEP makes no changes.  
 

Option REMOVE OLD expunges URLs identified by the server name shown on the right of the label for bibs in the batch.  
 

Option DISCARD NEW expunges URLs identified by the server shown on the right of the label for bibs in the batch. 
These are the URLs which you just imported, and only when the bib has URLs to the old server shown to the left and/or 
above.  
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Menu Style:  Radio Button/Check Box 

Menu Values: 

Keep 

Remove old= 

Discard new= 
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5 A to Z Groups Management 
 
5.1 Overview to A to Z Group Edit 
 
The A to Z Group edit is accessed from either the Cataloging menu or the Properties menu. An A to Z Group represents 
an aggregation of bibliographic records on the A to Z pages. For example, a Group might be Databases, eBooks, 
eJournals, Consumer Health DVDs, Games, etc.  
 

A bib can be assigned to 99 different A to Z Groups.  
 

An A to Z Group ID can be applied to a bib, or in the first three cases to bibs, via functions:  
 

   - Serials->Serial Properties;  

   - Batch Control->Tools;  

   - Properties->Circulation Locations;  

   - Batch Control->Edit Bib->Brief Bib Editor or MARC Editor.  

 

 
5.2  A-Z Group Edit 
 

 
 
5.3 Fields:   A-Z Group Edit 
 
5.3.1 Field 1 A to Z Group Short Identifier:  15 characters 
The A to Z Group Short Identifier is an alphanumeric code that uniquely represents an A to Z Group. Patrons do not see 
this code. It is used by the A to Z librarian and the software, but it is created by the librarian. An A to Z Group Short 
Identifier cannot be changed, but it can be removed or its members can be merged into another A to Z Group.  
 

The A to Z Group Short Identifier is entered into a table before it can be listed. If a leading portion of the Short Identifier is 
typed and the user presses Enter, then all matching identifiers are displayed. If a value is typed and is not matched, then 
the software confirms that the librarian is creating a new A to Z Group Short Identifier, thus a new A to Z Group.  
 

Example: DVDs, eBooks, eJournals, Fiction, Games, SERIALS, are common Short Identifiers.  
 
5.3.2 Field 2 Add Code:   
The function [Create New A to Z Group] is an direct means of creating a new A to Z Group. It pops-up a window to create 
a new A to Z Group Short Identifier.  
 

A new A to Z Group can also be created by simply typing in a new A to Z Group Short Identifier.  
 
Menu Style:  Push Button 
Menu Values: 
Create New 
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5.3.3 Field 3 A to Z Group Name:  60 characters 
The A to Z Group Name is displayed to the patron on the A to Z pages. It is unrestricted free text.  
 
5.3.4 Field 4 Open A to Z with this group:   
If there is more than one A to Z Group, then when the patron initially views the A to Z lists, the group that has been 
specified as "Open A to Z with this group" is initially displayed.  
 

If no group is specified, then the groups are listed alphabetically and the first group in the alphabet is utilized.  
 

If more than one group is specified, then the first selected group in the alphabetic listing of groups is utilized.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Open A to Z with this group 
 
5.3.5 Field 5 A to Z Type:  mandatory 
Specifies a second display category (in addition to titles) for the A to Z group. By default, a list of subjects is created (from 
tags 650 and 690). This can be modified to a list of personal names from tag 600 (for category biography) or a list of 
authors from tag 100 (for category fiction).  
 
5.3.6 Field 6 Controls:   
Specifies an action that controls the window's flow. [Ok] will save and apply the displayed values, while [Cancel] will reject 
the changes. [Help] will display all of the documentation for the window. Press the Help key for context-sensitive help for 
each field.  
 

Format: It is an action that toggles the push button.  
 
Function [Remove] will remove an A to Z Group. It will also remove the Group ID from all associated MARC bibliographic 
records.  
 

[Move] will move the records in one A to Z Group to another A to Z Group.  
 

[Review] will create a list of all bibs in the A to Z groups. This list can then be printed or viewed from the OPAC Save 
Results.  
 

[A to Z URL] displays the URL that opens this A to Z Group.  
 

[A to Z HTML] creates HTML code that can be inserted into any web page. The code displays the Descriptive Name and 
the A to Z push buttons. When a button is selected, the form uses the CyberTools OpenURL to list the titles or subjects. 
Please see function [My URLs, CyberJ Setup, and HTML Code] for more information.  
 
Menu Style:  Push Button 
Menu Values: 
Ok 
Cancel 
Help 
Move... 
Remove... 
Review... 
A to Z URL... 
A to Z HTML.. 
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6 URL Click Report 
 
6.1 Overview to URL Click Report 
 
The URL Click Report reports the titles, servers, and/or URLs accessed via Search Catalog or A to Z for a specified time 
period. The report can be alphabetic or ranked by the count of clicks. The report can be by:  
 

   - Title  

   - Server  

   - Title with Server  

   - Title with URL  

  

The Server option allows the library to determine return on investment by aggregator.  
 

This report is found at Staff Functions->Reports->Cataloging->URL Click Report and at OPAC Reports or Staff Functions-
>Cataloging-> Reports->URL Click Report.  

 
6.2 Report Anomalies 
 
CyberTools has always counted clicks from the Staff Search Catalog and A to Z. The Patron Search Catalog (i.e., the 
OPAC) and A to Z click counts started in mid-March 2012. The Patron counts are only valid after March 2012. Therefore 
the software uses a default starting date of April 2012, or later, depending on when the report is run.  
 

If a work was removed, then its MARC number displays with an appended asterisk. If a removed work's title can not be 
recovered then UNKNOWN TITLE displays. Here are examples:  
 

 MARC#     Title               Clicks  

 <snip>  

 6386*     AAACN Viewpoint.         2  

 9040      AAACN Viewpoint.         3  

 6387*     AACN Bold Voices.        2  

 9041      AACN Bold Voices.        1  

 <snip>  

  

In the above example, 6286* and 6387* are removed works.  
 

URLs are modified in the count database. Leading "http" and"www." are removed. Very long URLs are truncated and 
appended with "<snip>". In the event that the software cannot successfully modify the server and/or URL, then the server 
is displayed as UNKNOWN SERVER, and the URL as UNKNOWN URL.  

 
6.3 Example of a report by title 
 
The following report is alphabetic by title. The server and URLs are not shown.  
 

 URL Report 2012-JUN through 2012-DEC by Count for Patrons  

 MARC#     Title                                           Clicks  

 8723      12 Steps for Creating a Culture of Retention:        3  

 9201      12 Steps for Creating a Culture of Retention:        1  

 8615      20/20.                                               3  

 8616      24x7.                                                2  

 8109      2012 Lippincott's nursing drug guide                 5  

 6386*     AAACN Viewpoint.                                     2  

 9040      AAACN Viewpoint.                                     3  

 6387*     AACN Bold Voices.                                    2  

 9041      AACN Bold Voices.                                    1  

 8962      AACN advanced critical care.                         3  

 3413      AACN clinical issues.  

 <snip>  

file:///E:/wrk/http
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 3595      Wounds : a compendium of clinical research           2  

 9078      Wyoming Nurse.                                       1  

 8721      Yale journal on regulation.                          1  

  

 Total Rows = 1736  

 Total Clicks = 4626  

 

 
6.4 Example of a report by title and server, ranked 
 
The following report is ranked. Titles and servers are displayed. The URLs are not displayed.  
 

  URL Report 2012-JUL through 2012-DEC by Count for Patrons  

  MARC#     Title                        Server           Clicks  

  67        The New England journal of   nejm.org            106  

  89        JAMA : the journal of the A  ovidsp.ovid.com      42  

  38        Circulation.                 ovidsp.ovid.com      31  

  105       Nursing.                     search.ebscohost.com 26  

  2845      Environment of care news :   ingentaconnect.com   25  

  2848      Joint Commission perspectiv  ingentaconnect.com   25  

  3449      Journal of psychosocial nur  search.ebscohost.com 25  

  43        Chest.                       mdconsult.com        23  

  116       Nursing management           search.ebscohost.com 22  

  <snip>  

  6383      Wound repair and regeneratio search.ebscohost.com  1  

  9078      Wyoming Nurse.               search.ebscohost.com  1  

  8721      Yale journal on regulation.  search.ebscohost.com  1  

  

  Total Rows = 1914  

  Total Clicks = 4343  

 

 
6.5 Example of a report by server, ranked 
 
The following report is ranked. Only the servers are displayed. The server infers the aggregator. This report should help 
determine the efficacy of aggregators' packages.  
 

 URL Report 2012-JUN through 2012-DEC by Count for Patrons  

 Server                                             Clicks  

 search.ebscohost.com                                 1906  

 ovidsp.ovid.com                                       881  

 mdconsult.com                                         459  

 nursingconsult.com                                    313  

 gateway.ovid.com                                      278  

 ncbi.nlm.nih.gov                                      207  

 ejournals.ebsco.com                                   169  

 nejm.org                                              125  

 ingentaconnect.com                                     72  

 home.mdconsult.com                                     61  

 <snip>  

 techhandsurg.com                                        1  

  

 Total Rows = 28  

 Total Clicks = 4626  
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6.6 URL Click Report 
 

 
 
6.7 Fields:  URL Click Report 
 
6.7.1 Field 1 Status of the Process:  60 characters, display only 
Displays the message "Working..." and/or other messages while the software processes the data.  
 
6.7.2 Field 2 Start Year:  4 characters, mandatory 
Purpose: To specify the year for the report.  
 

Format: The year is four digits.  
 
6.7.3 Field 3 Month for the Report:  2 characters, mandatory 
Purpose: To specify the month for the report.  
 
6.7.4 Field 4 End Year for Report:  4 characters, mandatory 
Purpose: To specify the end year for the report.  
 

Format: The year is four digits.  
 
6.7.5 Field 5 End Month for the Report:  2 characters, mandatory 
Purpose: To specify the last month for the report.  
 
6.7.6 Field 6 Report by Title/Server/URL:  mandatory 
Purpose:  field "Report by" determines the core content of this report. The options are by  
 

   - Title;  

   - Server;  

   - Title and Server;  

   - Title and URL.  

  

Server is a powerful option since it infers the aggregator.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Title 
Server 
Title and Server 
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Title and URL 
 
6.7.7 Field 7 Sort by::  mandatory 
Purpose:  field "Sort by" determines if the data are listed alphabetically by the "Report by" value, or by the count of clicks.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Alphabetic 
Ranked 
 
6.7.8 Field 8 Count clicks by Patrons/Staff:  multiple, mandatory 
Purpose: The URLs are counted by the user type, Patron or Staff. Most libraries focus on Patrons. A research library 
might want to include the access by library Staff, too.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Patrons 
Staff 
 
6.7.9 Field 9 Include Cicked, All, or Not:  mandatory 
Purpose: Field Include can filter by activity. 'Clicked URLs' will count only those URLs which were selected. 'All URLs' is a 
complete listing. 'URLs not clicked' lists which URLs were not selected in this time period, and is always sorted 
alphabetically.  
 
Menu Style:  Radio Button/Check Box 
Menu Values: 
Clicked URLs 
All URLs 
URLs not clicked 
 
6.7.10 Field 10 Tab Delimiter Format:   
Purpose: Tab Delimiter Format for Foreign App Import will create the top row with the column labels for each report field. 
The column labels will have a tab character between them. The data will be formatted into a row per record with tabs 
between the fields. The output can be imported into spreadsheets and databases.  
 
6.7.11 Field 11 Choice of the Target Device:   
Specifies the target device for the output. Choices include Workstation, Printer, File, or send to an E-mail address.  
 
Menu Style:  Push Button 
Menu Values: 
Workstation 
Printer 
File 
E-mail 
Close 
Help 
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7 Remove Online Collection 
 
7.1 Overview to function Remove Online Collection 
 
Online collections change. Moreover, with the current FRBR method of cataloging such as RDA, a work can have many 
manifestations, including print and multiple URLs for heterogeneous aggregators. The goal of function [Remove Online 
Collection] is to easily and correctly remove old URLs (and when appropriate, the entire work) while preserving other 
unrelated persistent manifestations. In other words, you may want to remove an online collection without losing active 
data such as the print holdings or other aggregators' links.  
 

[Remove Online Collection] is found on the Cataloging menu. It consists of many fundamental CyberTools functions such 
as MARC Boolean Search and Batch Control. All of the components should look familiar. [Remove Online Collection] is a 
software wizard: although you could perform each of its steps individually, [Remove Online Collection] will guide you step 
by step. It also adds a level of verification and editing that would be difficult to manually execute. Ideally it also helps 
prevent mistakes.  
 

[Remove Online Collection] can be run before or after an aggregator's update. For updating smaller aggregator's 
collections (say, less than 2000 works), running [Remove Online Collection] before an aggregator's update might be 
easiest. When updating larger aggregator's collections, a library may benefit from running [Remove Online Collection] 
after an aggregator's update with the goal of removing decremented works or their URLs. For example, importing 6000 
works from a spreadsheet via function [File Z39.50 MARC Bib Import] could take a long time if the bibs are not already in 
the catalog. However, running [Remove Online Collection] after an aggregator's update takes a little more know-how. This 
is discussed later in this document.  
 

[Remove Online Collection] runs inside the window Process Control. Here's an example of the window where the 
cataloger is removing ovid.com:  
 

 ================================================================  

 Process Control  

  

     Function [Remove Online Collection]  

     1. See instructions at the Knowledge Center->ERM->  

     Remove Online Collection.  

     2. Searching for batches not DONE...  

     3. Searching for batches not DONE: no problems.  

     4. MARC Boolean Search for the collection  

     5. Sorting 327 bib(s) for removal or editing from search:  

        Set A 856 $u Contains ovid.com  

     6. Batch# 7329: Remove online only bibs  

     7. Batch# 7330: Remove URL for online only with other  

     unrelated URLs.  

     8. Batch# 7331: Remove URL for bibs with print  

     9. Batch# 7332: Remove URL for bibs with print with  

     other unrelated URLs.  

     10. Done. Archive this log and/or Close the window now.  

  

     [Workstation] [Printer] [File] [E-mail] [Close] [Help]  

 ================================================================  

  

The Process Control window is an activity log. At the end of the process you can print or archive the log. The window itself 
does nothing else.  

 
7.2 [Remove Online Collection] Steps 
 
Function [Remove Online Collection] steps are:  
 

 1. See instructions at the Knowledge Center->ERM->  

    Remove Online Collection.  

 2. Searching for batches not DONE.  
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 3. MARC Boolean Search for the collection.  

 4. Sort the found works for removal or editing.  

 5. Remove online only bibs which are being used only by your  

    catalog or a consistent group of catalogs in a union catalog.  

 6. When there is print or other aggregators' URLs, then remove  

    URLs which are only used by your catalog or a consistent group  

    of catalogs in a union catalog.  

 7. When the URL is used by many catalogs, but only your catalog  

    is no longer using the URL, then remove the URL restriction  

    for your catalog while preserving the other catalogs'  

    restrictions.  

 8. Offer the option to edit the bibs via Batch Control.  

 9. Done. Archive this log and/or Close the window now.  

  

All of the above is able to be accomplished in a few minutes. Each step is now discussed in detail.  
 

1. See instructions at the Knowledge Center->ERM->Remove Online Collection. The Knowledge Center can be found at 
your Staff Functions page or on Menu Main. Following these links will yield this document. It includes links to two WebEx 
tutorial recordings:  
 

  - Basics (10 minutes);  

  - Union Catalog Example (5 minutes).  

  

2. Searching for batches not DONE. This step will display all batches that are not DONE, CANCELLED, or DELETED, 
e.g.:  
 

 |--------------------------Warning------------------------------ 

 | These batches are not DONE & may interfere with this session:|  

 | Batch# 6434 by JOHN has 1864 bib(s) from 09/06/2013 as HOLD. |  

 | Batch# 6436 by JOHN has 1864 bib(s) from 09/06/2013 as HOLD. |  

 | Batch# 6508 by CONNIE has 1 bib(s) from 10/25/2013 as INUSE. |  

 | Batch# 6733 by CONNIE has 1 bib(s) from 03/18/2014 as HOLD.  |  

 | [Stop session]  [Continue with session]  [Print]             |  

 |--------------------------------------------------------------- 

  

Its function [Stop session] allows the cataloger to stop this process in order to deal with unresolved batches. Use the 
Cataloging function [Batch Control] to resolve the individual bibs, or use Cataloging function [Cancel All Open Batches] 
(but not if you are in a union catalog!). Conversely function [Continue with session] charges forward. If one of your target 
bibs is in an unresolved batch then you will not be able to add it to a new batch.  
 

3. MARC Boolean Search for the collection. This is the standard function [MARC Boolean Search] as found at Staff 
Functions-> Search Catalog-> Change Search Method->MARC Boolean Search. Here is an example of its window when 
searching for ovid.com:  
 

 ================================================================  

 Search & Select Bibs for function [Remove Online Collection]  

 Set Tag    Ind 1 Ind 2 Subfield  Condition          Search for  

 A  856     4      *      u         Contains         ovid.com  

 ---------------------------------------------------------------- 

 B                                                    

 ---------------------------------------------------------------- 

 C      

 ---------------------------------------------------------------- 

 Boolean Equation A                  [ ] Normalize Search Terms  

 [Search Now]  [Add Set]   [Properties...]          [Help...]  

 [Clear Search][Remove Set][Change Search Method...][Close]  

 ---Saved Results:  327           ------------------------------- 

 AORN journal.  

 The Journal of nursing administration.  

 The American journal of nursing.  

 American journal of obstetrics and gynecology.  

  Sort by Title v  Results Action: [Review]  [Hold]  [Clear All]  
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  Format by MARC Export                           

  Output: [Workstation] [Printer] [File] [E-mail]  

 ================================================================  

  

In a non-union catalog, the typical search is for tag 856 subfield u, Contains the aggregator's server name. Other subfields 
to consider:  
 

 - tag 856 subfield 9, CyberTools URL extensions, for ONLY and  

 your catalog's short name. If you are in a union catalog, and you  

 restricted your collection to your library, then you must use  

 this additional search SET;  

  

 - tag 856 subfield y, Link Text, for your unique wording;  

  

 - tag 856 subfield x, Non-public Comment, for the importer's  

 stamp, e.g.,  

  

        856 $x ACME CONNIE 20140817 batch#6281  

  

 where the format is CATALOG USER DATE BATCH#. These data became  

 available for imports in mid August 2014;  

  

 - tag 979:  

     $b Date entered the catalog YYYYMMDD  

     $c Method entered the catalog  

     $d Original batch number  

     $e Original user  

     $f Last batch number  

     $g Last user  

     $h Source MARC file (e.g. nejm.mrc) or Z39.50 server (e.g.  

        SHDWNLM). Note that $h started in mid-August 2014;  

  

 - tag 005, Date and Time of Latest Transaction, in the format  

 YYYYMMDDHHMMS. If you use this then use it with Condition  

 CONTAINS or START WITH and match on YYYYMMDD.  

  

IMPORTANT SUGGESTION. After conducting the search, reviewing the results and using Select All and Main, use the 
Saved Results Format by MARC Export and the Saved Results Output function [File] This is your safety net. The MARC 
file can be re-imported if necessary. Do this before selecting [Close] on Main.  
 

4. Sort the found works for removal or editing. This step sorts the found works for removal or editing. It is not interactive.  
 

5. Remove online only bibs which are being used only by your catalog or a consistent group of catalogs in a union 
catalog. This step removes bibs that have no other URLs or print holdings other than the specific URL indicated in the 
Boolean search. It removes these online only bibs that are used only by your catalog or a group of catalogs (union).  
 

6. When there is print or other aggregators' URLs, then remove URLs which are only used by your catalog or a consistent 
group of catalogs in a union catalog. The bibs are not removed, rather, the targeted URL is removed. Print and other 
aggregators' URLs remain.  
 

7. When the URL is used by many catalogs, but only your catalog is no longer using the URL, then remove the URL 
restriction for your catalog while preserving the other catalogs' restrictions: the bibs are not removed. The 856 subfield 9 
value  
 

   ONLY YourCatalogShortName,OtherCatalogShortName  

  

is modified, removing YourCatalogShortName but leaving OtherCatalogShortName. Print and other aggregators' URLs 
remain.  
 

8.  Offer the option to edit the bibs via Batch Control. This option is typically not selected, but it can be used to edit bibs 
individually or use the Batch Control->Tools->Global Tag and Subfield Editor.  
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Steps 4 through 8 are typically not interactive except in union catalogs. The function [Go to Batch Control for manual 
editing] can only occur in a union catalog, and only when there is a complex tag 856 $9 ONLY catalog restriction. 
Specifically, if the tag 856 has subfield 9 with an ONLY restriction that includes more than one catalog and includes the 
cataloger's catalog, then the software will offer a pop-up for the cataloger to determine how to manage the resource:  
 

 |-----------------------------Edit Decision--------------------|  

 | http://online.statref.com/document.aspx?FxId=228&DocID=1     |  

 | &grpalias=AZHIN                                              |  

 | for 79 bibs, e.g., MARC# 31733, AACN protocols for practice. |  

 | is restricted to the following catalogs:                     |  

 | ACME, GENERAL, & UNIVERSITY                                  |  

 | These bibs do not have print.                                |  

 | These bibs do not have additional URLs.                      |  

 | [Remove my catalog's ONLY restriction on these URLs]         |  

 | [Remove these bibs for all catalogs]                         |  

 | [Go to Batch Control for manual editing]                     |  

 | [Display MARC]                                               |  

 | [Cancel]                                                     |  

 |--------------------------------------------------------------|  

  

Function [Remove my catalog's ONLY restriction on these URLs] will remove your catalog's short name from the 856 $9 
ONLY list. For example, if yours is a collection or library with the short name of ACME, then  
 

 856 $9 ONLY ACME,GENERAL,UNIVERSITY  

  

will become  
 

 856 $9 ONLY GENERAL,UNIVERSITY  

  

Function [Remove these bibs for all catalogs] does just that.  
 

Use function [Go to Batch Control for manual editing] to individually edit bibs and/or use Tools->Global Tag and Subfield 
Editor.  
 

[Display MARC] will display all of the work's MARC numbers and titles and all of their URLs. The MARC number is 
hyperlinked to the OPAC View Picks display and the URLs are actual links.  
 

[Cancel] ends the session to this point. Any editing done prior to this is saved. This pop-up can occur more than once. If it 
previously occurred and was not cancelled, those editing decisions are permanent. [Cancel] here is for this point in the 
editing cycle only.  
 

9. Done. Archive this log and/or Close the window now. To archive the log, use function [File] to save the log on your 
workstation, or function [E-Mail] to save elsewhere.  

 
7.3 [Remove Online Collection] After an Update 
 
When you import the updated collection, the current software adds to each record a MARC tag 856 subfield x, Non-public 
Comment, in the format:  
 

     856 $x CatalogShortName User YYYYMMDD batch#NNNNN  

  

where CatalogShortName is the catalog's short name, e.g., if the catalog is Acme Medical then the short name is probably 
Acme. User is the cataloger's first name. YYYYMMDD is the date the URL was added to the batch. "batch#NNNNN" is the 
token "batch#" followed by the actual batch number. So if you update a collection today, and are removing the old URLs 
today, you can use today's date to identify the old URLs (or the batch number).  
 

Now run function [Remove Online Collection]. The MARC Boolean Search will be  
 

Set Tag    Ind 1 Ind 2 Subfield  Condition       Search for  

 A  856     4      *      u      Contains        SERVER.COM  

---------------------------------------------------------------- 
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 B  856     4      *      x     Does Not Exist                    

---------------------------------------------------------------- 

 C  856     4      *      x     Does Not Contain YYYYMMDD  

---------------------------------------------------------------- 

 Boolean Equation A AND (B OR C)      [ ] Normalize Search Terms  

  

where SERVER.COM is the server's domain name, e.g., ovid.com. YYYYMMDD is the batch date for the update 
(probably today). Please also note that you need to change the Boolean Equation to:  
 

     A AND (B OR C)       
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